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Preface

Welcome to FireRMS™. The FireRMS Administrator’s Guide describes how to install and 
configure the 4.9 version of the FireRMS software suite.

Introduction to FireRMS
FireRMS is the most advanced Fire Department Records Management System (RMS) on the 
market. It is a NFIRS 5.0-compliant Incident Reporting software program that has been specifically 
developed to dramatically cut report completion time for front-line officers and enhance data 
security.
Two versions of FireRMS are available:

FireRMS Standard Edition - Provides the basic elements for records management, 
including Incident Reporting, Training, Station Roster, and Personnel

FireRMS Enterprise Edition - Includes additional features such as occupancy module, 
hydrants with flow calculation, advanced EMS, vehicles and equipment, scheduling and 
tracking, a daybook module, a HazMat database and query tools. The Enterprise version 
also includes advanced management capabilities not found in the Standard edition of the 
product.
The FireRMS Mobile™ software is available as an add-on to the FireRMS Enterprise 
Edition. This software enables you to collect data while away from the fire station using a 
laptop or a PC tablet and merge it into the database when you return.

Documentation Set
The documentation set for the FireRMS software consists of the following: 

FireRMS User’s Guide
Describes the FireRMS desktop and how to filter data. 
Contains step-by-step procedures for reporting Incidents, using the Daybook, the Daily 
Roster, Other Entries, printing reports, and creating Incident or Occupancy queries. Also, 
describes how to use the following modules: Training, Occupancies, Hydrants, Vehicles & 
Equipment, Personnel, and Scheduling and Tracking.
xi



FireRMS Supplies and Inventory Guide
Describes how to configure and use the FireRMS Supplies and Inventory add-on 
application. The FireRMS Supplies and Inventory application enables you to store your fire 
equipment and supplies inventory in a database.

FireRMS Maintenance & Work Orders Online Help
Describes how to configure and use the FireRMS M&WO add-on application. The M&WO 
application enables you to schedule, track, test, and manage department equipment and 
apparatus.

Online Help
Contains online Help files that describe the user interface.

RescueNet FireRMS NEMSIS User Guide
Describes how you can collect EMS and demographics data required by the National EMS 
Information System (NEMSIS). 

RescueNet FireRMS LOSAP Setup and Usage Guide
Describes how to implement and track the Length of Service (LOSAP) Award Program. 

About This Guide
The Fire RMS Administrator’s Guide is written for system administrators who perform the 
following tasks:

Install and configure the FireRMS system
Enter department and personnel information
Customize input fields for personnel
Control user access

System administrators can disable and enable functions, and set limits on the range of the functions 
found in the software. They have access to personnel information and logs and are responsible for 
maintaining this information.

This guide assumes that the system administrator is familiar with basic PC functions such as 
changing to a different directory, editing and saving files, copying files to and from diskettes, and 
printing files.
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Book Conventions
This section describes:

Typographical conventions
Information highlighting and cross-references

Typographical Conventions
This guide contains the following typographical conventions:

Information Highlighting and Cross-References
This guide contains the following information highlighting and cross-references:

Cross-references indicate the location of additional information regarding the chosen topic. 
References may include headings on specific pages, entire chapters, or other guides.

When viewing the documentation online through Adobe® Acrobat®, click the cross-reference to 
display the referenced section.

Appearance Description

italics Terms first defined, and emphasis.

bold regular Descriptions of user interface elements such as buttons, tabs, icons, folders, 
directories, filenames, window text, etc. All displayed case-sensitive.

Note: Identifies important points, hints, special circumstances, or alternative methods.

Caution: Cautions the user regarding actions that may result in important system changes, 
operational issues, security issues, overwriting data, or data loss.

Warning:   Warns the user regarding actions that may result in physical damage to the 
system, actions that may be hazardous to the user, or actions that will disrupt 
communications between the server and clients.
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Organization
The FireRMS Administrator Guide is organized as follows:

Chapter 1: FireRMS Overview
Provides an overview of the FireRMS system, describes the configuration procedures you must 
perform to use FireRMS, describes how FireRMS filtering works, and lists the FireRMS Mobile 
setup steps.

Chapter 2: Installing FireRMS
Describes the installation procedure that the system administrator must follow to install FireRMS 
or FireRMS Mobile.

Chapter 3: Performing Initial Set Up Procedures
Contains the detailed procedures the System Administrator follows to perform initial setup.

Chapter 4: Customizing Additional Modules
Contains the detailed procedures needed to set up the additional FireRMS modules. You only need 
to customize those modules you intend on using. These include Hydrants, Occupancies, Incidents, 
Training, and Classes.

Chapter 5: Controlling User Access
Describes how to control user access. This information includes how to set a default desktop, 
encrypt patient data, limit access to Personnel and Roster details, activate design mode, set 
centralized reporting, and display mandatory/recommended fields.

Chapter 6: Changing System Settings
Describes how to change your System Settings. These include changing the system preferences, 
changing a user’s login, and setting values used on a Mobile device.

Chapter 7: Using FireRMS Mobile
Describes how to use the FireRMS Mobile module. 

Appendix A: Tables of Field Values
Contains tables listing all the security objects to which you can assign your group levels of access. 
You can assign access using the Access Rights command. 

Appendix B: Example Department Structures
Contains diagrams used to define the department structure. The diagrams identify the relationships 
among Division, Battalion and Station.

Appendix C: Customizing Field Codes
Contains tables describing how to customize field values in text boxes, list boxes, and drop-down 
list boxes by adding to or removing items from the categories.
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Appendix D: Setting up the Master Name Index Feature
Describes how to set up and use the Master Name Index (MNI) feature available with FireRMS 4.5 
SP 1 and later. 

Appendix E: Quick Reference
Lists quick reference questions for all major procedures in alphabetical order.

Appendix F: Contacting ZOLL
Describes how to contact ZOLL for product support.
Organization     xv
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Chapter 1:FireRMS Overview

The FireRMS Enterprise Edition is the most advanced Fire Department Records Management 
System (FRMS) on the market. It is a National Fire Information Council (NFIRS) 5.0-compliant 
Incident Reporting software program that has been specifically developed to enhance data security 
and to dramatically reduce report completion time for front-line officers.

FireRMS is built on Microsoft, and Microsoft SQL Server technology; a client-server database 
management system. 
Figure 1-1 displays the main FireRMS desktop window. Seven main buttons and four main tabs are 
displayed at the top of the window. When you select these buttons or tabs, you can enter/view all 
essential department information.

Note: A Reconcile tab may also be displayed on your desktop. This tab can be used by a 
designated person to reconcile new incidents entered on a mobile device or incidents 
updated on a mobile device.
For information about using Reconcile, see the FireRMS User’s Guide.
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Figure 1-1: Main FireRMS Desktop Window

The optional FireRMS Mobile™ module is only available with the FireRMS Enterprise Edition. 
FireRMS Mobile utilizes Microsoft merge replication technology to enable mobile users complete 
access to critical FireRMS data in the field using a laptop or Tablet PC. The laptop or Tablet PC is 
either connected to, or disconnected from their network. The following features support FireRMS 
Mobile:

Mobile Preferences - Includes Administrative options to manage the FireRMS Mobile 
client; allow users to create new incidents or occupancies on a mobile device, or select the 
number of incidents on a Mobile device.

For more information about Mobile Preferences, see “Changing a User’s Login 
Information” on page 6-13.

Mobile Inspections - Utilizes FireRMS Mobile and the features of the Tablet PC and 
Microsoft Windows XP Tablet PC Edition to enable pen-tablet functionality such as 
handwriting recognition for text field entry and free form signature capture. An inspection 
form enables routine occupancy inspections to be performed in the field on a mobile client 
(Tablet PC or laptop), thus eliminating redundant entry of data and streamlining the 
inspection process. 

For more information about Mobile Inspections using a Tablet PC, see Chapter 9 in the 
FireRMS User’s Guide.
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Mobile Disclosures - Includes, Administrative features to create multiple disclosures and 
signatures from which users can choose. A list of patient Disclosures is available from the 
Advanced EMS tab when using a Tablet PC.

For more information about Mobile Disclosures, see “Creating Advanced EMS 
Disclosures” on page 4-47.

For more information about the FireRMS Mobile product, see Chapter 7: “Using FireRMS 
Mobile.”

Incidents, Training, Other Entries, Daybook and 
Documents
You can view or modify FireRMS data using the tabs displayed on the main FireRMS desktop. 
These tabs include:

INCIDENTS - Displays the list of Incident records (for example, a fire, auto accident, 
earthquake, or an explosion). If you are using the Standard Edition of FireRMS, you can 
enter basic EMS patient care data on the following tabs:

Scene - Enter details about the scene of an incident where EMS services were provided.
Patient - Create a record for each patient who received EMS services at an incident.
History - Create a profile for each EMS patient at an incident.

If you are running the Enterprise edition of FireRMS, Advanced EMS is included.

For information about the fields on the additional tabs supplied with Advanced EMS, 
see the FireRMS online Help file.

TRAINING - Displays the training records and classes.You can record training classes, and 
associate credentials and certifications for personnel.You can also link performance 
standards to objectives and skills and associate them with class session definitions. Other 
features include tracking required and accredited class sessions, retiring class definitions for 
historical reporting, and creating class rosters, registration forms and certificates.

Note: If you are using the Collector Tool, you can select the Synchronize with Collector 
command on the Tools menu to synchronize the data in your FireRMS database with the 
Collector database. The Collector Tool is an add-on component, that you can use to collect, 
analyze, and export incident data.
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You can define course, certification, team and credential requirements for obtaining and/or 
maintaining personnel credentials. You can define initial and renewal criteria and associate 
it with training sessions, prerequisite actions, and actions taken.

OTHER ENTRIES - Displays the current other entry events in FireRMS. Other entries 
include tasks assigned to personnel such as equipment maintenance, inspections, and 
hydrant testing. You can schedule, modify and delete events.

DAYBOOK - Displays assigned and completed tasks for the current user. Also, allows the 
user to create work orders and inventory requests, and to communicate with other FireRMS 
users via email.

DOCUMENTS - Displays a tab on the FRMS Desktop and allows administrators to add 
department or company documents as attachments or URL links. You can create categories 
and sub-categories to help sort and identify documents and URLs that are posted in this 
module. Two default categories are provided for the initial setup. Users can select the 
desired category or subcategory to add, view, update or remove associated documents in 
each group. 
For information on security rights for the Documents tab, see Appendix A: “Tables of Field 
Values.”

Additional FireRMS Modules
In addition to selecting the desktop tabs, you can click a button to display the following associated 
modules on the main window:

Daily Roster - Displays a 24-hour view of daily assignments based on your shift schedule 
and department structure. The Daily Roster organizes your department's structure into a tree 
view that shows detailed assignments for your agency. It lists apparatus that is inadequately 
staffed based on information entered when the apparatus was added to the department. You 
can add new assignments, modify existing assignments and preview future rosters for 
planning purposes. The assignment information in the Daily Roster is included in other 
FireRMS modules, including Incidents, Training, and Daybook. For this reason, you should 
keep the information in the roster up-to-date and accurate. 

Also note the following: When setting up a new database, a roster cannot be generated 
unless there are personnel created that match more than one letter as defined in the Shift 
Pattern, if the shift pattern contains multiple letters.

When a FireRMS database is first created, it creates a 'default shift pattern' for 24 hours 
with a shift sequence of ABC. When this pattern is set up, at least two personnel must be 

Note: Once you create a Daily Roster in FireRMS, you cannot delete it from the 
application. If you experience problems with your Roster, you can delete it from within 
SQL Utililities.
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added, with one assigned to A, and one assigned to B in order to create a new roster for that 
day.    

To allow the roster to be created when all personnel are assigned to a single shift, such as 
"A", the admin should modify the shift pattern (under customize\department) to only list 
"A".

Personnel - Contains the list of employee records. Each record contains an employee’s 
login and password, the department to which you assigned them, and the security group to 
which you granted them access.You can enter personnel data including contact information, 
employment data, and duty assignments. You can maintain activity records including partial 
shift period assignment tracking and interaction with Advanced Personnel Scheduling. 
Additionally, you can record advanced assignment scheduling, pre-arranged shift 
exchanges and position changes, commendations, reprimands, evaluations, employment 
events, medical events. You can also attach photographs, and track occupational injury and 
exposure.

Occupancies - Displays occupancies in your service area. The occupancies can be 
commercial, such as office buildings and stores, or residential, such as condominiums and 
homes. You can track basic, building, prevention, hazardous materials, pre-plan, fire 
prevention systems, and supplemental information for occupancies. You can print Quick 
Assessment Plans, record detailed activities, list findings and follow-up information, and 
attach hydrants and fire flow, photographs, drawings, or videos. You can create a new 
occupancy from an existing one and save the existing occupancy to a history record.

Hydrants - Contains records for all Hydrants in your service area that include hydrant 
profiles, in/out-of-service tracking, activity records, hydrant flow calculations, and linkage 
to occupancy complexes.

Vehicles & Equipment - Contains records for all department vehicles and equipment, and 
those of outside agencies appearing in incident reports. Provides vehicle and equipment 
profiles and activity records.You can attach photographs, specification documents, warranty 
documents, check sheets, and assignment information.

Scheduling & Tracking - Contains scheduled activities and training activities. Scheduling 
& Tracking derives information from various FireRMS modules and organizes it all into a 
single tree view. You can view, add, and complete activities. You can also generate activities 
from recurring scheduled items.

Reports - Provides over 160 Crystal reports used to report operational data across modules. 
(Crystal Runtime is provided with FireRMS.) Each report is fully exportable in a number of 

Note:   You can set up the system to periodically create activities from scheduled items 
using Schedule Process in SQL Utilities.
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file and program formats, allowing users to compile, and combine data into active 
information.

Additional Enterprise Tools
The following additional tools are available in FireRMS Enterprise Edition:

Import/Export Tools - Import or export incident-related data compliant with the NFIRS 
5.0 standards. Advanced EMS Export modules are available as an add-on for state and 
region-specific EMS export requirements.
Flow Calculator Tools - Provide Hydrant and building fire flow calculators used to 
determine fire flow availability and requirements.
Cameo Link Tools - Provide linkage to the Cameo Hazardous Materials information 
database.
Query Builder - Allows you to create queries for incident or occupancy data and export the 
data.

Meaning of Color In Fields
The FireRMS fields displayed in color indicate required or optional information. The following 
fill-in fields are displayed:

NFIRS Required - These fields indicate required information that is dependant on NFIRS 
5.0 rules and are displayed in red. You must complete these fields before you can authorize 
the incident. The incident must be authorized before it can be exported or included in 
reports.

Mandatory - These fields also indicate required information. They are specified by the 
administrator and the color they are displayed in is also chosen by the administrator. You 
must complete these fields before you can authorize the incident. The incident must be 
authorized before it can be exported using NFIRS Export, or included in reports.

Recommended - These fields indicate recommended information. They are specified by 
the administrator and the color they are displayed in is chosen by the administrator. 
Administrators recommend this information be filled in. You can authorize the incident 
without completing recommended fields. 

Optional - The remaining fields are optional. They are displayed in white.

Changing the Desktop Font Size
You can change the size of the font on your desktop. You can increase the font size to easily view 
the fields where you position the mouse. In addition to the default font, you can choose from one of 
three larger fonts. 

To change the font size:
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1.  In the Tools menu, click User Preferences followed by Expand Controls. 

2.  Select Big to display 12-point characters, Bigger to display 14-point characters, or Biggest 
to display 20-point characters. The selection None displays the default font size. When you 
hover a mouse over a field, the field and the text you enter is enlarged. 

Setup Overview
After installing FireRMS, you must perform some initial setup before you can report incidents and 
perform other fire department management tasks. 
The first task is to enter department information; set up the “codes” (menu selections) used for 
selection lists, explorers and finders in FireRMS, and add apparatus, personnel, and the cities and 
streets in the service area.

Because some FireRMS features depend on some of the data being entered first, you must follow a 
specific sequence when entering the data. You can perform the initial setup using the Welcome 
Wizard screen that appears when you first open FireRMS. The wizard guides you through the setup 
process. When you have completed these tasks, you can then create security groups and define 
access rights for your employees. 

If you choose not to use the Welcome Wizard, you can perform the same tasks, with the exception 
of Adding Your Personnel, by selecting the Tools menu and then selecting the Customize command 
on the FireRMS desktop. The first three commands on the Tools menu correspond to the first three 
steps in the Welcome Wizard and are displayed in sequence.

For information about adding your personnel without the Welcome Wizard, click the 
Personnel button on the desktop and then see “Adding Personnel” on page 3-21.

Using either the Welcome Wizard or the menu, the initial setup steps are as follows:

Step 1: Enter Your Department Information
Your department information includes basic information, fire department structure, and 
shift patterns. Basic information includes agency name and address, FDID number, and 
demographics. Your department structure is defined using Divisions, Battalions, and 
Stations. You define the shift patterns your employees will use. Shift patterns include 
start and end times and a start date.
For more information, see “Entering Department Information” on page 3-1.

Step 2: Customize Your Codes
Code customization includes setting up Department codes, 901 codes, and EMS codes 
that are used for FireRMS selection lists (drop-down menus, finders, and explorers).

Note: The Chemicals tab contains a read-only list of chemical codes. These codes are 
displayed in the chemical look-up tables which users can search through.
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 For more information, see “Customizing Codes” on page 3-10.
Step 3: Add and Staff Your Apparatus

Your list of apparatus should include all of your department's units as well as any units 
from other agencies that may provide mutual aid to your department. These units are 
used for incident reporting, personnel assignments, and the Vehicles & Equipment 
module. You can select staff for each apparatus you add. Some of the apparatus types 
you can choose from, are engines, trucks, boats and aircraft.
For more information, see “Adding Apparatus and Staffing Apparatus” on page 

3-18.
Step 4: Add Your Personnel

Personnel information includes name and address, assignment information, login 
information, and shifts. Additional information includes emergency contact 
information, medical information, attachments (.BMP files), exception information for 
shift patterns, test data, and military information.
For more information, see “Adding Personnel” on page 3-21.

Step 5: Define Your Cities and Streets
The final step of the FireRMS setup process, using the Welcome Wizard, is to create a 
list of cities and streets in your service area. Once you have added cities, you can add 
streets. 
For more information, see “Entering Cities” on page 3-25. 
For more information, see “Entering Streets” on page 3-28.

Once you have completed these tasks using the Welcome Wizard, the final required task is:

Step 6: Create Security Groups and Define Access Rights
You must create security groups and then choose a level of access for each group. You 
can assign your personnel to one of these security groups in the Personnel module.
For more information, see “Creating Security Groups and Defining Access Rights” 

on page 3-31.

Setting Up Additional Modules
After completing the initial setup tasks, in order to collect accurate information regarding incidents, 
you must enter information in some additional modules, for example, Hydrants and Incidents. 
Other modules, such as Training, are optional; you only need to enter the information if you will be 
using the module. To enter information in these modules use the remaining Customize commands 
on the Tools menu.

Step 7: Customize Hydrants
Customization tasks specific to the Hydrants module include creating a list of hydrant 
related actions and assignments and defining a hydrant numbering scheme. 
For more information, see “Creating Hydrant Actions” on page 4-2.

Step 8: Customize Occupancies
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Customization tasks specific to the Occupancies module include creating a list of 
occupancy-related actions and assignments, setting up an occupancy-numbering 
scheme, and defining building codes for use in occupancy descriptions. 
For more information, see “Customizing Occupancies” on page 4-6.

Step 9: Customize Incidents
Customization tasks specific to the Incidents module include setting defaults, selecting 
aid given codes, and setting billing rates.
For more information, see “Customizing Incidents” on page 4-20.

Step 10: Customize Vehicles, Equipment, and Locations
Customization tasks specific to the Vehicles, Equipment, and Locations module include 
creating lists of vehicle and equipment related actions, creating a list of equipment 
categories, and creating an assignment list for vehicles, equipment, and locations.
For more information, see “Customizing Vehicles, Equipment, and Locations” on 

page 4-25.
Step 11: Customize Training

Customization tasks specific to the Training module include creating your classes, 
objectives and skills, credentials and training standards, and defining the default results 
for classes and objectives/skills.
For more information, see “Customizing Training” on page 4-31.

Step 12: Customize Other Entries
The customization task for the Other Entries module is to define the default results for 
other entry events. 
For more information, see “Customizing Default Results for Other Entries” on 

page 4-50.

Customizing Module Selections
After you have entered data in all the required FireRMS modules, you, or your personnel can begin 
entering incident information. If before using this product, you want to change field selections 
available to your users, you can customize your application in the following ways:

You can customize Department Codes, EMS Codes, and 901 Codes for the fields, 
drop-down boxes, and list boxes of the tabs displayed on the Customize menu commands, 
desktop tabs, and desktop buttons.

You can select the fields on the Incidents tab you wanted displayed as “mandatory” and as 
“recommended.” When you enable these fields, you can also indicate the color in which 
you want these fields to display.

The selections that appear in the fields, drop-down boxes, and list boxes of the various tabs are 
based on the category assigned to that field. You can modify the selections by adding items to, or 
removing items from the category.
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For information about customizing the selections for the Customize menu commands, see 
“Customizing Fields for the Tools/Customize Menu Commands” on page C-2.

For information about customizing the selections for the desktop tabs, see “Customizing 
Fields for Incident, Training, Other Entries and Daybook Forms” on page C-22.

For information about customizing the selections for the desktop buttons, see “Customizing 
Fields for Daily Roster, Personnel, Occupancies, Hydrants, and Vehicles and Equipment” on 
page C-103.

Determining The Data Your Personnel Can View
You can control the data that is displayed for each user through settings you assign to their 
personnel record. You can:

Filter Data - FireRMS Filtering is the means by which personnel can retrieve and display 
specific FireRMS desktop data that is only relevant to their needs. The Administrator 
determines the data displayed to their personnel.

Restrict Access to Data - You can restrict access to data via security objects that 
correspond to menus, forms and the desktop.

Customize Data - You can customize the data displayed by hiding fields in any module, 
hiding tabs, or creating new, custom, tabs for Incidents, Advanced EMS, and Occupancies. 

Filtering Data
The department level you assign to your personnel determines the amount of data they can view. 
Additionally, users can further reduce the data displayed on their individual desktops using the 
desktop settings Set To Current User and Not Assigned.

Filtering Data By Department Level
FireRMS Filtering has been implemented using a “Logical Hierarchy.” This Logical Hierarchy is 
based on the traditional structure of a fire department. The traditional structure contains Divisions, 
Battalions, and Stations. Each Department, Division, Battalion and Station level, has characteristics 
in terms of roles, data access, and security restrictions. Figure 1-2 depicts the Logical Hierarchy.
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Figure 1-2: Logical Hierarchy of a Fire Department

An administrator assigns one of the department levels below to a user. The user can view only the 
data available to their department level. 

Department - Personnel assigned to Dept. can filter data for all Divisions, Battalions, and 
Stations in the department. 
Division - Personnel assigned to Division can filter incidents in their command or division. 
This includes the Battalions and Stations that their Division supports. 
Battalion - Personnel assigned to Battalion can filter incidents contained in a specific 
Battalion and the assigned stations that this specific Battalion supports. 
Station - Personnel assigned to Station can filter only the data at their local station level.

Administrators can select the following settings to restrict these areas of the product to the user’s 
assigned department level; Protect Roster, Protect Daybook, Protect Personnel, and Protect 
Desktop.

For information on setting a department level for personnel, see “Adding Personnel” on page 
3-21.

For information about Protect Daybook and Protect Desktop, see “Enabling Login Security/
Protecting Daybook and Desktop” on page 5-2.
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For information about Protect Roster and Protect Personnel, see “Protecting the Daily Roster 
and Personnel Module” on page 5-6.

Filtering Data Using Desktop Settings
Users can limit the data displayed on their specific desktop by selecting the desktop filtering 
settings, Set To Current User, and Not Assigned. These filtering settings are specific to each user’s 
desktop, and include Incidents, Training, Other Entries, and Daybook respectively. (If neither check 
box is selected, the information displayed is filtered to the current user’s assignment level.)

Set To Current User - When a user logs on and checks the Set To Current User box, only 
data, e.g. Incident records, with resources the user is assigned to, are displayed. If this box is 
not checked, all data relevant to the user’s department level is displayed.
Not Assigned - When a user checks the Not Assigned box, all Incidents, Training Classes, 
or Other Entries that have not been assigned a resource are displayed. Resources are a 
combination of apparatus and personnel assigned to an incident or task.
Set to Roster – When a user logs on and checks the Set To Roster box, only data for which 
the user is responsible based on his current Roster Assignment will display. Daily Roster 
assignments may vary from the default schedule or location assignment setup in Personnel. 
If you participated on an incident that is outside your Roster assignment, use the Set to 
Current User filter to see those records.

An additional desktop filtering mechanism, the Desktop Filter, can be used to filter data for the 
Incidents and Training tabs on the desktop.

Desktop Filter - Users can filter incident data by apparatus, incident type, location, 
completed and not reviewed, incomplete, reviewed, shift, and reporting station within their 
assigned structure level. The selections you can choose from are determined by the 
department structure set up by the Administrator. 

Refer to the “Filter the Incident List” topic in the online help for information about 
filtering incidents via specific criteria.

Setting Responsibility Levels for the Personnel and Roster 
Modules
Fire RMS 4.4 or later enables you to specify responsibility levels for an individual in the Personnel 
and Roster modules. You can use this feature to allow a logged in user to view the Incidents and the 
Daybook/To do list based on the filter set in the Responsible Level field in the Personnel and Roster 
modules. 

To use this feature:
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1.  As a pre-requisite, ensure that the Protect Daybook and Protect Desktop fields are 
checked for the system. Use Tools>Administration>System> Settings to access these 
fields in the More Settings area of the screen. Restart FireRMS.

2.  When these settings are enabled, FireRMS checks the Responsible Level field in the Roster 
module to check which records or related records are displayed to a specific user. You can 
view or modify the setting in the Roster module on the Roster Entry tab for the specific 
user. 
If there is no roster for the day, or if the logged on user is not on the current day’s roster, 
FireRMS checks the Personnel module for the setting of this field. You can view or modify 
the setting in the Personnel module by clicking on the Basic Info tab for a specific user. 

3.  The Responsible Level field setting in these modules allow the logged in user to view all 
records in the Incident and the Daybook/To do List for the level set in the field, regardless 
of the person’s actual roster or personnel assignment. So a user could be assigned to a 
specific station for a day, but still be able to view records created for a different level 
station, division, battalion or department. This allows for greater flexibility in viewing 
information for personnel who may work in other departments, battalions and so on. 

Note that the Responsible Level field is set to the current assignment by default in either the 
Personnel or Roster modules. You may modify the default setting to allow the user to view 
information based on a higher or lower level filter if desired. 

Restricting Access to Data
In addition to using Filtering to determine the information your personnel can view, you can assign 
access levels to menu commands, tabs, and the FireRMS desktop. Each security group you create 
contains a list of “security objects” that correspond to the FireRMS menus, forms, and the desktop. 
Each user’s ability to access an item is determined by the level of access chosen in the security 
group to which you assigned them.

For information on assigning levels of access to security objects, see “Creating Security 
Groups and Defining Access Rights” on page 3-31.

For a list of the security objects to which you can restrict access, see “Access Rights 
Definitions” on page A-1.

Customizing Data
You can customize the data displayed on your users desktops by hiding fields in any of the 
FireRMS modules that you do not want displayed. You can set default values for data elements. 
Also, you can hide Incident and Advanced EMS tabs that you do not use, or you can create new 
tabs with specific information that your department needs to collect.
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For information about hiding FireRMS fields, see “Selecting Mandatory and Recommended 
Fields, Repositioning Fields, or Changing Visibility” on page 4-59.

For information about setting default values for the data elements, see “Assigning Default 
Values to Data Elements” on page 4-62.

For information about hiding Incident or Advanced EMS tabs, see “Customizing Tabs: Labels, 
Sort Order, Visibility” on page 4-51.

For information about creating custom tabs, see “Creating Custom Tabs” on page 4-52.

For information about Design Mode, see “Selecting Mandatory and Recommended Fields, 
Repositioning Fields, or Changing Visibility” on page 4-59.

For information about security objects, see “Creating Security Groups and Defining Access 
Rights” on page 3-31.

Note:   You can customize the data while in Design Mode or via security objects to which 
you have full access. If users are logged into FireRMS when you make changes to the 
interface, they must log out of FireRMS and log back in to view these changes.
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Chapter 2:Installing FireRMS

This chapter describes how to install the FireRMS application and the FireRMS Mobile software. 
Using the FireRMS Mobile software, users can collect data while away from the fire station using a 
laptop or a PC tablet and merge it into the database when they return. You can follow the steps in 
the next section if you are performing a new application install or an upgrade to a previous install. 
The FireRMS application CD contains the selections in Table 2-1 and Table 2-2. 
The FireRMS Mobile CD contains one selection: Install FireRMS Mobile.

When you select Install Products, you can install the software described in Table 2-2.
Refer to the FireRMS Release Notes for the correct hardware/software requirements.

Table 2-1: FireRMS Install Main Menu

Selection Description

Install Products Lists all the software you can install.

Browse Contents Displays a folder with all the information provided on this CD.

Documentation Displays a folder with all relevant documentation, e.g., FireRMS 
Administrator Guide and FireRMS 4.x Release Notes.

Contact Us Displays a phone number, email address, and web address for 
ZOLL.

Table 2-2: FireRMS Install Products Menu

Software Description

FireRMS 4.x Client Select this if you want to install the client software.

Crystal Reports 11 
Interface

Select this after you install the client software to install Crystal 
Reports Runtime files.

SQL Utilities Select this to install SQL Utilities on the Administrator’s PC.
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These installation procedures describe how to install software on the FireRMS client and the server. 
Before upgrading your software, you must be aware of the following:

If you install FireRMS in a directory other than c:\Firerms5sql, and you use SMS, you 
must open the SMS configuration and register the FireRMS executable in its new location.

Installing FireRMS Client Software
This section describes the procedure you follow to install software on the client. In addition to the 
client software, FireRMS requires certain third party utilities for normal operations. All utilities 
except for SP3 can be found on the FireRMS CD.

To install the client software:

1.  Insert the FireRMS installation CD in the client CD drive. After a pause, the CD options 
screen appears. (If the CD options screen does not start automatically, in Windows Explorer 
open the FireRMS installation CD directory and double-click Launch.exe.) 

2.  Click Install Products in the list of options.

3.  Click FireRMS Client. 

4.  A Welcome screen is displayed. Click Next. A Customer Information screen is displayed 
with User Name and Company Name fields. 
ZOLL recommends that you use the default of Install app for those who use this computer. 
This allows any FireRMS user to run the application on the client. 

5.  Enter this information and click Next. 

6.  The Destination Location screen displays. Use the default directory, c:\firerms5sql, and 
click Next, or click Browse to install to a different directory.

3rd Party Utilities Select this to install 3rd party utilities, e.g. MSDE or MDAC 2.8.

Add-On Apps Select this to install add-on applications, such as Audit Log 
Viewer that you use with the SQL Utility Audit Management or 
Central Web Reporting.

Table 2-2: FireRMS Install Products Menu

Software Description
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7.  A Setup Type screen displays and you can choose a Complete or a Custom install and 
click Next. (If you select a Custom install, you can deselect FireRMS Core application or 
Crystal Reports 11 Runtime.)

8.  A File Copy screen displays with Setup information. Click Next.

9.  A Setup Status screen displays and the software is installed.

10.  When you see the InstallShield Wizard Complete screen, click Finish. The main screen 
displays.

11.  OPTIONAL: Click 3rd Party Utilities or Add on Apps if you need to install any of the 
third party utilities or the add on applications on your system. 

12.  Click Exit twice to close the FireRMS install program.

13.  Restart your computer.

Installing FireRMS Server Software
To install software on the server:

1.  Insert the FireRMS installation CD in the client CD drive. After a pause, the CD options 
screen appears. (If the CD options screen does not start automatically, in Windows Explorer 
open the FireRMS installation CD directory and double-click Launch.exe.) 

2.  In the list of options, click SQL Utilities.

3.  A Welcome screen is displayed. Click Next.

4.  A Customer Information screen is displayed with User Name and Company Name fields. 

5.  Enter this information and click Next.

6.  The Destination Location screen displays. Use the default directory, c:\firerms5sql, and 
click Next, or click Browse to install to a different directory.

7.  A Setup Status screen displays and the software is installed. 

Note:    If you will be using the central web reporting option, make sure you install the 
Add on App Central Web Reporting.
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8.  After completing the install, click Finish. We recommend you install the add-on application 
Log Viewer, in SQL Utilities, if you will be using Audit Management or Fire Reports 
Central is you will be using Central Web Reporting.

9.  Click Finish when you are done installing Log Viewer and click Exit twice to close the 
FireRMS install program.

10.  Double-click the SQL Utilities icon on the desktop. If the SQL Service is not currently 
running on the local machine, you will be prompted to enter the server name and login. If 
the service is running locally, SQL Utilities automatically detects this information.

11.  Do one of the following:

Update the FireRMS database(s) if you are upgrading your software.
a)  Verify that no clients are connected to the database(s).
b)  In the Your Databases list of the SQL Utilities for FireRMS dialog, locate and 

highlight the FireRMS database that you are updating.
c)  Click the Lock Database check box. 
d)  Click the Update button to update a single database or the Update All button to 

update all the databases.
e)  On the Maintenance tab, click Reset Stored Procedures.
f)  Uncheck the Lock Database check box to unlock the FireRMS databases.

Create a new database if you are performing a new install.
a)  Click the Create button. The Create Database dialog box displays.
b)  Enter the database name in the Database Name text box.
c)  Click OK.

12.  Close the SQL Utilities application.

13.  Start FireRMS on a client machine.

14.  Click the Help menu, then click Help About.

15.  In the About dialog, click the Details button.

16.  In the Details dialog, verify the application version number is correct.

Note:   If you are updating multiple databases, be sure to check the version number next to 
each database when the update is complete to verify that all databases were updated.
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Security for Crystal Reports
FireRMS 4.3 or later provides additional security for Crystal Reports. A new tab is available in: 
Tools> Administration>Security > Report Access. By using these new security options, you can 
choose to restrict access to reports for each security group. Restrictions can include preventing 
access from viewing reports, printing reports and/or exporting report data. This new security option 
also applies to locally created reports that follow the FireRMS naming convention and which are 
located in the Reports folder. This new option does not affect reports printed from other modules in 
the product, such as the ability to print an incident from within the Incident form. Security access 
for all reports is enabled for all security groups by default during the upgrade. The following 
screenshot shows an example: 

Note:   If you will be using the Central Web Reporting feature described in Chapter 5, you 
must install the Central Web Reporting software on your Web server. The software resides 
in the Add-On Apps section of the Install CD. Also, in addition to the open database 
connection created on each client, the Administrator must create an open database 
connection (ODBC) to RMS5SQL_DSN on the Web server.
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Chapter 3:Performing Initial Set Up 
Procedures

You must perform initial set up procedures before you can use this product. The initial set up 
procedures consist of two major tasks:

Performing initial customization 
Creating security groups and defining access rights

You can use the Welcome Wizard to guide you through the initial customization of FireRMS. The 
Wizard displays on your screen. You can select a check box for the task you want to perform. After 
you complete each task, the Wizard redisplays on your screen.

If you would prefer not to use the Welcome Wizard, you can complete these procedures using menu 
commands described in the following sections.

Entering Department Information
You must enter basic fire department information, indicate the department structure, and create the 
shift patterns for your department personnel.

Entering Basic Department Information
The basic information that you enter is used to identify the incident reports associated with your 
department in the NFIRS incident database.

To enter basic fire department information:

1.  Click the Tools menu, then select Customize, followed by Department.
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2.  On the Basic Info tab, enter the information in the fields provided.

Table 3-1 contains descriptions of the fields on this tab. Remember that you must enter 
information in any field displaying mandatory information.

Table 3-1: Basic Info Tab Field Descriptions 

Field Description

Department Name & IDs Your fire department name. NFIRS requires this information on all 
incident reports, and is automatically included in your incident 
exports.

FDID The fire department identifier (FDID) assigned to your department 
by the State Program Manager. You can enter a maximum of five 
alphanumeric characters. The FDID number is required by NFIRS 
for all incidents. Like the Department Name, FDID is 
automatically included in your incident exports.

EMS Your department's EMS identifier. This is a secondary number 
used to identify your EMS agency for EMS exports from 
FireRMS. It is used by some states for collection information. It is 
not required by NFIRS.

County Your department's County ID, if used. This number is used by 
some states for collection information. It is not required by 
NFIRS.
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Dispatch Your department's Dispatch ID, if used. This number is used by 
some states for collection information. It is not required by 
NFIRS.

Address, Phone, Fax, 
E-mail, and WEB page

The primary address of your department and a person to contact, 
in addition to their phone, fax, E-mail and Web page, if applicable.

City, State, Zip Code Enter the city, state and zip code where your primary department 
is located. The first time you enter a city, FireRMS prompts you to 
add it to your list of cities. Click Yes. The list of cities is a global 
look-up table (selection list) used by data entry personnel to select 
cities when entering information in FireRMS. It helps to speed 
data entry and ensure accuracy.

Career The number of professional paid staff members in your 
department. You can enter a number or click the arrows to select 
the number you want.

Volunteer, paid or
Volunteer, unpaid

The number of paid volunteers and the number of unpaid 
volunteers in your department.

Stations The number of stations in your department.

Budget The department's total annual budget in dollars.

EMS A selection that describes the level of EMS provided by your 
department.

Square Miles The total area in square miles of your service area.

Population The number of people living in your service area.

Density A selection that best describes the population density in your 
service area.

ePCR Company Name Enter your ePCR Company Name if you are exporting records to 
an ePCR database that holds multiple agencies. 

Auto-Complete ePCR If you are receiving updates from an ePCR database, use this 
check box to automatically mark incidents as complete when they 
are created by the eCPR user. Leaving this check box unchecked 
will cause those incidents to display on the reconcile tab where 
they must be manually updated and completed.

Table 3-1: Basic Info Tab Field Descriptions (Continued)

Field Description
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Follow the procedure in the next section to set up the department structure.

Setting Up The Department Structure
The department structure indicates the organizational structure of your department. The department 
structure can have up to three levels in FireRMS. The structure is used in FireRMS when you 
generate rosters, or assign units, equipment, and personnel. Refer to Appendix B for some sample 
department organizational structures.
To set up your department structure:

1.  Click the Tools menu, then select Customize, followed by Department. The Customize 
Department dialog displays.

2.  On the Structure tab, enter the information in the fields provided. 

Authorized Personnel for 
ePCR

If you are receiving updates from an ePCR database, select a name 
here for the Member Making Report in the incidents. 
Note: If you have mapped your ePCR User IDs, you do not need 
to enter a value here.

ePCR Export Start Date If you are exporting records to an ePCR database, enter the date 
for the earliest incident you wish to post to ePCR. The date is 
based on the Incident Alarm Date.

Table 3-1: Basic Info Tab Field Descriptions (Continued)

Field Description
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3.  Click the Use Divisions check box or the Use Battalions check box at the top of the tab. 
Use Divisions enables you to create a three-level structure with Divisions, Battalions, and 
Stations. Use Battalions enables you to create a two-level structure with Battalions and 
Stations. Table 3-2 contains descriptions of the fields on this tab.

4.  Create Divisions, Battalions, and Stations or just Battalions and Stations using the following 
procedures:

Create Divisions:
a)  Click the Divisions radio button.
b)  Click the New button.
c)  Type up to four unique alphanumeric characters in the Code text box to identify the 

division.
d)  Type a description of the Division in the Description text box.
e)  Repeat this procedure to enter another Division or proceed with Create Battalions.

Create Battalions:
a)  Click the Battalions radio button.
b)  Click the New button.
c)  Type a unique code and enter a description to identify the Battalion.
d)  In the Assigned To drop-down, select the Division to which you want to assign the 

Battalion.
e)  Repeat this procedure to enter another Battalion or proceed with Create Stations.

Create Stations:
a)  Click the Stations radio button.
b)  Click the New button.
c)  Type a unique code and enter a description to identify the Station.
d)  In the Assigned To drop-down, select the Battalion to which you want to assign the 

Station.
e)  Repeat this procedure to enter another Station or proceed to the next section to enter 

the department shift patterns.

Note: Once you create a department structure, you cannot change it.
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Entering Department Shift Patterns
The department shift patterns indicate department work hours. Department shift patterns are used to 
make personnel assignments and generate rosters. You can create up to 99 shift patterns, including 
the default shift pattern of 24-hours.
To create the department shift patterns:

Table 3-2: Structure Tab Field Descriptions 

Field Description

Use Divisions Creates a three-level departmental hierarchy: Divisions, 
Battalions, and Stations. You can have multiple Divisions and 
multiple Battalions in each Division. You can then have multiple 
Stations in each Battalion.

Use Battalions Creates a two-level departmental hierarchy. You can have multiple 
Battalions and multiple Stations in each Battalion. If you select 
this structure, you will be unable to create Divisions.

Divisions, Battalions, or 
Stations

Displays fill-in fields after you select a radio button and click the 
New button. After creating Divisions, Battalions, or Stations, you 
can modify the information or delete it.

Code Identifies the Division, Battalion, or Station. You must enter a 
unique code for each Division, Battalion, or Station you create.

Description A brief description containing up to forty alphanumeric characters 
of the Division, Battalion, or Station. 

Note: NFIRS does not support more than 3 characters for a Station ID, but FireRMS 
allows you to create Stations with up to 4 characters for the Station ID. This value is 
truncated to the first 3 characters only when the station is included on an Incident Report 
which is being exported for NFIRS reporting. 
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1.  Click the Tools menu, then select Customize, followed by Department. The Customize 
Department dialog displays.

2.  On the Shifts tab, enter the information in the fields provided. Table 3-3 contains 
descriptions of the fields on this tab.

3.  Click the first available shift pattern in the Shift Patterns list box. If you are defining your 
department’s 24-hours shift, click the first shift in the list because the 24-hour shift must 
always be the first in the list.

4.  In the Description text box, type a name for the shift.

5.  In the Start Date text box, type the date on which the shift will become active. If this is a 
24-hours shift, select the 24-hour shift check box, otherwise enter the shift start and end 
times.

6.  Select the pay code to be associated with each shift. 

7.  In the Shift Pattern text box, type the letter combination that represents the shift cycle, 
using the Valid Shift Letters displayed in the list box on the right side of the Shifts tab.

8.  Repeat Steps 3 through 6 (choosing the next available shift) to create additional shifts or 
click the Close Toolbar button to save your settings.
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For information on adding shift letters or assigning colors to Shift letters, see “Adding Shift 
Letters or Assigning Colors To Shifts” on page 3-9.

Table 3-3: Shift Tab Field Descriptions 

Field Description

Shift Start Time The start time for the primary 24-hour shift. The primary shift is 
tracked as a single 24-hour unit from the shift start term, even if it 
crosses into the next day. For example, if your 24-hour shift starts 
at 7 A.M. one day, it ends at 7 A.M. the next.

Shift Patterns Use this option to create your agency's shift patterns in FireRMS. 
With the Enterprise edition of FireRMS, You can define up to 99 
shift patterns in addition to the default Monday-Friday shift 
pattern. (With the Standard Edition, you can define three shift 
patterns.) The shift rotation is based on the Shift Start Time, that 
is, all shifts will begin after the Shift Start Time. Shift1 should 
always be used for your primary 24-hour shift.

Description A description of the shift pattern that suits your department's 
needs; for example “24-hour shift” or “4-10 Fri. Off.”

Shift Pattern The shift pattern is indicated using the Shift Letters. Type one 
complete shift cycle (until the pattern starts repeating itself). The 
dialog on the previous page contains a shift pattern that starts with 
shift A and ends with shift B in a repeating pattern.

Start Date The first day in the shift cycle. This is important as it ensures that 
shifts are assigned to the correct days.

24 Hour Shift Indicates the shift is 24 hours. You can have multiple 24-hour 
shifts, but Shift 1 is always the primary 24-hour shift (first on the 
list) on which all other 24-hour shift cycle start times are based.

Start and End For shifts other than the primary 24-hour shift (Shift 1), enter the 
shift start time and end time using military (24-hour clock) time. 
This is used by the Daily Roster to ensure people are still assigned 
to the correct shift into the next day. (This is assuming the shift 
starts one morning and ends the next.)

Valid Shift Letters and 
Assigned Colors

Shift letters and assigned colors are used to visually represent 
shifts and to track shift patterns on the calendar. Each letter/color 
combination represents a single shift. Letters and colors are not 
exclusive to one shift pattern; they can be re-used in different 
combinations to represent multiple shifts.
3-8     Chapter 3: Performing Initial Set Up Procedures



FireRMS Administrator’s Guide
Adding Shift Letters or Assigning Colors To Shifts
You use shift letters and assigned colors to visually represent shifts and to track all patterns on the 
calendar. Each letter and color combination represents a single shift. Letters and colors are not 
exclusive to one shift pattern; you can re-use them in different combinations to represent multiple 
shifts.
To add shift letters or assign colors to Shifts:

1.  On the Shifts tab of the Customize Department dialog, click the Add Letter button to add 
the next available shift letter to the list.

2.  Repeat Step 1 for each shift letter you wish to add or proceed to Step 3 to assign shift colors.

3.  In the Valid Shift Letters and Assigned Colors list box, select a Shift Letter representing 
the shift to which you want to assign color.

4.  Click Assign Color to assign a color to the shift you chose.

5.  Click the color in the color palette and click the OK button.

6.  Repeat Steps 3 through 5 to assign additional colors to shift letters.

7.  OPTIONAL: Click the Shift Calendar button next to the Add Letter button to view the 
Calendar. The Shift Calendar uses the Assigned Colors and Shift Cycle to represent daily 
shift rotations.

You can view shift rotation by Day, Month, or Date Range. Select different shift patterns to 
view from the drop-down box. 

8.  Click the Close Toolbar button when you are done.

Paycodes Each shift may be assigned to its own paycode to reflect the 
varying daytime, nighttime and weekend shifts. Paycodes are set 
up under Department codes and each code may be used to 
represent On Duty & Available, On Duty but not Available, or Off 
Duty. 

Table 3-3: Shift Tab Field Descriptions (Continued)

Field Description
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Customizing Codes
You can define the values or “codes” that appear in the list boxes, drop-down list boxes, explorers, 
and finders in FireRMS. You can enter codes to identify your department-related information, add 
sub-codes to the 901 codes, and add sub-codes to the EMS codes. You can also view a list of 
Chemical codes.

Department Codes are used in incident reports, training, and other areas in FireRMS. The 901 
Codes are the NFIRS-based predefined 901codes. The Chemical codes are the values that appear in 
the chemical look-up tables. The EMS codes are predefined codes that you will use when reporting 
EMS incidents.

Department, 901 and EMS codes can be grouped into categories or sub categories. You can 
highlight any code and click on the Assign to Sub-Category list box on the Customize Code form. 
You can type in a new category name or select from an existing name previously defined. You can 
also assign all codes to a sub category, or just some of the codes. When users later right click on any 
field that provides a code explorer option, they can expand the listing of sub categories you have 
created to view and select codes from that group. 

Entering Department Codes
Department codes are used in incident reports, training, and other areas of FireRMS. The 
department codes you create are contained in categories. Some examples of categories are, “Cause 
of Firefighter Injury,” “Incident Type,” and “Patient Status.”
To enter your department codes:

1.  Click the Tools menu, then select Customize, followed by Codes. The Customize Codes 
dialog displays.

Note: When you set up multiple letters for a shift, you must assign at least one person to 
each shift letter in the Personnel module before you are able to generate a Roster that 
includes that shift. 
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2.  Select the code category to which you wish to add a new code from the Category 
drop-down list.

3.  In the Code text box, type an alphanumeric code that represents the department code you 
are creating. (If you are adding additional Fire agencies, enter the agency’s FDID number as 
the code value.)

4.  In the Description text box, type a name for the code. The Code and Description will be 
used by data entry personnel to identify the value in selection lists in FireRMS. (Table 3-4 
contains descriptions of the fields on this tab.)

5.  Enter a state if the State text box is displayed.

6.  Click OK. The Category is created.

7.  Click the New button.

8.  Enter a Code, Translation Code, and Description.

9.  Repeat Steps 2 through 8 to enter additional department codes.

10.  Click the Close Toolbar button when you are finished to save your changes and close the 
Customize Codes dialog.
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Entering 901 Sub-Codes
The 901 codes are primarily used in the Incidents module to store and track incident data in 
accordance with the NFIRS incident reporting rules. The 901 Codes tab has over 100 categories 
based on the NFIRS 6.0 codes.

The 901 codes are NFIRS-based, so you cannot modify them. However, if the 901 codes are not 
specific enough to meet your department's needs, you can use the Code and Plus One text boxes to 
extend the NFIRS 901 code set. You can do this by adding more specific sub-codes to the 901 
codes.

To enter your 901 Plus One codes:

Table 3-4: Department Codes Tab Field Descriptions

Field Description

Category Select the Category that you want to update. 

Code A unique alphanumeric EMS code of up to four characters. 

Description A description containing up to forty alphanumeric characters of 
the code created for the selected category.

Description A description containing up to forty alphanumeric characters of 
the code created for the selected category.

Translation Code An alphanumeric code used to collect specific departmental 
information or for use in exporting code data to third party 
programs
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1.  Click the Tools menu, then select Customize, followed by Codes. The Customize Codes 
dialog displays.

2.  On the 901 Codes tab, enter the information in the fields provided. Table 3-5 contains 
descriptions of the fields on this tab.

3.  Select the 901 Code Category in the drop-down box to which you wish to add a plus one 
code. 

4.  In the list box, click the code to which you wish to add a plus one code.

5.  Click the New button. Click Yes when you are prompted to create a copy of the selected 901 
code.

6.  In the Plus One text box, type the plus one code. This code will be added to the base 901 
code to indicate that it is a subset of that code.

7.  In the Description text box, type a name for the code.

8.  Select the Common Code check box if you want to add this code to the 901 code explorer's 
common code category. Common codes are frequently selected by data entry personnel.

Note: You should be aware of the following restrictions:
Code Plus One is not allowed for some 901 codes, such as index codes. The New button is 
grayed if you select a 901 code that does not allow Code Plus One. 
The 901 codes must meet the minimum code size to add Code Plus One.
Using Code Plus One values may result in warnings from your State System when the 
NFIRS export is processed.
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9.  OPTIONAL: If you delete a code from the list, you can click the Restore button to re-add 
the deleted code.

10.  Click the Close Toolbar button when you are finished to save your changes and close the 
Customize Codes dialog.

Entering EMS Codes
You can enter EMS codes to extend the existing base EMS codes. This is useful when an EMS code 
description is not specific enough for your department's needs. 
To enter your EMS codes:

1.  Click the Tools menu, then select Customize, followed by Codes. 
The Customize Codes dialog displays.

2.  In the Customize Codes dialog, click the EMS Codes Tab.

Table 3-5: 901 Codes Tab Field Descriptions

Field Description

View by Category or
View Common

Lists the 901 codes by category or lists the codes that have been 
designated as common codes.

Code Displays the designated NFIC code.

Plus One The sub-code of numbers or letters that are appended to the 901 
base code. Using a sub-code enables you to create a more specific 
sub-code. For example you may want more specific codes for staff 
vehicles.

Description Describes the 901 code or the sub-code you entered.

Common Code Indicates the 901 code is a common code. Common codes are 
frequently selected by data entry personnel. Common codes are 
listed at the top of the Code Explorer to make it easy for personnel 
to select.

Code Size The minimum code size required for a 901 code to be a valid 
look-up value within the selected category. This also indicates the 
minimum size a code must be before you can add a code plus one. 
(Code Size=2 means 901 codes must be two characters long 
before you can add a code plus one to it.)
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3.  Select the code category to which you wish to add a new code from the Category 
drop-down list. 

4.   In the Code text box, type an alphanumeric code that represents the EMS code you are 
creating. 

5.  In the Description text box, type a name for the code. The Code and Description is used by 
data entry personnel to identify the value in selection lists in FireRMS. 

6.  Repeat Steps 3 through 4 to enter additional EMS codes.

7.  Click the Close Toolbar button when you are finished to save your changes and close the 
Customize Codes dialog.

Viewing or Adding Chemical Codes
FireRMS provides you with chemical look-up tables you can check so that you can clearly define
the chemicals involved in an incident as required by NFIRS. The chemical look-up tables include

Note: Systems setup to use NEMSIS should not modify EMS Codes through the 
FireRMS User Interface, but should use Excel to update the Spreadsheets provided for each 
NEMSIS reporting system and then re-import the Code set through SQL Utils. 
See the FireRMS NEMSIS Administrator’s Guide for more information on using NEMSIS 
and NEMSIS EMS Codes.

Note: The Restore option restores all base EMS codes deleted from the category. The Plus 
One codes are not restored.
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drop-down lists and Explorers. The list of chemicals provided with FireRMS was created by NFIC, 
but you may add additional codes if desired. The NFIRS Extract will include the code name rather 
than the code number, so you may use any numbering scheme appropriate for your local agency.
To view the chemical codes:

1.  Click the Tools menu, then select Customize, followed by Codes. The Customize 
Chemical Codes dialog displays.

2.  In the Chemicals tab, click Search by Name or View Common. Search by Name enables 
you to click the Search button and enter a chemical name to search for. Click View 
Common to list chemicals designated with common codes. Table 3-6 contains descriptions 
of the fields on this tab.

3.  Click the Close Toolbar button when you are finished to save your changes and close the 
Customize Codes dialog box.

Table 3-6: Chemicals Tab Field Descriptions 

Field Description

Search by Name or
View Common

Search for a chemical by name or list the chemicals designated 
with common codes.
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Note that FireRMS 4.4 or later enables you to add chemical names if the code does not exist in the 
system-wide list. 
FireRMS supports three new security options to control access to the Chemical Code List:

Menu, Tools, Add Chemicals: When this security option is set to 3 – Full Access, users in 
the security group are able to add new codes to the Chemical Code list. Security Option 
‘Menu, Tools, Customize Chemicals’ must also be set to 3 in order to access the Chemical 
Code List tab. 

Menu, Tools, Customize Chemicals: When this security option is set to 3 – Full Access, 
users in the security group are able to view the Chemical Code List tab and modify the data 
for all existing Chemicals. If the other two new security options (Menu, Tools, Add 
Chemicals & Menu, Tools, Delete Chemicals) are set to 1, a user with this security option 

Name The standard chemical or trade name by which the hazardous 
material is commonly known. Products from different 
manufacturers with similar chemical ingredients may have 
different trade names. The proper entry for this field is the 
chemical or trade name of the hazardous material as shown on the 
MSDS, product label, packaging or container.

Name for Ordering and 
Locating

An alternate name used when ordering or locating the chemical.

Number The identification number assigned to the chemical by the 
National Fire Information Council (NFIC).

DOT Identifier The identification number assigned to the chemical by the 
Department of Transportation (DOT) Hazard Classification 
system.

Cas No The identification number assigned to the chemical by the 
Chemical Abstract Service (CAS).

Common When checked, designates the selected Chemical code as a 
common code. A common code is one that is frequently selected 
by data entry staff. Common codes are moved to the top of the 
Code Explorer to make it easier for data entry personnel to locate 
and select them.

Cache File Indicates that FireRMS is reading the Chemical codes from a 
cache file.

Table 3-6: Chemicals Tab Field Descriptions (Continued)

Field Description
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set to 3 will not be able to Add or Delete Chemicals to or from the existing list. This 
security option must be set to 3 in order to access the Chemical Code List tab.

Menu, Tools, Delete Chemicals: When this security option is set to 3 – Full Access, users 
in the security group with this access level are able to delete codes from the Chemical Code 
list. (Security Option ‘Menu, Tools, Customize Chemicals’ must also be set to 3 in order to 
access the Chemical Code List tab). 

Adding Apparatus and Staffing Apparatus
You must add all units in your department as well as those from other departments that may appear 
in incident reports. Apparatus can include mutual aid vehicles, police vehicles, unit radio 
identifiers, and private ambulances. The apparatus are added to the Apparatus Finder that data entry 
personnel use to select units for incident reports.
You can also define the staffing for each type of apparatus. If the staffing is not adequate, the 
non-compliant node in the Daily Roster indicates the apparatus has insufficient staff.

To add your apparatus:

1.  Click the Tools menu, then select Customize, followed by Apparatus. 
The Customize Apparatus dialog displays.

Note:   The EMS Code Builder Program is no longer required to set up Advanced EMS 
for new databases or to add new EMS Codes. To set a new Database to use the Advanced 
EMS Module in Incidents, go to Tools>Administration>System>Settings and click on 
the button labeled Use Advanced EMS. This button is only available on Enterprise 
Licensed systems when Advanced EMS is not already enabled. All available EMS Code 
Categories now display by default in the EMS Codes List (Tools>Customize Codes>EMS 
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2.  In the Basic Info tab, click the New button.

3.  Enter the information in the fields provided. Table 3-7 contains descriptions of the fields on 
this tab.

4.  In the Unit ID text box, type the unit identifier for dispatch. 

5.  In the Type drop-down, select the unit type that best describes this unit.

6.  In the Assigned To drop-down, select an assignment for the unit. The unit can be assigned 
to the Division, Battalion, Station or Department level. Skip this step if this unit is not 
assigned to your agency.

7.  If this unit does not belong to your department, select the Not Our Unit check box, and 
select the agency to which the unit belongs from the Agency drop-down.

8.  Click Add to select a department position from the drop-down, and enter a quantity. Enter 
the shift start and end times for each position.

9.  OPTIONAL: Select a position and click Delete to remove a staffing position.

10.  Click the Apply to all types button to apply this staffing position to all apparatus of the 
same type. For example, if you select a position for ENG1 and you click this button, this 
staffing position will also apply to the remaining engines, e.g. ENG2, ENG3, ENG4.
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11.  Click the Close Toolbar button to save your changes and close the dialog.

.

Table 3-7: Basic Info Tab Field Descriptions 

Field Description

Unit ID The unit identifier used by CAD or your dispatch center. The ID 
can be any alphanumeric character combination of up to six 
characters. For those departments using the SMS/CadLink, this 
must be the same as the ID that CAD uses to identify the unit.

Type The option that best describes the type of unit.

Assigned To An assignment for the unit from the department structure. For 
example, to assign the unit to a particular station, select Station 
from the first drop-down list, then select the station name from the 
second list. 

Not Our Unit Indicates the unit does not belong to your department. This is an 
important option for identifying units from mutual aid agencies 
that appear in your incident reports. Mutual aid units that are 
marked as “Not Our Unit” are excluded from your NFIRS exports 
to prevent them from being reported twice for the same 
incident--once by your agency and once by the mutual aid agency. 
“Not Our Unit” is also useful for identifying other units that arrive 
on scene such as police vehicles or private ambulances.

Agency When Not Our Unit is active, this selection would be the agency to 
which the unit belongs.

Position Lists all the positions that were created on Department Codes tab.

Note: NFIRS does not support more than 5 characters for a unit ID, but FireRMS allows 
you to create apparatus records with up to 8 characters for the Unit ID. This value is 
truncated to the first 5 characters only when the Apparatus is included on an Incident 
Report which is exported for NFIRS reporting. 
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Adding Personnel
You will create a personnel record for each employee. Each employees personnel information, 
assignment information, and login information is stored in the personnel record.

To add personnel records:

1.  Click the Personnel button on the desktop.

2.  Click the New button on the List tab. The Basic Info tab displays.

3.  Enter the information in the fields displayed in red. This includes name, assignment 
information and schedule information. After entering this information you can enter Login 
Information, such as a Login Name, to restrict access to the employees personal 
information. You can then enter information in the remaining optional fields. Table 3-8 
contains descriptions of the fields on this tab.

4.  Proceed to the next section to enter additional personal information such as home phone 
number and emergency contact information. You can also restrict access to this information 
so that only authorized FireRMS users can access it.
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Table 3-8: Basic Info Tab Field Descriptions 

Field Description

Name and Address The first and last name of the employee, the middle initial, Suffix, 
street address, City, State, and Zip Code.

Login Name The name the employee uses to login to FireRMS.

Security Group The security group to which you are assigning the employee. The 
employee will have access to the FireRMS information and 
features assigned to this group.

Create Password The password the employee will use to login to FireRMS.

Date Filtering Only Indicates the Incidents are filtered by the date displayed at the 
bottom of the FireRMS window, instead of the logical hierarchy.

Start Date The employee's date of hire. If this employee will start the job at a 
future date, you may type the employee's anticipated start date. 
This allows you to schedule the employee in advance.

End Date The termination date of the employee.

Employee Number The unique identification number assigned to this employee by 
your agency. Employee numbers are used to identify employees 
and to track employee activities in FireRMS. The data entry 
personnel use employee numbers to quickly find employees in 
FireRMS.

NFIRS5 The option that describes the employee's primary duty as defined 
by NFIRS version 5 codes.

Position Indicates the employee's position in the department.

Status Identifies the person as a career employee or a volunteer.

Schedule The employee's primary shift pattern.

Shift The employee's primary shift assignment. Shifts are indicated 
using letters.

Assigned To The department level to which the employee will be assigned; 
Dept, Division, Battalion, or Station. If you select Station, you 
must also select the station name.

Apparatus The employee’s unit assignment, if a unit was assigned.
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NEMSIS Fields: If your department is using NEMSIS EMS reporting in FireRMS, you need to 
update the NEMSIS fields for all users that respond to EMS calls. For more information, see the 
NEMSIS Guide for FireRMS for additional information on these fields.   

Entering and Restricting Employee Contact Information
You can enter employee contact information such as home phone and emergency contact. FireRMS 
also allows you to restrict access to this information. Restricting access limits viewing of this 
information to authorized FireRMS users only. It also excludes the phone number from general 
employee rosters and other reports intended for distribution to general staff.

To enter employee contact information and restrict access to information:

Secondary Tab A secondary assignment for an employee. The options on this tab 
are the same as those on the Primary Tab.

Table 3-8: Basic Info Tab Field Descriptions (Continued)

Field Description

Note: Your selections for Assigned To and Apparatus affect the Incidents a person can 
view. For example, if you assign a person to Batt2, incidents assigned to Batt2 appear on 
this person’s Incidents list. If you also assign this person to ENG1, and you add ENG1 as 
the incident’s apparatus, this incident also appears on this person’s Incidents list.
For a description of the Incidents your personnel can view, see “Determining The Data 

Your Personnel Can View” on page 1-10.
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1.  In the Personnel Information dialog, click the Communication tab. (The information you 
enter applies to the name of the employee that was displayed on the Basic Info tab when 
you selected the Communication tab.)

2.  Enter the information in the fields provided. Table 3-9 contains descriptions of the fields on 
this tab.

3.  Select the Restricted check box next to the emergency contact’s home phone number, to 
restrict access to that information.

4.  Click the Close Toolbar button to save your changes.

If you want to restrict access to the information you entered, you must restrict access to security 
groups for the following Restricted Objects; Form, Personnel Info, All, Restricted and Form, 
Personnel Info, You, Restricted.

For information, see “Creating Security Groups and Defining Access Rights” on page 3-31.

Table 3-9: Communication Tab Field Descriptions 

Field Description

Home Phone Enter the employee’s home phone number. A check mark in the 
Restricted box restricts access to this information.

Emergency Contact Enter information for the person to contact in case of emergency 
(e.g., a spouse).

Mobile Phone Enter the employee’s mobile phone number. 
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Entering Cities
You must add all the cities in your service area. You must do this prior to creating incident reports 
or performing any other data entry tasks in FireRMS. These cities are added to the City Finder, 
which is available to users anywhere a city can be entered in FireRMS.

To add the cities in your service area:

1.  Click the Tools menu, then select Customize, followed by Cities. The Customize Cities 
dialog displays.

2.  On the Cities tab, click the New button.

3.  In the City text box, type the city name.

Work Phone Enter the employee’s work phone number and extension.

Email Address Enter the employee’s email address.

Pager Number/Address Enter the employee’s pager number or address.

Additional Numbers Enter any additional contact numbers for the employee.

Table 3-9: Communication Tab Field Descriptions (Continued)

Field Description
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4.  In the State drop-down, select the state or province to which the city belongs.

5.  Repeat Steps 2 through 4 for each city you wish to enter.

6.  You then have two choices:

If you want to enter numbers to associate with a city, such as a zip code, click on the 
city to which you wish to add a number, click the Numbers tab and perform the next 
procedure.

Click the Close Toolbar button when you are finished to save your changes and close 
the Customize Cities dialog.

Entering Numbers for Cities
After you enter cities, you can add a variety of numbers or names, e.g., Agency, that you want to 
associate with that city. These numbers/names include zip codes, districts, or census tracts. These 
numbers/names are available in the City Finder.

To enter numbers for cities:

1.  In the Customize Cities dialog, click the Numbers tab, followed by the New Toolbar 
button.

2.  Enter the information in the fields provided. Table 3-10 contains descriptions of the fields 
on this tab.
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3.  Click the Close Toolbar button when you are finished to save your changes and close the 
Customize Cities dialog.

After you complete this procedure, if you are using the Welcome Wizard, click the check box 
labeled Don’t show this again if you do not want to wizard to display again, then click the box 
next to 6) Finished, Go To Desktop.

Table 3-10: Numbers Tab Field Descriptions

Field Description

Type The number or the name you wish to add:
Census Tract -- Used to create a list of census tracts within a city. 
This is useful when your agency wants to record census tract as 
part of the incident location in incident reports. 
County -- Used to enter the county or counties within which city 
boundaries lie. This is useful when your agency wants to record 
county as part of the location information in incident reports. 
Select the county you want from the drop-down list.
District -- Used to create a list of districts within a city. This is 
useful when your agency wants to record district number in the 
location information in incident reports.
Zip Code -- Used to create a list of possible zip codes for a city. 
Entering zip codes helps to ensure that the correct zip code is 
selected by data entry personnel.
Agency -- Used to create a list of agencies within a city. Agency 
information is used in incident reporting when multiple agencies 
share the same FireRMS database, allowing you to identify which 
agency responded to the incident. After selecting this option, 
select the agency you want from the drop-down list.
Other -- Used to record other miscellaneous numbers for a city. 
Other numbers are used for incident reporting to further 
differentiate incident records for reporting purposes. For example, 
you could select Other to identify contract service areas or special 
circumstances.

Name/Number The name or number you enter based on the Type you selected.
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Entering Streets
As part of the FireRMS setup process, you need to add all the streets in your service area. This 
should be done prior to creating incident reports or performing any other data entry tasks. These 
streets are added to the Street Finder, which is available to users anywhere a street can be entered in 
FireRMS.

To define the streets in your service area:

1.  Click the Tools menu, then select Customize, followed by Streets. The Customize Streets 
dialog displays.

2.  On the Streets tab, click the New button. 

3.  Enter the information in the fields provided. Table 3-11 contains descriptions of the fields 
on this tab.
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4.  Repeat Steps 2 and 3 to enter additional streets.

5.  You have two choices:

Select a street name and click the Blocks tab if you want to define block ranges for a 
street. Follow the procedure in the next section.

Click the Close Toolbar button when you are finished to save your changes and close 
the Customize Streets dialog.

Table 3-11: Streets Tab Field Descriptions

Field Description

Search or
Show All Streets

Enables you to view all streets or search for a street. To search for 
streets, click Search, type a street name in the text box, and click 
the Search button. You can type a partial street name. For 
example, type “P” and click the Search button to see all streets 
that begin with the letter P.

City The city for which you want to either enter streets or view streets. 
To add cities to the list, use the Customize Cities dialog.

Prefix The prefix of the street, e.g., N - North.

Street Name The street name.

Street Type The type of street, e.g., AVE - Avenue.

Suffix The street suffix, e.g., S - South.

Aliases Displays a dialog box, in which you can choose one or more 
aliases for the street. You can choose the aliases from the list of a 
street name that you previously entered. You may want to assign 
an alias to a highway passing through a city that is known by two 
names: the highway name and a street name within the city limits.

Alias Only When checked, this box indicates this street name is not 
legitimate.
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Entering Block Ranges for a Street
You can define block ranges for your streets. Block ranges allow you to define the acceptable range 
of values for address numbers on a particular street. Address numbers outside of the defined block 
range are not allowed for the street.

To define the block ranges for streets:

1.  On the Streets tab of the Customize Streets dialog, select the street for which you will 
define blocks.

2.  Click the Blocks tab, and click the New button. 

3.  Enter the information in the fields provided. Table 3-12 contains descriptions of the fields 
on this tab.

4.  Repeat Steps 2 and 3 to enter multiple ranges for a street.

5.  Click the Close Toolbar button when you are finished to save your changes and close the 
dialog.

After performing all the setup procedures in this chapter, you must create security groups for the 
personnel and define their access rights.

For information on completing these tasks, see “Creating Security Groups and Defining 
Access Rights” on page 3-31.

Table 3-12: Blocks Tab Field Descriptions

Field Description

Blocks for The name of the street you chose on the Streets tab for which you 
are selecting a block range.

Starting Block The lowest possible address number in the block range.

Ending Block The highest possible address number in the block range.
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Creating Security Groups and Defining Access 
Rights

Security groups control user access to information in FireRMS. A designated security group gives 
users access to the features they need while protecting data integrity and securing privileged 
information. After creating security groups, you must define the access rights that the group has to 
the FireRMS data. Access to data is derived from security objects that correspond to menu items, 
forms, or the desktop. The level of access you assign to an object for the group controls the ability 
of the members of a security group to access and modify data in FireRMS.

To create security groups and define access rights:

1.  Click the Tools menu, then select Administration, followed by Security.

2.  On the Security Groups tab, click the New button. The Security dialog displays.

3.  In the Security Group Name text box, type a name for the group.

4.  Repeat Steps 2 and 3 for each security group you want to create.

5.  After creating all security groups, click the security group name for which you want to 
define access.

6.  Click the Access Rights tab.
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7.  Click the name of the object to which you want to restrict access.

8.  Under Access Code, select a security object to which you want to change access and select 
the following:

1 - Denies the users in the security group the ability to view or modify the selected 
object.

2 - Allows the users in the security group to read but not modify the selected object.
3 - Allows the users in the security group to have full access (read/write) to the 

selected object.
For information about each security object on the Access Rights tab and the access 

you have with 1, 2, or 3, see “Access Rights Definitions” on page A-1.

9.  Repeat Step 8 for each security object you want to change, then repeat steps 5 through 8 for 
each group to which you want to define access.

10.  OPTIONAL: Click the Preferences tab and select a default desktop from the Start Up 
Desktop Page drop-down box for all security groups. The desktop you select will display 
for all users.

11.  Click the Close Toolbar button when you are finished to save your changes and close the 
Security dialog.

Another security option is also available to prevent users from setting up new or existing personnel 
as members of any restricted security group. This option is available under Menu>Tools> Admin> 
Security, SecLevel.

 To enable this option:

1.  Go to the System Settings tab and click on the new checkbox labeled Personnel Security. 

2.  Next go to the Security list (under Tools>Admin>Security) and use the new scroll boxes to 
set security levels for each group. Groups with a higher security value are able to update the 
security group in personnel to any group of the same or a lower value. You only need to 
modify the values for groups that should have higher level securities. 
 The default level for all groups is zero.   

For example: Security Group “SYS” has security Level 5. Security Group “SUPER” has security 
level 4. All other security groups have security level 0 (default). 

A user in the SYS group is able to assign anyone in personnel to be a member of the SYS 
group or below. 

A user in the SUPER group is able to assign anyone in personnel to the SUPER group or 
below only, but not to anyone in personnel to the SYS group. 
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A user in any lower level security group is able to assign anyone in personnel to any other 
security group EXCEPT for SUPER or SYS.

Creating Personnel Security Settings
FireRMS 4.4 or later enables you to select security levels for users or groups of users, and restricts 
users from setting up new or existing personnel as members of any restricted security group. 

1.  Click on the Tools menu, select Administration, followed by System and Settings. 

2.  You must first enable the personnel security groups option by checking on the Personnel 
Security checkbox under More Settings. 

3.  Save your changes and exit the dialog box. 

Applying Exclusions for Security Groups
You can also restrict users within a multi-tiered security system with Security Rights Authorization 
without locking out access to all other security settings. 

1.  Click the Tools menu, then select Administration, followed by Security.

2.  Select the Exclusions tab. Use the Name of Restricted Object and Security Group Name 
tabs to assign or restrict security access to users. 

3.  Use the scroll boxes to set security levels for each group.
Groups with a higher security value are able to update the security group in personnel to 
any group of the same or a lower value. You only need to modify the values for groups that 
should have higher level securities. The default level for all groups is zero.   

4.  Save your changes and exit the dialog box. 

Creating Local Help 
FireRMS 4.4 or later allows you to add local help definitions for fields. Systems with multiple 
databases can share the new local help through the SQL Utilities UDShare function.
To set up local help:

1.  Go to Tools>Administration>System>Settings.

2.  Select Initiate Design Mode from the box titled Dynamic Property Changes. 
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3.  Restart FireRMS locally. 

4.  Open any form in FireRMS locally and right click on any field on the form. The system 
displays the Properties sheet. 

5.  Use the Help Info tab to bring up the local help form for any field and enter information. 
You must enter a title if you want to share this information across multiple databases. Press 
save and close when you are done entering the information.

Exporting and Importing Local Help across Multiple 
Databases 
To export and import local help across multiple databases:

1.   Launch SQL Utils and lock the database where the help was created. 

2.  Go to the UDShare tab and click on the sub tab labeled Export. 

3.  Click on the dropdown arrow and highlight the <CUSTOM HELP> choice from the 
displayed list of options.   

4.  Enter a filename in the field labeled Save as File and use the required .XML extension for 
the filename. 

5.  Click the Export button. This changes the local help into an XML file that can be stored on 
a local server. You may optionally click on the 'browse' button to store the file in any 
network location.

6.  After you have created the XML file, lock the database into which you wish to import the 
Local Help data. 

7.  Go to the UDShare tab and click on the sub tab labeled Import. 

8.  Click on the browse button and select the XML file created in the previous step. 

Note: Local Help is saved in XML file format. It is important to follow the rules for XML 
Formatting especially for non-alpha characters when you are creating local help.   
Characters such as angle brackets (<) and (>) are not supported in XML unless they include 
special wrappers. Administrators are advised to restrict local help entries to basic alpha, 
numeric and punctuation characters to avoid display issues or to ensure data entered is 
XML compliant.
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9.  Click on the Load from File button to run the import process. 
When the import is complete, the help text set up for each field in the first database displays 
in the second selected database. 

10.  Repeat the import process for each additional database. 
Creating Local Help     3-35



3-36     Chapter 3: Performing Initial Set Up Procedures



4 4

Chapter 4:Customizing Additional Modules

This chapter describes how to customize the remaining FireRMS modules. You only have to 
customize the modules you plan on using. You will customize these modules using the commands 
on the Tools menu. The remaining modules include:

Customize Hydrants - The Customize Hydrants selection enables you to perform customization 
tasks specific to the Hydrants module. This includes creating a list of hydrant related actions, 
identifying staff, and defining a hydrant numbering scheme.

Customize Occupancies - The Customize Occupancies selection enables you to perform 
customization tasks specific to the Occupancies module. This includes creating a list of 
occupancy-related actions and assignments, setting up an occupancy-numbering scheme, and 
defining building codes for use in occupancy descriptions.

Customize Incidents - The Customize Incidents selection allows you to perform customization 
tasks specific to the Incidents module, such as setting billing rates used by agency resources or 
selecting default settings. 

Customize Vehicles and Equipment - The Customize Vehicles and Equipment selection module 
allows you to perform customization tasks specific to the Vehicles and Equipment module. This 
includes creating lists of vehicle and equipment related actions, creating a list of equipment 
categories, and creating an assignment list for vehicles and equipment.

Customize Training - The Customize Training selection allows you to perform customization 
tasks specific to the Training module. You can create your classes, objectives and skills, credentials 
and training standards, and define the default results for classes and objectives/skills.

Customize Other Entries - The Customize Other Entries selection allows you to perform 
customization tasks specific to the Other Entries module. Specifically, you can define the default 
results for other entry events.

In addition to customizing the remaining modules, you can customize the following items in 
FireRMS:
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Advanced EMS Protocols - You can design Advanced EMS protocols that are displayed 
on the Flow Chart tab.

Default Result Fields - You can define the default results fields on the Class Explorer, the 
Objective Explorer, the Participants tab, and the Objectives/Skills tab.

Tabs: Labels, Sort Order, Visibility - You can customize tab labels, sort order, and 
visibility for Advanced EMS, Basic, and Incidents tabs.

Custom Tabs for Incidents and Advanced EMS - You can create custom tabs for 
Incidents and Advanced EMS. You can create text boxes, combo boxes, check boxes, and 
labels for these tabs.

Object Properties for All Modules - You can reposition fields, change the visibility, or 
indicate the fields are mandatory or recommended. You can also, change field labels or hide 
them.

Customizing Hydrants
You will customize hydrants by creating a list of actions to be assigned, identifying staff that can be 
assigned hydrant activities, and selecting a hydrant numbering scheme.

Creating Hydrant Actions
You can create a list of hydrant-related actions in FireRMS. These actions are added to look-up 
tables (drop-down lists, Explorers) in the Hydrants module. Users who are scheduling 
hydrant-related actions can select these actions.

To create hydrant actions:

1.  Click the Tools menu, then select Customize, followed by Hydrants.... The Customize 
Hydrants dialog displays.

2.  On the ACTIONS tab, click the New button.
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3.  In the Code text box, type an action code for the inspection. This unique number is used to 
identify the action in the Hydrants module. You may enter up to 14 alphanumeric 
characters.

4.  In the Description text box, type a description of the action. This is used in addition to the 
code to identify the action in the Hydrants module.

5.  In the Default Fee text box, enter a default dollar amount for the action.

6.  In the Priority text box, assign a priority level to the action. This indicates, to the user, the 
order in which the actions should be performed. A number one is the highest priority and 
number nine is the lowest.

7.  Click the Close Toolbar button when you are finished to save your changes and close the 
dialog.

Selecting Staff To Be Assigned Hydrant Activities
You can identify staff available for assignment to hydrant activities. These entries are added to the 
Assignment Explorer, which is used by data entry personnel to assign actions in the Hydrants 
module.
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To select staff to assign hydrant actions:

1.  Click the Tools menu, then select Customize, followed by Hydrants. The Customize 
Hydrants dialog displays.

2.  On the ASSIGNMENTS tab, choose one of the following:

Click Persons to identify a specific person available for assignment (for example, Joe 
Brown) and click the New button.
a)  In the ID text box, enter a label to identify the entry (for example, Fire Marshall). 

This label will help data entry personnel find the entry on the Assignment Explorer.
b)  Click the Explorer button to display the Personnel Explorer dialog, select a person 

and click the OK button. The Code text box is filled with the person’s Employee 
Number.

Click Department Structure to identify a structure level and location available for 
assignment (for example, Station, Station 10) and click the New button. If you choose 
Department Structure, whomever fills the position is responsible for the assigned 
action.
a)  In the ID text box, enter a label to identify the entry. For example, “RepHydrants.” 

This label will help data entry personnel find the entry on the Assignment Explorer.
b)  Select the following:

Level - Select a department structure level.
Location - Select a location within the selected level.
Apparatus - If applicable, select an Apparatus available for the assignment.
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Shift - If applicable, select a Shift responsible for the assignment.

3.  Click the Close Toolbar button when you are finished to save your changes and close the 
dialog.

Selecting a Hydrant Numbering Scheme
The hydrant numbering scheme you select determines how these numbers are assigned in the 
Hydrants module. Each hydrant must have a unique identification number in FireRMS.

To create a hydrant numbering scheme:

1.  Click the Tools menu, then select Customize, followed by Hydrants.... The Customize 
Hydrants dialog displays.

2.  On the Numbering tab, select one of the following radio buttons:

No autoincrement - Indicates each new hydrant number must be manually assigned 
by data entry personnel. FireRMS will prevent you from re-using the same number.

Auto Number existing field beginning at last highest number - Indicates FireRMS 
automatically assigns the next sequential number based on the highest hydrant number. 
For example, if the highest hydrant number is 000120, the next hydrant number would 
be 000121. Enter the starting hydrant number in the text box, e.g., 0001 or HYD-0001.
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Insert Mask and prompt next number in sequence - Creates a numbering scheme 
based on fire management zones. Under this system, when a new occupancy is created, 
the zone number is applied followed by the next sequential number. For Example: If 
you have fire management zone 1901, each hydrant number would consist of 1901 plus 
a unique code--1901-001, 1901-002 and so on.
a)  Click the New button to add a new Fire Management Zone (FMZ) number to 

FireRMS. The following fields display:
Code - The zone number.
Description - A description of the zone.
Default FMZ code - Makes the selected zone number the default number, which is 
the number that always appears first when you create a new hydrant entry.

3.  Click the Close Toolbar button and click Yes when you are prompted to save your changes.

Customizing Occupancies
When you customize Occupancies, your users can:

Create a list of occupancies in your service area
Schedule building related actions such as inspections and record the results
Maintain detailed records on each occupancy
Create occupancy-related letters

Setting a Default View For the Occupancies Activities Tab
You can select a default view for the Activities tab of the Occupancies module. You can change this 
view within the Occupancies module, but it is always reset to the default view.

To select a default view:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Default View of Activities List drop-down list box select one of the following 
default views:

Single List - Displays Actions and Findings together in a single list.
Double List - Displays Actions and Findings on separate lists.
Custom List - N/A
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Creating a List of Building-Related Actions
You can create a list of building-related actions such as inspections, pre-plan visits and public 
education events, that can be assigned to occupancies in FireRMS.

To create a list of building-related actions:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Actions tab, click the New button.

3.  In the Code text box, type a unique action code of up to 14 alphanumeric characters for the 
action. This number is used to identify the action in the Occupancies module.

4.  In the Description text box, type a description of the action. The description helps users 
identify the action in the Occupancies module.

5.  OPTIONAL: Type a default dollar amount, in the Default Fee text box.

6.  In the Priority text box, assign a default priority to an action, with 1 being the highest 
priority and 9 being the lowest.

7.  In the Reinspection Action field, select a default reinspection action for each activity by 
selecting a code from the list if you are using FireRMS Mobile clients to complete 
occupancy reports. When a mobile client completes an Occupancy inspection, this default 
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value can be used to schedule a reinspection, or you can clear the field, or select an alternate 
activity as appropriate.    

8.  Repeat Steps 2 through 6 for each action you want to create.

Creating a List of Occupancy Findings
You can create a list of findings that may result from an occupancy activity. These findings are 
added to look-up tables (drop-down lists, explorers) in the Occupancies module and can be selected 
by users who are entering the results of occupancy-related activities.

To create a list of occupancy findings:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Findings tab, do one of the following:

Click the Findings node (top level node) on the tree view, and click the New button to 
add a new group to the tree view. A group is a logical collection of individual findings 
that makes it easier to locate findings in the tree view. 
a)  Enter the group name in the Group text box.

Click the group in the tree view to which you wish to add a finding, and click the New 
button. A finding is an individual event related to an occupancy activity, such as the 
result of a permit inspection.
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a)  In the ID text box, enter the ID number for the finding, following your agency’s 
code system. This number will be used to identify the finding in the Occupancies 
module and on reports. You must enter a unique number for each finding.

b)  In the Short Description text box, enter a brief description of the finding. This 
description will be used on reports and will also be used with the code to identify the 
finding in the Occupancies module and on reports.

c)  On the Full Text tab, you can enter a more complete description of the finding.
d)  You can click the Standards tab and then the Add button to relate a set of standards 

to a finding. Types of standards you may want to relate to a finding include uniform 
fire codes (NFPA Standards), uniform building codes, and so on.
For Dates - Indicates the Start and End date for which the standard is in effect. 
Leave the End date blank while the standard is current.
Type - Indicates the category to which the standard belongs: Nat, State or Local.
Standard - Indicates the standard you want to relate to a finding, e.g., uniform fire 
codes or uniform building codes.
Reference - Indicates any miscellaneous reference to the standard, such as an 
edition number.

e)  You can click the National Code Set tab and then the Add button to relate a set of 
IFC standards to a finding if you have purchased licensing to integrate Electronic 
IFC Code sets with your FireRMS database. You may associate one or multiple IFC 
regulations with each finding. If your licensing model allows, additional IFC 
regulations can be added to the Finding in the Occupancy module, or on the 
FireRMS Mobile Occupancy report at the time an inspection is completed.

Entering Staff Available for Occupancy Assignments
You can identify staff available for assignment to occupancy activities, e.g., inspections. These 
entries are added to the Assignment Explorer, which is used by data entry personnel to assign 
actions in the Occupancies module.
To enter staff available for occupancy assignments:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

Caution: If you delete a Group, all findings in the Group are also deleted.
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2.  On the ASSIGNMENTS tab, choose one of the following:

Click Persons to identify a specific person available for assignment, e.g., Joe Brown, 
and click the New button.
a)  In the ID text box, enter an ID number that is logically tied to a position assignment. 

For example, the ID for station 51, shift C could be 51C. A logical system of ID 
numbers can speed the reporting process and make it easier to identify the 
assignments on which you wish to report.

b)  Click the Explorer button to display the Personnel Explorer dialog, select a person 
and click OK. The Code text box is filled with the person’s Employee Number.

Click Department Structure to identify a position within the department structure 
available for assignment, e.g., Station 1, Shift A, and click the New button. If you 
choose Department Structure, whomever fills the position is responsible for the 
assigned action.
a)  Select the following:

Level - A department structure level.
Location - A location within the selected level.
Apparatus - If applicable, select an Apparatus available for the assignment.
Shift - If applicable, select a Shift responsible for the assignment.

Note: If a person transfers to a new position in the department, the replacement 
automatically inherits the assignment.
4-10     Chapter 4: Customizing Additional Modules



FireRMS Administrator’s Guide
Creating a List of Occupancy-Related Permits
You can create a list of occupancy-related permits. Personnel select these permits when entering 
permit information in the Occupancies module. FireRMS organizes permits into a tree view with 
three predefined categories: 

System - A permit for prevention and extinguishment systems.
Hazmat - A permit for hazardous materials.
Others - A permit for anything other than a system or hazardous material.

To create a list of occupancy-related permits:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Permits tab, select Systems, Hazmat or Others in the tree view and click the New 
button.

3.  Enter the ID number that will be used to identify the permit.

4.  Type a description of the permit.

5.  Enter the permit’s renewal cycle in months. For example, if a permit expires every 12 
months, enter 12 as the renewal cycle in the Expires every text box.

6.  In the Default Fee field, enter a default dollar amount. 
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7.  Repeat Steps 2 through 5 for each permit you are entering.

Creating a List of Standards Linked to Occupancy 
Findings
You can create a list of standards that can be linked to findings in the Occupancies module. 
Standards can dictate the frequency of a fire extinguisher inspection. FireRMS organizes standards 
into three categories: 

National - Assigns a standard to the National category.
State - Assigns a standard to the State category.
Local - Assigns a standard to the Local category.

Once you enter the standards, you can link them to findings.

For more information, see “Creating a List of Occupancy Findings” on page 4-8.

To create a list of standards linked to occupancy findings:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Standards tab, select National, State, or Local in the tree view and click the New 
button.

3.  Enter a name for the Standard.
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4.  Repeat Steps 2 and 3 to enter additional Standards.

5.  When a Finding is associated with a standard, the finding Code and Description displays in 
the Grid along with the From (start) and To (end) dates. 

Sharing Occupancy Information Between Databases
FireRMS 4.4 or later allows you to share occupancy information between databases. 
Go to Tools>Administration>Settings and select Occupancy Search from the More Settings 
section. This allows you to search for and review occupancy data between multiple databases 
located on a single SQL Server. 

When the option is enabled, a new search option displays on the Occupancy List tab in the 
Occupancy Module. You can select other databases to search, including All. You can also select a 
search method, such as by name or by number, and then enter the search criteria.
Highlight the occupancy record that is displayed on the list grid tab and press the print icon to 
display or print a report of the important occupancy information. Note that the system displays a 
read-only or print only view of the information. You can display information that includes: 
contacts, hazardous materials, systems, violations and building information.

All databases must have the system setting enabled in order to be accessed through this message. If 
a database on the local server does not have the option enabled, it does not display in the list of 
possible databases to be searched or the and the occupancy data from that database. 

Creating Groups and Assigning Building Codes
You can create a list of sub-categories known as “groups” in any of the following four categories: 
Construction Codes, Roof Codes, Occupancy Use Codes and Storage Tank Codes. Examples of 
groups created under Construction Codes would be Floors, Windows, and Interior Walls. You can 
also assign building codes to each group. After you add this information, personnel can select it 
when they enter building information in the Occupancies module.

To create a list of groups and assign building codes:

1.  Click the Tools menu, then select Customize, Occupancies..., followed by Occupancies 
The Customize Occupancies dialog displays.

2.  On the Codes tab, select the Construction & Use Codes tab to assign codes to the groups 
or select the Construction Code Groups tab to create groups.
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3.  Do one of the following:

If you selected the Construction & Use Codes tab:
a)  Select a group beneath one of the following categories: Construction Codes, Roof 

Codes, Occupancy Use Codes, or Storage Tank Codes.
b)  Click the New button.
c)  Enter the code in the Code text box.
You can, additionally, make the following selections:
Retire Group - Click this check box to retire the group and all the construction use 
codes. A date/time stamp is added to the customize page with the name of the person 
who retired the code. Retired codes will no longer display in the drop-down lists on the 
Occupancy module Building and More Building tabs. Existing occupancies where the 
code had previously been assigned will display blank fields.
Retire Codes - Click this check box to retire construction use codes. Only the code is 
retired, the group will still be active. A date/time stamp is added to the customize page 
with the name of the person who retired the code. Retired codes will no longer display 
in the drop-down lists on the Occupancy module Building and More Building tabs. 
Existing occupancies where the code had previously been assigned will display blank 
fields
Description - Enter a description of the code. The description appears next to the code 
in the list box.
d)  OPTIONAL: You can edit an existing code by highlighting it and modifying the 

code in the text box. You can also delete an existing code by highlighting it and 
clicking Delete. You are prompted to verify the deletion. Click Yes.
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If you selected the Construction Code Groups tab:
a)  Select the category or the group for which you are creating the new group.
b)  Click the New button.
c)  Enter the group in the Construction Group Code text box, e.g., floor or interior 

walls.
d)  Enter a description of the building feature in the Description text box.
You can also select the following:
Retired - Click this check box to retire construction use codes. A date/time stamp is 
added to the customize page with the name of the person who retired the code. Retired 
codes will no longer display in the drop-down lists on the Occupancy module Building 
and More Building tabs. Existing occupancies where the code had previously been 
assigned will display blank fields.
e)  OPTIONAL: You can delete an existing group by highlighting it and clicking 

Delete. You are prompted to verify the deletion. Click Yes.

4.  Click the Save toolbar button.

Note:   You can “un-retire” codes by clearing the Retire Codes check box. Un-retired 
codes will re-display in field boxes on existing occupancies where it had previously been 
assigned. Un-retiring a code clears the “retired” notation (date/time stamp and name) on 
the Customize tab.

C B ildi G
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5.  Repeat Steps 2 through 4 to enter additional building codes.

Creating Templates for Occupancy-Related Letters
You can create templates for occupancy-related letters. An example of occupancy letter is a 
standard introductory letter sent prior to a new inspection.

To create templates for occupancy-related letters:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Letter Templates tab, click the New button.

3.  In the ID text box, enter a name or number that identifies the template.

4.  Enter an amount, in inches, for the top and bottom page margins. You can use half-inch 
increments, e.g., 1.5 inches.

Note: When you create a new group, it will not appear in the list box on the Construction 
& Use Codes tab until you save your changes, close the Customize Occupancies dialog, 
and re-open this dialog.
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5.  Type an amount, in inches, for the left and right page margins.

6.  Type the text of the header and footer that appears in the letter.

7.  Choose a selection listed in Table 4-1 from the drop-down list box and click the Insert 
button. The list box contains information taken from the FireRMS database that is entered 
into the template letter.

Table 4-1: Template Field Selections 

Selection Description

Today’s Date Inserts the current date (according to the workstation's system 
settings).

Contact #1 Fullname Inserts the first and last name of the occupancy contact, e.g., a 
business manager.

Contact #1 Firstname Inserts the first name of the occupancy contact.

Contact #1 Lastname Inserts the last name of the occupancy contact.

Address Inserts the occupancy address as entered in FireRMS.

City/State/Zip Enters the occupancy city, state and zip code as entered in 
FireRMS

Contact #1 Phone (Day) Inserts the daytime phone number of the occupancy contact.

Contact #1 Phone (Night) Inserts the nighttime phone number of the occupancy contact.

Occupancy Name Inserts the name assigned to the Occupancy in FireRMS. The 
occupancy name may be the name of the company leasing a 
building.

Address Inserts the address of the occupancy.

City, State, Zip Inserts the city, state and zip code of the occupancy.

Occupancy ID Inserts the ID of the occupancy.

Occupancy Phone Inserts the phone number of the occupancy.

Note: Contact #1 is the first contact listed on the Occupancy Info > Contacts tab of the 
Occupancies module.
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8.  OPTIONAL: Click the Preview button to view or print the template.

Occupancy Fax Insert the fax number of the occupancy.

Business License Inserts the business license number of the occupancy.

Owner Full Name Inserts the first and last name of the owner of the property.

Owner First Name Inserts the first name of the owner.

Owner Last Name Inserts the last name of the owner.

Owner Address Inserts the address of the owner.

Owner City/State/Zip Inserts the city, state, and zip code of the owner.

Owner Phone (Day) Inserts the daytime phone number of the owner.

Owner Phone (Evening) Inserts the nighttime phone number of the owner.

Occupant Full Name Inserts the first and last name of the occupant of the property.

Occupant First Name Inserts the first name of the occupant.

Occupant Last Name Inserts the last name of the occupant.

Occupant Address Inserts the address of the occupant.

Occupant City/State/Zip Inserts the city, state, and zip code of the occupant.

Occupant Phone (Day) Inserts the daytime phone of the occupant.

Occupant Phone 
(Evening)

Inserts the evening phone of the occupant.

List Uncleared Findings Inserts the most recent finding that does not have a cleared date. 
This can be useful for including unresolved issues in the letter.

Next Action Date Inserts the next date that an action is scheduled for the occupancy.

List Pending Activities Inserts the activities not yet completed for the occupancy.

Table 4-1: Template Field Selections (Continued)

Selection Description

Note: You can add text from external files into FireRMS text areas, such as the letter 
template. Select the text in the source field and press CTRL+C. In FireRMS, click in the 
text box you wish to insert the text and press CTRL+V
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Choosing an Occupancy Numbering Scheme
You must choose an occupancy numbering scheme in which each occupancy has a unique 
identification number in FireRMS. The occupancy numbering scheme determines how these 
numbers are assigned in the Occupancies module.

To choose an occupancy numbering scheme:

1.  Click the Tools menu, then select Customize, followed by Occupancies.... The Customize 
Occupancies dialog displays.

2.  On the Settings tab, select one of the following options:

No autoincrements - Indicates each new occupancy number must be manually 
assigned by data entry personnel. FireRMS prevents you from re-using a number.
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Auto Number existing field beginning at last highest number - Indicates FireRMS 
automatically assigns the next sequential number based on the highest occupancy 
number. That is, if the highest occupancy number is 000120, the next occupancy 
number would be 000121. Enter the starting occupancy number in the text box, e.g., 
0001 or OCCU-0001.

Insert Mask and prompt next number in sequence - Creates a numbering scheme 
based on fire management zones. Under this system, when a new occupancy is created, 
the zone number is applied followed by the next sequential number. For example, if you 
have fire management zone 1901, each hydrant number would consist of 1901 plus a 
unique code--1901-001, 1901-002 and so on.
a)  Click the New button to add a new Fire Management Zone (FMZ) number to 

FireRMS. The following fields display:
Code - The zone number.
Description - A description of the zone.
Default FMZ code - Indicates the selected zone number is the default number. 
This number always appears first when you create a new occupancy.

Occupancy Module Options: 
Copy Complex to New Subcomplex: Selecting this option auto fills or updates the 

address from an original Occupancy when any other occupancy is set to be Part Of or a 
Sub-complex or the original Complex. By default, the addresses for occupancies set as 
Part of or Sub-Complex will NOT be changed. 

Lock Occupancy ID: Selecting this option prevents users from changing any existing 
Occupancy ID code.

3.  Click the Close Toolbar button and click Yes when you are prompted to save your changes.

Customizing Incidents
You can customize Incident fields by setting billing rates for incidents, selecting forms for Aid 
Given Codes to be completed in Incident reports, and creating a narrative template for incident 
reports. You can also map your department’s EMS codes to another agency to whom you submit 
EMS incident data.

Setting Billing Rates For Incidents
You can set billing rates for the use of your agency's resources in response to incidents. For 
example, your department may charge a fee for units that respond to wildland fires outside of your 

Note: The FMZ zones you create in this module are also used in the FireRMS Hydrants 
module.
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district. A FireRMS billing report is available which multiplies the billing Rate by the Amount to 
calculate the dollar amount to be charged per resource use.

To set billing rates for incidents:

1.  Click the Tools menu, then select Customize, then Incidents, followed by Customize 
Incidents. The Customize Incidents dialog displays.

2.  On the Incident Billing tab, select Apparatus or Personnel as the Code Type, depending 
on which type of resource for which you wish to set a billing rate.

3.  In the Item list box, select the apparatus or personnel type for which you wish to set a 
billing rate.

4.  In the Rate 1 and Rate 2 text boxes, enter the dollar amount of up to two billing rates for 
the selected apparatus or personnel type.

The fields for Amount 1 and Amount 2, appear on Incident Form’s Apparatus and 
Personnel tabs. Rate 1, the first billing rate, is multiplied by Amount 1, and Rate 2, the 
second billing rate is multiplied by Amount 2. Each calculation is the amount to be charged 
for use.

The type of rate you apply depends on how your department charges for use. For example, 
you could enter a rate per hour or rate per use. The amount you enter on the incident report 
applies to the type of rate in use. For example, if the rate is per hour, you would enter the 
number of hours used. 
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Selecting Aid Given Codes Forms
You can select forms for Aid Given Codes to be completed in the Advanced EMS section of 
incident reports. Aid Given Codes are used to describe medical actions taken during an Advanced 
EMS incident. For each Aid Given Code, you can choose from a variety of forms. Each form 
contains fields in which you record information for the medical action. The form you choose 
depends on the type of information you want recorded for a particular Aid Given Code.

To select aid given codes forms:

1.  Click the Tools menu, then select Customize, then Incidents, followed by Customize 
Incidents. The Customize Incidents dialog displays.

2.  In the Aid Given drop-down of the Aid Given Codes tab, select the Aid Given Code for 
which you wish to select a form.

3.  In the Type drop-down list box, select the form that you want filled in when you select the 
Aid Given Code in the Advanced EMS section of incident reports.

4.  OPTIONAL: Enter a charge amount that will automatically be entered when a user selects 
this “Aid Given.”
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Selecting Default Settings
You can select default settings for incident reports. You can set narrative text and default headings.
To select the default settings:

1.  Click the Tools menu, then select Customize, then Incidents, followed by Customize 
Incidents. The Customize Incidents dialog displays.

2.  On the Incident Defaults tab, select the response time threshold for incident responses. 
When the first unit arrival time exceeds the response time threshold, the Response Time 
label on the Incident Form's Basic > Response tab is red. To use this feature, type the 
maximum response time allowed for incidents in the Response Time text box.

3.  In the Assessment Category drop-down box, select the category with the heading you want 
to rename.

4.  In the Category Heading text box, change the caption to the one you want used for 
Assessment categories on the Advanced EMS > Assessment tab. 

5.  In the Narrative Template text box, enter narrative text you want included in the Advanced 
EMS section of the Incident Form.

6.  OPTIONAL: You can indicate you want to use a Fire tab rather than a Wildland tab (the 
default), for fire or wildland incidents. To use the Fire tab, select a fire or wildland incident 
type from the Fire or Wildland drop-down list and click the Use Fire Form check box. 
The Fire tab displays with this incident type when you enter information for this incident 
type.

7.  Click the Close Toolbar button and click Yes when you are prompted to save your changes.
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Mapping EMS Translation Codes
You can map your department's EMS codes to those of another agency to which you submit EMS 
incident data.

To map EMS translation codes:

1.  Click the Tools menu, then select Customize, then Incidents, followed by EMS 
Translation Codes. The EMS Translation Codes dialog displays.

2.  Click OK when the View Parameter dialog displays. The EMS Translation Codes dialog 
box displays.

3.  Click the Explorer button next to the Export Module drop-down to select an Export 
Module. 

4.  In the Code drop-down, click an EMS code category. The codes for this category are 
displayed in the list box below the category. The Code text box displays the code for the 
selected EMS code and the Description text box displays a description of the EMS code.

5.  Select an EMS code from the list box, enter the code of the receiving agency in the Export 
Code text box, and press the Enter key. Repeat this step for each EMS code in the list box. 

Note: Before using EMS Translation Codes, you must have a custom export module that 
is designed specifically for your code set. Contact Customer Support if you want an export 
module developed for your department.
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6.  Click the Close Toolbar button to save your changes. FireRMS automatically maps the 
EMS codes to those of the receiving agency each time you export incident data using the 
selected export module.

Customizing Vehicles, Equipment, and 
Locations

You can create a list of categories to which equipment and facilities can be assigned, select the 
default measurement units (e.g., gallons, tons, inches), create a list of actions that can be assigned 
to vehicles and equipment, and create a list of staff and positions available for assignment to 
actions.

Note the following: You can use a checkbox labeled For MWO in the Vehicles and Equipment 
module in Fire RMS 4.4 or later if you are running Maintenance and Work Orders (MWO). If you 
are using MWO, enabling this checkbox allows an activity report to be sent to the MWO. It also 
allows the local user to determine which activities require a work order and how to generate a work 
order as needed. 

Creating Equipment or Facilities Categories
You can create a list of categories and sub-category codes for equipment as well as categories and 
codes for facilities.
Use the Equipment codes when creating new Equipment records in the Vehicles and Equipment 
module.
Use the Facility codes when setting up Locations for Training Classes.
To create equipment or facilities categories or sub-categories: 

1.  Click the Tools menu, then select Customize, followed by Vehicles, Equipment, & 
Locations. The Customize Vehicles, Equipment and Facilities dialog displays.

2.  On the Categories tab, click either the Equipment or Facilities label on the tree view or, 
click a sub-category, then click the New button.
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3.   Do one of the following:

If creating a category, enter a name in the Group text box.
If creating a sub-category:

a)  Select a group name from the Group drop-down box.
b)  In the Code text box, type a unique alphanumeric code for the sub-category.
c)  In the Description text box, type a description of the sub-category.

4.  Repeat Steps 2 and 3 to create additional categories or sub-categories.

Setting Default Measurement Units
You can select the default measurement units, e.g., gallons, tons, inches, for the Vehicles and 
Equipment module. 

To set default measurement units:

1.  Click the Tools menu, then select Customize, followed by Vehicles, Equipment, & 
Locations. The Customize Vehicles, Equipment and Facilities dialog displays.

Caution: If you delete a category, all equipment in that category is also deleted.
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2.  Click the Defaults tab.

3.  From the following units of measurement, select a default measurement from the 
drop-down lists:

quarts, gallons, or liters
gallons or liters
ci, cc, or liters
lbs, tons, kg, or mt
in or cm

Creating a List of Equipment Actions
You can create a list of actions to be performed on your vehicles and equipment in FireRMS. These 
actions are added to look-up tables (drop-down lists, explorers) in the Vehicles and Equipment 
module and can be selected by users who are scheduling actions. 
To create a list of equipment actions:

1.  Click the Tools menu, then select Customize, followed by Vehicles, Equipment, & 
Locations. The Customize Vehicles, Equipment and Facilities dialog displays.
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2.  On the Actions tab, click Vehicle or Equipment on the tree view and click the New button 
to add a new action.

3.  OPTIONAL: Select an action from the tree view and click the Delete button to remove it.

4.  Type an action code of up to 14 alphanumeric characters. This code is used to identify the 
action in the Vehicles and Equipment module.

5.  In the Description text box, type a description of the action. This is used along with the 
code to identify the action in the Vehicles & Equipment module.

6.  If applicable, type a dollar amount for the default fee in the Default Fee text box.

7.  In the Priority text box, assign a priority to an action, with 1 being the highest priority and 
9 being the lowest.

8.  Repeat Steps 2 through 7 to create additional actions.
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Creating Staff or Department Structures Available For 
Assignments
You can create a list the people or department structures available for vehicle or equipment 
assignments. These entries are added to the Assignment Explorer, which is used by data entry 
personnel to assign actions in the Vehicles and Equipment module. You can choose from the 
following:

Vehicle - Indicates vehicle-related assignments.
Equipment - Indicates equipment-related assignments.
Person - Identifies a specific person available for assignment, e.g., Joe Brown.
Department Structure - Identifies a position within the department structure available for 
assignment, e.g., Station 1 Shift A.

To create a list of people or department structures:

1.  Click the Tools menu, then select Customize, followed by Vehicles, Equipment, & 
Locations. The Customize Vehicles, Equipment and Facilities dialog displays.

2.  On the Assignments tab, click either Vehicle or Equipment in the tree view.

3.  Select one of the following in the tree view and click the New button to create a new entry.

Persons
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a)  In the ID text box, type a label to identify the entry, for example, “Joe Brown” or 
“Fire Marshall.” This label will help data entry personnel find the entry on the 
Assignment Explorer.

b)  Click the Explorer button to select a person from the Personnel Explorer. 
Department Structure 

a)  In Department Structure, identify a position available for assignment.
Level - Select a department structure level.
Location - Select a location within the selected level.
Apparatus - If applicable, select an Apparatus available for the assignment.
Shift - If applicable, select a Shift responsible for the assignment.

4.  Repeat Steps 2 through 3 to create additional people or department structures.

5.  Click the Close Toolbar button and click Yes when you are prompted to save your changes

Defining Additional Roles for your Personnel
You can define the fields for identifying the specific role of each crew member attending an 
incident. For example, a crew member may be defined as a fire fighter in Personnel, but for a 
specific incident, your department may also wish to note that he was the apparatus driver. 

To define additional roles for your personnel:

1.  To add codes, go to Tools>Customize>Codes>Department codes. 
Select the Additional Role checkbox. 

2.  Restart FireRMS to update all the codes into the local cache files.

3.   Go to File>New>Incident and start a new incident report, if needed. 
Go to the Resources tab on the incident form, and press add to add an apparatus. When the 
apparatus finder form displays, click on the radio button ‘show all apparatus’ and then just 
highlight any of the listed apparatus & click on the ‘select’ button. This enables you to add 
the apparatus to your incident. 

4.  Go to the next tab titled Personnel. Assuming you have not created a roster, the personnel 
list will be empty. Press the ‘add’ button on this tab and the Personnel explorer will display. 
By default the list displays in ‘dept’ order. Click on the scroll box under the label in the 
upper left corner (Select Tree View) and change it from ‘Personnel’ to ‘Alphabetical’. 
This provides a list of personnel sorted alphabetically by last name. Pick the person whose 

Note: ZOLL recommends that you select Dept. Structure as the Type instead of Person. If 
a person transfers to a new position in the department, the replacement automatically 
inherits the assignment.
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role you want to change, or assign.Or you can double click on the name, you’ll see if 
display in the ‘Selected Personnel’ list box in the lower right. Add the person and click on 
the OK button to close the explorer form and return to the incident. 

5.  A Position In Vehicle choice box becomes available and you will see and be able to select 
the codes & descriptions you entered under Dept Codes. 

6.  Enter the additional role for the person during the incident in this dialog box. 

7.  Save your changes and exit the dialog box. 

Customizing Training
You can customize training by adding sub-categories, entering standards, entering objectives and 
skills, creating classes, creating credentials related to training classes, and setting up training 
default results. Standards enable you to track standards compliance based on training.

You create classes using predefined FireRMS classes. You can create training classes that measure 
your progress toward a goal. You can also define default objectives and skills for a training session.

Adding Sub-Categories and Creating Standards
The Standards Explorer contains three preset categories; National, State, and Local. You can create 
standards in these categories. You can also create sub-categories beneath these three categories and 
then create standards in the sub-categories.

Standards can be linked to objectives and skills in the Training module to allow you to track 
standards compliance based on training. For example, if your district is held to NFPA performance 
standards, you could enter these standards in the Standards Explorer, then link them to specific 
skills taught in your training classes. When a participant completes a training class and obtains a 
skill, the standard is cross referenced, demonstrating that the participant is trained in accordance 
with standards.

For information about linking standards to objectives and skills, see “Creating a List of 
Objectives and Skills” on page 4-33.

To add sub-categories and create standards:

1.  Click the Tools menu, then select Customize, then Training, followed by Standards. The 
Standards Explorer dialog displays.
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2.  Click the category to which you want to add a new sub-category; National, State, or Local, 
and click the New button.

3.  Click the Category radio button.

4.  In the Code text box, enter an alphanumeric code to represent the category.

5.  In the Description text box, enter a category name.

6.  Click the Save button.

7.  Repeat Steps 3 to 6 to add additional sub-categories to the same category or Steps 2 to 6 to 
add sub-categories to a different category.

8.  Click the category or sub-category to which you wish to add the new standard.

9.  Click the New button.

10.  Click the Standard radio button to create a new standard.

11.  In the Code text box, enter an alphanumeric code to represent the standard.

12.  In the Description text box, enter a standard name.

13.  OPTIONAL: Click the UnDo button to cancel your most recent unsaved changes.

14.  Click the Save button.
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15.  OPTIONAL: Click the Print button and click OK to display the Print dialog box. You can 
then preview or print the list of categories and standards.

16.  Click OK after entering categories and standards.

Creating a List of Objectives and Skills
You can create a list of objectives and skills for your training classes. Objectives and skills are the 
abilities, certification, or knowledge gained by personnel. Objectives are knowledge-based, while 
skills are demonstrable. For example, an objective is to know the firefighter's role in the agency; a 
skill is to demonstrate the ability to properly place a ground ladder. You will group your objectives 
and skills beneath categories.

To create a list of objectives and skills:

1.  In the Tools menu, click Customize, then select Training, followed by Objectives/Skills. 
The Objective/Skills dialog displays.

2.  Click Objective and Skills in the tree view and click the New button to create a category or 
click a category and the New button to add objectives/skills or a sub-category.

3.  Enter the following information:

Code - An alphanumeric code that represents the category, objective or skill.
Type - Includes Cat (Category), Obj (Objective), or Skill to create a category or an 
objective or a skill. If you selected an objective/skill and you select Cat (Category), you are 
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prompted to remove objective/skill specific information and convert the record to a 
category.
Assigned Category - Displays the category to which the selected entry is assigned. You can 
assign an entry to a category by clicking the category you want on the tree view.
Description - A description of the category, objective, or skill.
Sub-Tabs - Displays the sub-tabs if you choose either Obj or Skill. You can make selections 
from the fields in the sub-tabs listed in Table 4-2.

4.  Click the Save button.

5.  Repeat Steps 2 through 4 to create additional categories or to create objectives and skills 
beneath the categories. 

6.  OPTIONAL: Select the objective/skill or category you wish to delete and click the Delete 
button.

7.  Click OK when you have entered all your categories, objectives, and skills.

Table 4-2: Objective/Skill Selections

Field Description

Details A more detailed description of an objective or skill.

Standards Link an objective or skill to a specific standard or series of 
standards on the Standards tab. This is useful if an objective or 
skill is tied to compliance with local, state or federal standards. 
The Type text box displays the name of the standard you select. 
The text box displays a description of the standard. In the Valid 
Dates fields, enter the Start and End date for which the standard 
is in effect. Leave the End date blank while the standard is current. 
In the Reference field, type any miscellaneous reference to the 
standard, such as an edition number.

Notes Enter miscellaneous comments for an objective or skill. Click the 
Date Stamp option to insert the current date and time (according 
to your system) into the note.

Results Contains three user-defined fields that allow you to store default 
results for an objective or skill. These results will be used by the 
Training module when the objective/skill is selected for a class.

Note:   You cannot delete categories that have objectives/skills assigned to them.
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The Objective Explorer organizes objectives and skills into categorized folders in a tree view.

Creating Classes
You can create and modify classes for the Training module. FireRMS provides a set of predefined 
classes that you can use, modify, or delete.

To create classes:

1.  Click the Tools menu, then select Customize, then Training, followed by Classes.

2.  Click Training Classes in the tree view and click the New button to create a category, or 
click a category and the New button to add a class or a sub-category.

3.  Enter the following information:

Code - An alphanumeric code that represents the category or class.
Type - Indicates a Category or Class.

Note:   A memo field Full Text has been added to Training Standards form.Use this field 
to fill out additional text regarding the standard and display for the user when setting up 
Class Objectives and Skills. When the class is later added to the Training Module, clicking 
on the specific standard on the Class objectives and skills tab allows the end user to read 
the full text in the description. 
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Assigned Category - Displays the category to which the selected entry is assigned. You can 
assign an entry to a category by clicking the category you want on the tree view.
Description - The name of the category or class.
Retired - Indicates a class, is “retired” or hidden from the Class Explorer in the Training 
module. This prevents data entry personnel from selecting it. However, FireRMS saves the 
class record and you can still view and modify it by accessing the Class Explorer from the 
Tools Customize menu.

Enter information on any of the following sub-tabs; Defaults, Results, Notes, Obj/Skills, 
Attach, Resources.

Defaults - Enter information in the text boxes and drop-down boxes provided:
Standard - Displays any standard (NFPA, for example) that may be applied to this 
class. This field is primarily for FireRMS Standard Edition users who do not have the 
ability to link standards to objectives and skills. This field is not reportable.
Reference - A miscellaneous reference to the standard, such as an edition number.
Mandatory - Indicates this is a mandatory class. For example, some training may be 
mandatory to achieve a certification or position.
Accredited - Indicates this class is part of an accredited training program for which 
college credit or certification from a third party agency is given.
Preregistration - Indicates you want to include preregistration information, in the 
default class description. After selecting this option, enter the desired Min. Class Size 
and Max Class Size. The Max Class size determines how many participants can be 
added for the class in the training module. Once the number of participants equals the 
Max Class Size, the class will be marked as full on the Training Form.
Min Class Size and Max Class Size - The minimum and maximum number of class 
participants.
Method - A default training method for the class.
Provider - A default provider for the class.

Results - Enter default results in the text boxes and drop-down boxes provided. Default 
results include Credit Hours plus three user-definable fields.

Credit Hours - The credit hours needed for training for each objective and skill.
Default Result 1, 2, 3 - You can store the default results for each objective and skill. 
These results are passed to the Training module when the class is scheduled.

Note:   You can change Method, Provider and other options for individual classes once 
they are scheduled in the Training module. The purpose of these options is to provide class 
defaults to speed data entry.

Note: You can configure the user defined results fields using the Customize Results 
dialog. For more information, see “Customizing Default Results for Other Entries” on page 
4-50.
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Notes - Enter miscellaneous comments about a class in the text boxes and drop-down boxes 
provided. 

Class Notes - Record general notes about a class.
Prerequisite Notes - Record notes specific to the class prerequisites.
Date Stamp - Inserts the current date and time into a note.

Obj/Skills - Enter a default set of objectives and skills for a class.
a)  Click the Add Object to Class button to add an objective or skill to the class, then 

double-click the objective and click the OK button.
b)  Click the Explorer button to open the Objective Explorer to view the selected 

objective or skill.
c)  Default Hours - Indicates default hours needed for training for each objective and 

skill.
d)  Default Result 1, 2, 3 - These three user-defined fields allow you to store the 

default results for each objective and skill. These results are passed to the Training 
module when the class is scheduled.

Attach - Create, open, or remove file attachments for a class, such as a lesson plan.
a)  Click the New button to create a new file attachment. Click the Browse button to 

select the file you want to attach.
b)  Click the Open button to open the selected file attachment.
c)  Click the Delete button to remove a file attachment.

Description - A description of the attached file.
Linked to - The path of the attached file.
Browse - The list of files you can choose from to attach.
Comments - Any notes you want to store with the file attachment.

Resources - Indicate the resource you want to attach to a class.
a)  Choose the resource from the tree view.
b)  Click the Add Resource to class button.
c)  Choose the resource from the Location Resources dialog.
d)  Click the OK button.

4.  Click OK to save changes.

5.  OPTIONAL: Click the UnDo button to cancel your last unsaved change.

Note: You can store default objectives and skills for a class in the Class Explorer. You can 
enter these in the Training Form's Objectives/Skills tab when you schedule the class and 
you can assign them to class participants. Or, if you prefer, you can enter values on the 
Training Form when you schedule the class.
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6.  Click the Save button to save a new category or class, or to apply the changes you have 
made to an existing entry.

7.  OPTIONAL: Select a class or category you wish to delete and click the Delete button. If 
you delete a category, all classes in that category are deleted.

8.  Click OK after you have created the classes.

The Class Explorer organizes classes into categorized folders in the tree view to which you can add 
categories and classes as needed.

Creating Credentials
You can create a list of credentials related to your training classes. Credentials are used to measure 
a person's progress towards a particular goal, such as a certification. A credential can have initial or 
renewal requirements. An initial credential requirement is one that is required up front. For 
example, a person may have to become a member of a team or gain certification. A renewal 
credential requirement is one that is required to remain accredited. For example, a person must 
remain accredited to stay on a team or remain certified.
The five categories of credentials are:

Certifications - The credentials required to receive a certificate of achievement--classes 
passed, skills attained, actions taken in the field. For example, an EMT Basic certificate 
might require 160 training hours in specific objectives and skills.

Degrees - The credentials required to earn a degree. For example, college or technical 
degree curriculum.

Courses - The credentials required to complete a course. e.g., a CPR course.

Team - Credentials required to become a member of a team, such as Hazmat. These consist 
of classes, objectives and skills or actions taken that must be met by all team members.

Other - A catch-all category for credentials that do not fall into the other categories.
To create credentials:
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1.  Click the Tools menu, then select Customize, then Training, followed by Credentials. The 
Credentials dialog displays.

2.  Select a credential category; Certifications, Degrees, Team, Other, or Courses.

3.  Click the New button to add a new credential.

4.  Enter the basic information to create the credentials on the Definition tab. The fields are 
described in Table 4-3.

Table 4-3:  Credentials Tab Fields 

Field Description

Code A unique alphanumeric code for the credential.

Description A brief description of the credential.

Type The category to which the credential belongs.

Expiration Term The number of months after which the credential will expire.

Effective Date Beginning date that the credential went into effect.
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5.  Enter the requirements to receive a credential on the Requirements tab:

Code - The code of the credential to which you are adding requirements.
Description - A description of the credential to which you are adding requirements.

6.  On the Identification sub-tab of the Requirements tab, choose from the following options:

Objective/Skill - Indicates the requirement is related to an objective or skill.
Category/Class - Indicates the requirement is related to a class or category of classes.
Credential - Indicates the requirement is to obtain another credential.
Actions Taken - Indicates the requirement is related to an action during an incident.
Aid Given - Indicates the requirement is related to a medical aid given in the Advanced 
EMS module.

7.  If you select one of the first three options, click the Explorer button to select a requirement. 
A second dialog opens that allows you to choose from existing records. For example, if the 
requirement is an objective/skill, the Objective Explorer opens. If you select one of the last 
two options, choose an action or the aid given from the drop-down box.

Local Qualifications If selected, local qualification options are activated for this 
credential definition when it is associated with personnel in the 
Credentials Earned Explorer. Open the Credentials Earned 
Explorer, by clicking Personnel on the Info menu, and then 
clicking Credentials Earned.

Obsolete Date The date that a credential becomes obsolete.

Comments Miscellaneous notes about the credential.

Table 4-3:  Credentials Tab Fields (Continued)

Field Description
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8.  On the Initial sub-tab or Renewal sub-tab of the Requirements tab, you can set a time 
frame for completing a requirement when working towards the initial credential. 

For a description of these fields, see “Setting Initial and Renewal Credential 
Requirements” on page 4-42.

9.  Click the Save button to save your changes.

10.  OPTIONAL: 

Click the UnDo button to cancel your last unsaved change.
Click the Print button to print credentials. You can print the entire list or a selected 

credential.
Click the Delete button to remove the selected requirement from a credential. 

11.  Click the OK button to close the dialog box.
Customizing Training     4-41



Setting Initial and Renewal Credential Requirements
When you are creating credentials, you can set the requirements on the Initial sub-tab or Renewal 
sub-tab. The fields are described in Table 4-4.

You can click the Same as Initial button to match the Renewal requirements with the Initial 
requirements. Values are taken from the Initial tab and inserted in the Renewal tab.

Table 4-4: Initial or Renewal Sub-Tab Fields

Field Description

Complete ___ time(s) 
within ___ months

The number of times the requirement must be met within a given 
time frame. Some requirements may only have to be met once. 
Others, such as incident-related actions, may be required multiple 
times.

with a minimum ___ of 
___

You can set default results--test scores, time taken to complete a 
skill, and so on--that must be met to successfully complete the 
requirement. The available options are based on your user-defined 
training and objective results. The drop-down list contains all 
integer, numeric, and character based user-defined results. This 
field is for required classes and objectives/skills, but it is dimmed 
if there are no user-defined results of this type.

With a “Y” for ___ of 
___ 

This field is similar to the “with a minimum” field except that it 
uses user-defined Y/N (Yes/No) results. This field is dimmed if 
there are no user-defined values of this type.

Accumulate ___ within 
___ months

Uses user-defined training and objective results to allow you to set 
minimum accumulation requirements. For example, a user might 
be required to accumulate two minimum test scores within a year 
to meet a requirement. This field is dimmed if there are no 
user-defined results.

Renewal tab Used when renewal requirements differ from initial requirements. 
You can set the time frame for completing requirements needed to 
renew a credential. This tab only applies when a credential must 
be periodically renewed. The fields on this tab work as described 
on the Initial tab.
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Setting Up Default Objectives and Skills
You can define the default objectives and skills for a training session. In this case, the defaults are 
passed to this tab when the class is scheduled. You can also add and delete objectives/skills as 
needed for this particular session. Once the default results are in place, you can apply them to, and 
modify them for, class participants using the Training Form/Participants tab.
To define default objectives and skills:

1.  Click the Tools menu, then select Customize, then Training, followed by Objectives/
Skills.... The Objective Explorer dialog displays.

2.  Select an objective or skill.

3.  Click the Standards sub-tab and click the New button to add an objective or skill to this 
training session. The Standards list box displays any standards that have been associated 
with the selected objective/skill. The Results sub-tab contains user-definable fields that 
display the default results for each objective/skill in the class.

4.  Click OK after setting up default results.

Recording Objectives and Skills Achievements for 
Participants
Use the Training Form / Participants tab to record objectives and skills achievements for 
individual participants in the training class. For example, if a student is retaking a training session, 
you can mark those skills that the student acquired the first time as completed.

To record objectives and skills for participants:

1.  Click the Training tab on the desktop and open a class to display the Training Form.

2.  Click the Participants tab and select the participant you want from the list box.

3.  Click the Add Defaults button to apply the default objectives and skills as defined on the 
Objective/Skills / Defaults tab. You can customize them as needed for individual 
participants.

4.  Click the New button to add an objective/skill for the selected participant.

5.  Click the Delete button to remove the selected objective/skill from the student's list.

6.  Use the Results options to measure a student's performance toward attaining objectives/
skills.
Customizing Training     4-43



7.  Click the Completed check box when the student has successfully completed the selected 
objective/skill. Clear this check box if a student has not yet completed the objective/skill.

8.  Type the total hours that the student has completed in working towards the selected 
objective/skill.

9.  Click the Close Toolbar button to close the form.

Customizing Default Results Fields
You can define the default results fields on the Class Explorer, the Training Form’s Participant’s 
tab, the Objective Explorer, and the Objectives/Skills tab on the Training form.

Setting Up the Class Explorer Default Results
The default results fields on the Class Explorer and on the Training Form’s Participants tab are 
user-defined fields that allow you to record and store participant results.
To define the field labels and usage:

1.  Click the Tools menu, then select Customize, then Training, followed by Results. The 
Default Results dialog displays. 

2.  Click the Class Explorer Default Results tab.

3.  Do one of the following:

Select the Not Used check box if you do not want to use a field. The field will still be 
visible to FireRMS users, but will be dimmed and labeled “NOT USED.”

Enter a Label, Data Type, and Default Value.
a)  In the Label field, type the field label name using up to 20 alphanumeric characters.
b)  In the Data Type field, select one of the following type of data that will be entered 

in the field:
Integer - Accepts whole numbers only (no decimals).
Numeric - Accepts decimal values.
One Character - Accepts a single alphanumeric character.
Six Characters - Accepts up to six alphanumeric characters.
Y/N - Accepts only the values “Y” or “N.”

c)  In the Default Value field, type the value that you wish to appear as the default.

Note:   The Data Type for the first two default results fields must be either Numeric or 
Integer in order for certain reports in FireRMS to process data correctly.
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4.  Click Close when you are finished to close the Default Results dialog and save your 
changes.

Setting Up the Objective Explorer Default Results
The default results fields on the Objective Explorer and the Objectives/Skills tab in the Training 
Form are user-defined fields used to store and record results for your training participants. These 
fields must be defined as part of the training setup process.
To set up the objective explorer default results:

1.  Click the Tools menu, then select Customize, and Training, followed by Results. The 
Default Results dialog displays.

2.  Click the Objective Explorer Default Results tab.

3.  Do one of the following:

Select the Not Used check box if you do not want to use a field. The field will still be 
visible to FireRMS users, but will be dimmed and labeled “NOT USED.”

Enter a Label, Data Type, and Default Value.
a)  In the Label field, type the field label name using up to 20 alphanumeric characters.
b)  In the Data Type field, select one of the following type of data that will be entered 

in the field:
Integer - Accepts whole numbers only (no decimals).
Numeric - Accepts decimal values.
One Character - Accepts a single alphanumeric character.
Six Characters - Accepts up to six alphanumeric characters.
Y/N - Accepts only the values “Y” or “N.”

c)  In the Default Value field, type the value that you wish to appear as the default.

4.  Click Close when you are finished to close the Default Results dialog and save your 
changes.

Customizing Advanced EMS Protocols
You can customize your own Advanced EMS protocols after changing the security object 
Menu,Tools,Customize,Advanced EMS to 3. You can create a new protocol and add the treatments 
via the treatment codes.

Note:   The Data Type for the first two default results fields must be either Numeric or 
Integer in order for certain reports in FireRMS to process data correctly.
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1.  Click the Tools menu, then select Customize, then Advanced EMS, followed by 
Protocols. The Protocols box displays. The left list box lists the Protocols and the right list 
box lists the Treatment Work Flow.

2.  Click New Protocol, enter the name in the Name text box and click Add.

3.  Click the name of the protocol, and click the Add button beneath the Treatment Work Flow 
list box to add treatment work flows. The Treatment Codes dialog displays. 

4.  Select the treatment code and click Add. The treatment codes display in the Treatment 
Work Flow list box. Repeat this procedure to add additional treatment codes. 

5.  Click Exit when you are done.

Note:   Before customizing protocols, you must select all the version 2 forms, e.g. 
CFlowChartPatientCarePage_v2, as the default forms on the Tab Control box.
For information on selecting version 2 forms, see “Customizing Tabs: Labels, Sort 

Order, Visibility” on page 4-51.

Note: If you will be exporting your protocols and importing them into other databases 
using SQL Utilities, make sure the Treatment Codes in the source and destination databases 
are the same. If they are not, when you import the protocols and then select 
Tools>Customize>Incidents>Advanced EMS>Protocols, errors will display.
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6.  Select a Treatment Work Flow and click Edit Defaults to enter or edit the default values for 
this work flow.

7.  OPTIONAL: Enter an Effective Date and End Date for this protocol. The protocol can only 
be used during the dates entered.

8.  Click the Close button.

9.  Open an incident and click the Advanced EMS tab and the Flow Chart tab.

10.  On the Protocols drop-down, select one of the protocols you created and click Add 
Protocol. The Events for the protocol appear at the bottom half of the tab. You can click a 
button to add the event to the bottom. You can reorder the event in the list by changing the 
date and time. You can hide events in the protocol that will not be used for a patient. You 
must enter a reason the event is not being used.

The protocol information used for each patient is saved.

Creating Advanced EMS Disclosures
You can create your own Advanced EMS Disclosures for use on the Mobile tablet. Disclosures are 
declarations or statements that apply to advanced EMS patients. Disclosures consist of a title, 
disclosure text, and a signature(s). An example of a disclosure you may create is; Title: Refusal of 
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Medical Care, Disclosure Text: Medical treatment is refused by patient, Signatures: Patient, 
EMT.

To create the Advanced EMS Disclosures:

1.  Click the Tools menu, then select Customize, then Incidents, followed by Advanced 
EMS, and Disclosures. The Disclosures dialog box displays.

2.  Click the Add button in the top portion of the dialog and enter the Disclosure Title. (To 
remove a disclosure, select the title and click the Delete button. The title, language, and text 
are deleted.) You cannot create two titles with the same name, in the same language.

3.  OPTIONAL: If you created multiple languages, click in the Language column and select a 
language from the drop-down box. If you choose a language other than English, enter the 
title, text, and signatures in that language.

4.  Enter disclosure text in the Disclosure Text box.

Note: Before creating disclosures, if you will be creating disclosures in languages other 
than English, you must first enter language types. Click the Tools menu, then select 
Customize, then Codes, followed by Department Codes, and the category Language, 
and enter language types.
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5.  Click the Add button in the bottom portion of the dialog and enter a signature. (To remove a 
signature, select the signature and click the Delete button.) You can repeat this step to add 
more signatures.

6.  Click the Save All button and repeat Steps 2 through 6 to add more disclosures or click the 
Close Toolbar.

Before your users can view or modify the Disclosures tab, you must display the tab using the Tab 
Control feature. When you do, it will appear on the Incident > Advanced EMS tab.

For information about displaying hidden tabs, see “Customizing Tabs: Labels, Sort Order, 
Visibility” on page 4-51.

Preventing Unauthorized Users from Viewing 
Patient Data on EMS Reports

To prevent unauthorized users from viewing patient data on EMS reports:

1.  Go to Tools>Administration>System.

2.  Click on the Settings tab. Go to More Settings and select the Lock PCR option. Selecting 
the checkbox enables this feature.

3.  When you create patient records using Advanced EMS or NEMSIS after enabling this 
feature, you can use the Personnel Explorer icon on the Patient Information tab to select 
names of personnel attending the Incident. You can also change the explorer view and make 
selections from personnel based on Assignment, Roster, or from an alphabetical list of all 
personnel. Once you have set up a member making report for the specific patient, only the 
person selected (or an authorized reviewer) is able to view that patient’s data. 

4.  Save your changes and exit the screen.

NOTE: FireRMS 4.4 or later has added a new security option under Form> Incident>Advanced 
EMS>All Patient Info. Use this option to designate the authorized reviewers of EMS Data. Users 
must have their security group option set to 3 – Full Access to view the patient data for all Incident 
Reports. This is irrespective of whether or not the user entering the data has locked the record by 
selecting his or her name using the Personnel Explorer.

Note: After creating a Disclosure Title, Text, or a Signature, you can highlight the text in 
these fields and modify the text.
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Customizing Other Entries
You can customize the Default Results fields on the Other Entries Form. You can indicate you want 
the Default Results fields to be greyed out so they cannot be used. If you want the fields to be used, 
you can customize the label name, choose the data type, and set a default value.

Customizing Default Results for Other Entries
You can create a set of default results for scheduled events in the Other Entries module. For 
example, you could track total staff hours for an other entry event such as station maintenance.
To customize other entries:

1.  Click the Tools menu, then select Customize, followed by Other Entries. The Other Entry 
Results dialog displays.

2.  Do one of the following:

Select the Not Used check box if you do not want to use a field. The field will still be 
visible to FireRMS users, but will be dimmed and labeled “NOT USED.”

Enter a Label, Data Type, and Default Value.
a)  In the Label field, type the field label name using up to 20 alphanumeric characters.
b)  In the Data Type field, select one of the following types of data that will be entered 

in the field:
Integer - Accepts whole numbers only (no decimals).
Numeric - Accepts decimal values.
One Character - Accepts a single alphanumeric character.
Six Characters - Accepts up to six alphanumeric characters.
Y/N - Accepts only the values “Y” or “N.”

c)  In the Default Value field, type the value that you wish to appear as the default.

The Sample column in the dialog box displays a sample value for the selected Data Type.

Note: The first two data types are used by FireRMS to calculate personal activity reports; 
these values should be numeric or integer data types to work properly. Some agencies use 
these fields to measure attendance by counting total participation points.
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Customizing Tabs: Labels, Sort Order, Visibility
Administrators can give users access via a new security object; Menu,Tools, 
Customize,TabControl, to customize tab labels, visibility, and order for Advanced EMS, Basic, 
Resource, Incidents, or user-defined Occupancy tabs. Also, users can select different forms for 
some of the Advanced EMS tabs. 
To customize tabs, sort order, or visibility:

1.  Change the access to the security object Menu,Tools, Customize,TabControl to 3. 

For a description of the procedure, see “Creating Security Groups and Defining Access 
Rights” on page 3-31.

2.  Click the Close button.

3.  Click the Tools menu, then select Customize, then Incidents or Occupancies followed by 
Tab Control. A Tab Control box displays. 

4.  Do one of the following:

If you selected Incidents:
a)  Select the tab label, INCIDENT, BASIC, RESOURCE or ADVEMS.

If you selected Occupancies:
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a)  Select OCCUPANCYINFO or PREVENTIONINFO.

5.  You can change the values in the Caption column or the Order column, and select or 
deselect the Show check box.

Click on the Caption, modify it, then press Enter.
Click on a number in the Order column and change it, then press Enter. The items are 

reordered. Items categorized as NFIRS cannot be modified. 
Select the Show checkbox at the bottom of the screen to display a tab. Deselect it to 

hide the tab. Also, two versions can be displayed for some Advanced EMS tabs. These 
alternate versions are indicated by version - 2 in the object name. Note that you must 
select the same version numbers of the tabs, e.g. if you select Version 2 of one tab, you 
must select Version 2 for the others.

6.  After making all changes, click the OK button. Changes are reflected on the Incident, 
Basic, Resources, Advanced EMS, or Occupancy tabs of current incidents/occupancies and 
newly created incidents/occupancies. Click Cancel to cancel all your changes.

Creating Custom Tabs 
Administrators can give users access via the security object; Menu, Tools, Customize, Tab Creator, 
to create their own top level (parent) tabs in the following modules: Incidents, Occupancies, 
Hydrants, Personnel and Vehicles & Equipment. Low level (child) tabs may also be created for 
Incident – Advanced EMS and Occupancy – Prevention tabs. These tabs can contain text boxes, 
combo boxes, check boxes, labels, a date/time field, and a Report button. Before creating a custom 
tab, ZOLL recommends you create a rough draft of the tab containing the fields with the data you 
want to enter. Creating a tab consists of the following steps:

Create
Save
Reset SQL Permissions
Publish 

Once tabs are published, or created and saved, you can edit them and then re-publish or re-save 
them.

To create a new tab:

Note: The Incident>Advanced EMS>Accident tab has a field under Accidents: the 
Safety Device Reported by field can be populated by adding the code and descriptions 
desired to the EMS Codes page under Customize Codes. 
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1.  Change the access for the security object Menu,Tools, Customize,Tab Creator to 3. 

For a description of the procedure, see “Creating Security Groups and Defining Access 
Rights” on page 3-31.

2.  Click the Close button.

3.  Click the Tools menu, then select Customize, then either Incidents or Occupancies, and 
Tab Creator, followed by Create New. A Tab Creator Wizard box displays. 

4.  Select one of the following:

Incident Tab Top Level or EMS Tab Lower Level
Occupancy Info or Prevention Info

5.  Click Next.

6.  Do one of the following:

If you selected Incident Tab Top Level, Occupancy Info, or Prevention Info:
A) Enter the Tab Name in the text box and the Tab Caption in the text box.
B) The tab name must include alpha characters and may contain numeric characters.
C)  Click Finish. The Page Creator window displays.

Or
If you selected EMS Tab Lower Level:

A) Select Incident or Patient.
B)  Click Next.
C) Enter the Tab Name in the text box and the Tab Caption in the text box.
D)  The tab name must include alpha characters and may contain numeric characters.
E)  Click Finish. The Page Creator window displays.

Note: If you selected a Patient tab, you will notice a Patient drop-down box 
automatically appears in the upper left corner of the screen. The fields you add on this tab 
will contain data associated with each patient that you select when using this tab.
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6.  Click Add Object. The Select an Object dialog, above, displays. Select one of the 
following objects to add to the tab. 

Label:
a)  Select Label and click the Finish button. The object appears in the upper right 

corner of the screen. 
b)  Click on the object and drag and drop it to a location on the screen.

Text Box:
a)  Select Text Box.
b)  Click Next. The Define Data Type box displays.
c)  Enter a field name up to 35 characters.
d)  Select the data type of Character and the length, or select Numeric.
e)  Click Finish. The object appears in the upper right corner of the screen.
f)  Click on the object and drag and drop it to a location on the screen.

Combo Box:
a)  Select Combo Box.
b)  Click Next. The Define Data Type box displays.
c)  Enter a field name up to 35 characters.
d)  Select the data type of Character and the length, or select Numeric. (You can only 

select the value Numeric if you are creating either an Incident or an EMS tab. It is 
not available if you are creating an Occupancy Info or Prevention Info tab.)

e)  Click Next.
f)   Select a category from the drop-down box.
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g)  Select an item in the list box and click Select. The item name displays and appears 
in the Selected Category box.

h)  Click Finish. The object appears in the upper right corner of the screen.
i)   Click on the object and drag and drop it to a location on the screen.

Check Box:
a)  Select Check Box.
b)  Click Next. The Define Data Type box displays.
c)  Enter a field name up to 35 characters. The default data type is Logical.
d)  Click Finish. The object appears in the upper right corner of the screen.
e)  Click on the object and drag and drop it to a location on the screen.

Date/Time Field:
a)  Select Date / Time Field.
b)  Click Next.
c)  Enter a field name up to 35 characters. The default data type is Date/Time.
d)  Click Finish. The object appears in the upper right corner of the screen.
e)  Click on the object and drag and drop it to a location on the screen.
f)  When you publish this tab, and enter data in this tab, the Date/Time field displays the 

date and time of data entry.

Report Button:
a)  Select Report Button.
b)  Click Next.
c)  Enter the name of the report, e.g. Incident.rpt.
d)  Click Finish. A Print button appears in the upper right corner of the screen.
e)  Click on the object and drag and drop it to a location on the screen.

7.  Repeat Step 7 and follow the procedures for each object you want to add to the tab.

8.  OPTIONAL: To delete an object, drag it to the trash barrel in the bottom right corner and 
drop it in.

Note:   When you create a combo box, you select from a list of Categories. This list 
contains the selections provided by the category <ADD NEW>. You can modify this list to 
change your selections. (Click the Tools menu, then select Customize, then Codes, 
followed by Department Codes, and the category <ADD NEW>.) 

Note:   The Report Button object will be linked to a customized Crystal Report that you 
create. Before choosing this object, you must create a report and you must install it in the 
FireRMS5SQL directory on your local machine even it you are using centralized reporting. 
When you add the Report Button, you are prompted for the name of the report. The report 
is generated based on the Incident number/EMS Patient ID or the Occupancy ID number 
that you enter when you create the report.
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9.  After creating objects, you can right-click on an object to display the Object Property Sheet 
dialog box. You can hide or change a label, or you can hide a field, or change it's location on 
the tab.

10.  Click Save to save the tab and fields. A save message displays. Click OK. You are 
prompted to reset permissions in SQL Utilities. Click OK. You must reset permissions 
when you create tabs in order to display the correct data.

11.  Close FireRMS and reset permissions in SQL Utilities by locking the database and clicking 
Reset Permissions on the Maintain tab. When the update is complete, unlock the database, 
close SQL Utilities and re-open FireRMS.

12.  Reopen the tab you created by selecting Tools, then select Customize, then Incidents or 
Occupancies, and Tab Creator, followed by Open Saved.

13.  Select the tab name and click Finish.

14.  Click Publish to save the tab and place it on the network. The new tab displays on the 
Incident Form. If the tab is selected and permissions have not been set in SQL Utilities, the 
text “Reset Permissions must be run from SQL Utils” appears on the tab. If at any time you 
want to remove a tab, you can hide it using the Tab Control dialog box. Contact Customer 
Support for information about deleting tabs from your system that you created.

Modifying Published or Saved Custom Tabs
You can modify published tabs, or tabs you have created and saved, but not yet published. 

To modify tabs:

1.  Click the Tools menu, then selecting Customize, then Incidents or Occupancies, then Tab 
Creator, followed by Open Saved. A list of tabs you saved displays. 

2.  Select the name of a tab you want to modify. The Page Creator window displays. 

3.  Make changes to the tab, e.g. add objects or modify labels, and click Finish or Save. If you 
edited a tab that is already published, you must:

Click the Update Publish button after clicking Save, then click Close
Close FireRMS
Open SQL Utilities, reset permissions, and click Close
Re-open FireRMS to view the tab with all changes
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Changing the Tab Order of Objects
When you press the Tab key to move through objects on a tab, the default tab order is left to right 
and top to bottom. Using the “Tab Index” property on the Object Property sheet, you can change 
the order in which you tab through the objects on user-defined tabs.

To change the order in which you tab through objects:

1.  Click the Tools menu, then select Administration, then System, followed by Settings.

2.  Under Dynamic property changes, select Enabled.

3.  Select the Initiate Design Mode check box.

4.  Click the Close Toolbar button.

5.  Open an incident.

6.  Click on a user-defined tab.

7.  Right-click in the object you want to reorder. The Object Property Sheet dialog displays.

8.  In the Tab Index row and Target Value column enter the number for the tab order of the 
object.
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9.  Click Save.

10.  Repeat Steps 7 through 9 for each object you want to reorder.

11.  Click Save.

12.  Deselect the Initiate Design Mode check box on the Settings tab after you have made all 
changes.

FireRMS 4.4 or later has increased this functionality by expanding the User Defined option to most 
fields in the default FireRMS user interface. Fields that are required by NFIRS may not have the tab 
order changed as this could interfere with rules processing. All other fields may be modified to 
have the tab order set as locally desired. This is especially helpful on systems where optional fields 
are hidden using the Design Mode.

To set up local Tab Order for fields in the User Interface, initiate Design Mode and then right click 
on any field. The system displays the Properties sheet. 
There are two methods for changing the tab order – field by field, or form by form.

You may choose to update the tab order for a a single field. To do this, type in the new 
desired value on the Tab Index line on the Properties Tab.

You may also choose to update the tab order for all fields on a given tab by accessing the 
new Tab Order form on the Property Sheet.

Changing Object Properties For All Modules
Administrator’s can change the object properties for labels and fields in the Incident and 
Occupancy modules. The objects that can be modified include: Text Boxes, Combo Boxes, Check 
Boxes, and Radio Buttons. When you right-click on a label, an object property sheet displays. You 
can edit the field label or you can hide the label. 

When you right-click in a field, an object property sheet displays with settings to reposition the 
field, select a default value for the field, hide the field, or display a field as mandatory or 
recommended. Mandatory fields must be filled in. You cannot authorize an incident unless 
mandatory fields are filled in. Before an incident report can be exported or used for reports, the 
incident must be authorized. Recommended fields contain data that your department would like 
you to enter, but you can authorize a tab without entering data in recommended fields.

Note: You can change the properties for objects that are NFIRS and function required if 
the NFIRS rule applies to only the field’s character length. If you right-click in a field that 
is NFIRS required, and the rule does not apply to only the field’s character length, the 
words NFIRS Required appear next to the name in the Object Property sheet and no Object 
Properties are listed in the sheet.
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Selecting Mandatory and Recommended 
Fields, Repositioning Fields, or Changing Visibility
Administrators can indicate the fields on the tabs that will be mandatory or recommended. When 
you enable these fields, they display in the color you selected. 
For a description of the procedure, see “Displaying Mandatory and Recommended Fields” on 

page 5-14.
You can also change the location of the field on the tab, the sort order, or change the visibility. The 
objects that can be modified include: Text Boxes, Combo Boxes, Check Boxes, and Radio Buttons.

To change field properties:

1.  Click the Tools menu, then select Administration, then System, followed by Settings.

2.  Under Dynamic property changes, select Enabled. (You can also disable this feature.) 
When Disabled is selected, no prior label changes are displayed; default values will display. 
When this feature is enabled, system performance is diminished, but you can view any prior 
label changes. 

3.  Select the Initiate Design Mode check box.

4.  Select the Enable Recommended Fields and/or the Enable Mandatory Fields check box 
and select the color you want the fields to display in. The tab labels of the fields will also 
display in this color. You should inform your users of the colors you have chosen for 
mandatory and recommended fields.
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5.  Click the Close Toolbar button to enable Design Mode. While in design mode, you can 
make field and label enhancements. 

6.  Open an incident.

7.  Right-click in the field you want to modify. The Object Property Sheet dialog displays.

8.  Do the following:

Change the visibility of that field
a)  Click the Hide radio button next to Default to hide the field.

Reposition the field
a)  Change the values in the Target Value column next to Top, Left, and Width.

Indicate the field is a mandatory or a recommended field
a)  Click the radio button next to Mandatory or Recommend to indicate a Mandatory or 

Recommended field. (These selections are greyed out if the Mandatory and 
Recommended check boxes on the Settings table on the previous page are not 
checked.) If you chose Mandatory, and you do not enter a Start Date the field will 
display as mandatory in all new and existing records. If you enter a start date, the 
fields will display as mandatory in records created as of that date.
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9.  Click Save. Labels or fields that have been changed or hidden are highlighted in green.

10.  Deselect the Initiate Design Mode check box on the Settings tab after you have made all 
changes.

Changing Field Labels or Visibility
In addition to changing the properties for fields, administrators can also change the field labels or 
hide the labels for all FireRMS modules. You are not allowed to change the labels on Command 
buttons. 
To change field labels:

1.  Click the Tools menu, then select Administration, then System, followed by Settings. 

2.  Under Dynamic property changes, select Enabled. (You can also disable this feature.) 
When Disabled is selected, no prior label changes are displayed; default values will display. 
When this feature is enabled, system performance is slowed, but you can view any prior 
label changes. 

3.  You can select the Initiate Design Mode check box and click the Close Toolbar button to 
change to Design Mode. While in design mode, you can make field and label 
enhancements.

4.  Right-click on the label you want to modify. The Object Property Sheet dialog displays.

5.  Do the following:

Change the label name
a)  Enter a new label name in the Target Value column next to Label.

Change the visibility of that field
a)  Select the Hide radio button to hide the field.

6.  Click Save. In Design Mode, labels or fields that have been changed or hidden are 
highlighted in green.

7.  Deselect the Initiate Design Mode check box after you have made all changes.

Note: When you choose a field to be mandatory in the Incident module, you must fill in
this and all mandatory fields before you can complete an incident. You can use design 
mode to clear all mandatory fields on a tab if you later decide to hide the tab or change to 
another version of the tab using the Tab Control option.
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Assigning Default Values to Data Elements
You can assign a default value to data elements (text boxes or drop-down lists) on regular FireRMS 
tabs, or published, user-defined tabs. When entering a value for a field with a drop-down list, the 
value you enter must be a valid selection. For example, on the Incident>Basic>Location tab, you 
can set the default value for the State field to be MA. (MA is one of the selections available in the 
drop-down list.)
To select a default value for a data element:

1.  Click the Tools menu, then select Administration, then System, followed by Settings. 

2.  Under Dynamic property changes, select Enabled. (You can also disable this feature.) 
When Disabled is selected, no prior label changes are displayed; default values will display. 
When this feature is enabled, system performance is slowed, but you can view any prior 
label changes. 

3.  Select the Initiate Design Mode checkbox and click the Close Toolbar button to change to 
Design Mode. 

4.  Right-click in a field on a regular FireRMS tab or a user-defined tab. The Object Property 
Sheet box displays.

5.  In the Default Value row and Target Value column, enter a valid value.

6.  Click Save.

7.  Deselect the Initiate Design Mode check box after you have made all changes.
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Chapter 5:Controlling User Settings

This chapter describes the tasks associated with controlling user settings for your FireRMS system. 

Setting the Default Desktop
You can select the default desktop you want to display for your users.
To set the default desktop:

1.  Click the Tools menu, then select Administration, followed by Security. The Security 
dialog displays.

2.  In the Security Groups tab, click the Preferences tab.

3.  In the Start Up Desktop Page drop-down, select one of the following default desktops:

Incidents
Training
Other Entries
To Do Items
Log

4.  Click the Close Toolbar to save your changes and close the Security dialog.

Using NT Logins
The Use NT Login feature bypasses the FireRMS login screen and accesses FireRMS via the 
Windows NT login script. This is a useful feature when you have only one user per workstation. If 
multiple people will be using one workstation, you may not want to use this feature.

To access FireRMS via NT Login:
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1.  Enter each user’s NT login name and password in their FireRMS personnel record. The 
FireRMS login name and password must be the same as the NT login name and password.

For information about assigning a login name and password, see “Adding Personnel” 
on page 3-21.

2.  Click the Tools menu, then select Administration, followed by System.

3.  In the System Administration dialog, click the More Settings tab.

4.  In the More Settings tab, select the Use NT Login check box.

5.  Click the Close Toolbar when you are finished to save your changes and close the dialog.

Enabling and Disabling System Lockouts for 
Invalid Logons

To set up an account lockout policy for your users:

1.  Click the Tools menu, select Administration, followed by System and More Settings.

2.  Set the value for the number of invalid log ons that you want your users to have in the Max 
Logons box.

3.  If the user is locked out and you have to reset the log on, go to the Personnel module and 
select the Show locked out button. The system displays a drop down list with all the users 
and the number of log on attempts. 

4.  To unlock a user’s account, select their name from the drop down list and clear the 
checkbox next to the user’s name. You can also reset the user’s password, if needed.

5.  Save your changes and ensure that all FireRMS clients restart their systems to recognize the 
new settings.

Enabling Login Security/Protecting Daybook 
and Desktop

Login security allows you to enforce the use of logins to access FireRMS. When login security is 
enabled, users that are not using the NT Login feature must type a user name and password in order 
to access FireRMS. Be sure the system administrator has all privileges assigned before selecting 
this option.
5-2     Chapter 5: Controlling User Settings



FireRMS Administrator’s Guide
With Protect Desktop checked (on), both Daybook and Desktop tab(s) will be restricted to the 
department assigned level of the individual logged in. For instance, the captain at Station 1 will be 
restricted to his/her station; the Battalion Chief in Battalion 1 will be restricted to his/her battalion. 
When both Protect Desktop and Protect Daybook are unchecked (off), a user will default to his/her 
level when running the application. The entire hierarchy of the department is accessible to them 
from any tab on the desktop; Incidents, Training, Other Entries, and Daybook.
To enable login security:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, select the Enable Login Security check box.

4.  In the More Settings drop-down, select the Protect Desktop check box to restrict both 
Daybook and Desktop tabs to the department assigned level of the logged in user.

5.  Click the Close Toolbar when you are finished to save your changes and close the dialog.

Turning On/Off the Welcome Wizard 
The Welcome Wizard dialog appears the first time you start FireRMS and continues to appear each 
time you run FireRMS until you turn it off.
To turn on/off the welcome wizard dialog:

1.  Click the Tools menu, then select Administration.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, click the Don't Show Welcome Wizard at Startup check box. You can 
clear this check box at any time to reactivate the Welcome Wizard dialog.

4.  Click the Close Toolbar when you are finished to save your changes and close the dialog.

Disabling Automatic Incident Numbers
Numbers are automatically assigned to Incident reports when you create a new incident. If you 
want to assign your own incident number you can disable this auto-numbering feature.

Note: You can also turn off the Welcome Wizard that displays on your desktop by 
clicking the Don’t show this again check box and the 6) Finished, Go To Desktop check 
box on the bottom of the Welcome Wizard screen.
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To disable automatic incident numbers:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, click the Disable Automatic Incident Numbers check box.

4.  Click the Close Toolbar when you are finished to save your changes and close the dialog. 
When you save a new incident, you are prompted to enter a number in the Incident Number 
text box.

Turning Off the Refresh Timer
The Refresh Timer updates FireRMS with changes from the database every 5 minutes. If this 
causes performance issues, you can disable the Refresh Timer. If you disable this setting, the 
FireRMS client will refresh at startup or when you click the Refresh Toolbar. 
To turn off the Refresh timer:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the More Settings tab.

3.  In the Settings tab, clear the Refresh Timer check box.

4.  Click the Close Toolbar when you are finished to save your changes and close the System 
Administration dialog.

Setting up the System Inactivity Timer
You can choose to set up an inactivity timer which, when enabled, causes the local FireRMS 
program to shut down automatically on an individual’s desktop after a certain time period of 
inactivity. The Inactivity Timer option applies to users logging into FireRMS Clients and   
FireRMS Mobile Clients. All FireRMS clients must be restarted in order to recognize the new 
setting.
To set up the inactivity timer:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.
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3.  In the Inactivity Logout (Min) field, enter the number of minutes that you want to set as 
your inactivity threshold. 

4.  Save your changes and exit the screen. 

When the number of minutes for inactivity is reached, a prompt displays on the local client 
informing the user that the program has been inactive and will shut down. The user can cancel the 
shutdown. If the user selects to cancel the shutdown, the timer is reset. If the user does not respond 
to the prompt, the local FireRMS program automatically closes.

Note that if you are using Citrix networking, clients running FireRMS through a shared Citrix 
network may not receive an automatic program shutdown prompt, or the system may not recognize 
inactivity depending on how the Citrix client is set up.

Locking Completed Records and Creating 
Supplemental Records 

You can lock incidents and activity records in the Occupancy, Hydrant, Vehicles and Equipment 
modules when they are completed.
To lock records:

1.  Click the Tools menu, then select Administration, followed by System.

2.  Go to More Settings and check any or all the four options available for locking records. 
The specific fields are Lock Incident, Lock Activity (V&E), Lock Activty (Hyd) and 
Lock Activity (Occ). 

3.  Save your changes and exit the screen. 

If you need to add information to a report that is locked, you can create a supplemental record for it. 
When an incident report is completed and locked, FireRMS displays a new button on the Incident 
form. Clicking on this button allows you to create a supplemental incident report and only 
authorized users can create supplemental records. The supplemental incident record has the same 
number as the original incident. Supplemental Records are preceded with the phrase “SUPP” to 
clarify the record type. When an authorized user opens a completed, locked incident, users see a 
option box labeled Supp Inc in the incident form. Clicking on that box creates the supplemental 
record. 
Note that if you change the activity type in the supplemental activity report, the report is saved as a 
new record, and not a supplemental record.
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A user in a security group where this option is set to 3 – full access, is able create supplemental 
incident reports. Users in security groups where this option is set to 1 – no access are not able to 
create supplemental incident records.

Protecting the Daily Roster and Personnel 
Module

You can limit a user's access to Personnel and Roster details using the Protect options on the 
System Administration, Settings tab. If you limit access, a user can only view information at or 
below their station level. For example, a user assigned to Station B could only access roster 
assignments for Station B.
   

To limit a user’s access to Personnel and Roster details:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the More Settings tab.

3.  In the More Settings tab, click the Protect Roster check box to protect the Daily Roster.

4.  Click the Protect Personnel check box to protect the Personnel module. 

5.  Click the Close Toolbar when you are finished to save your changes and close the dialog.

You can use the Roster Access Lock to restrict access to the Roster Module to one user at a time. 
Restricting access to the Roster helps avoid conflicts that could otherwise occur when multiple 
users attempt to make updates to the same date at the same time. 
When this option is enabled, each user must save their changes and exit the module before a second 
user may access the module to make additional changes. If an user locks the roster and fails to 
disconnect properly (if their machine or network access goes down unexpectedly while in the 
Roster module), the lock may be cleared by running Reset Permissions in SQL Utils. 

Setting the Date Format
You can select either the United States or Canadian date format.
To set the date format:

1.  Click the Tools menu, then select Administration, followed by System.

Note:   You must enable Logins to use this option.
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2.  In the System Administration dialog, click the Settings tab. 

3.  In the Settings tab, click the Set Date Format drop-down box to select the date format.

4.  Click the Close Toolbar when you are finished to save your changes and close the dialog.

Selecting a Default Personnel Explorer
You can select a global default personnel explorer that displays when you click the personnel 
explorer icon in FireRMS. The choices are:

Personnel - Select this option to view personnel based on department structure.
Roster - Select this option to view personnel based on Daily Roster assignments. This
option is only available if the Daily Roster has been created for the day.
Alphabetical - Select this option to view personnel in alphabetical order by last name.

If you make no selection, Personnel is the default.

To select a default personnel explorer:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab. 

3.  In the Settings tab, click the Default View of Personnel Explorer drop-down box to select 
the default explorer.

4.  Click the Close Toolbar when you are finished to save your changes and close the dialog.
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Activating Design Mode
You can change FireRMS from the default mode to Design Mode in order to modify the FireRMS 
fields or field labels. While in Design Mode, you can do the following:

Edit field labels or fields for all modules. 
Modify field labels or hide them.
Hide fields, reposition them, or select the fields to display as Mandatory or Recommended 

fields.
You can modify the following objects: text boxes, combo boxes, check boxes, and radio buttons. 
After making all changes, deselect the Initiate Design Mode check box.

To enable design mode:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, click Enabled under Dynamic property changes. System performance is 
diminished when you enable this feature. You must enable this feature to view any prior 
label changes. When this feature is disabled, default labels will display.

4.  Select the Initiate Design Mode check box and click the Close Toolbar to change to design 
mode. The words -------DESIGN MODE------- appear in the Title bar of the FireRMS 
screen.

Note:   You cannot change the labels on command buttons, and you cannot change fields 
that are NFIRS and function required.
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For information about changing field labels, see “Changing Field Labels or Visibility” 
on page 4-61.

For information about changing fields, see “Selecting Mandatory and Recommended 
Fields, Repositioning Fields, or Changing Visibility” on page 4-59.

5.  After making all changes, deselect the Initiate Design Mode check box and close the 
Settings tab.

Using an Alternate Spell Check Dictionary 
Instead of using the default spell check dictionary, you have the option of using your own spell 
check dictionary. 
To use an alternate spell check dictionary:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, click the button to the right of the Additional Spell Check Dictionary 
field.

4.  Select the location and name of the dictionary file you want to use. The file you select must 
have the extension.CUD. You can place the dictionary on each client machine or you can 
place it on a shared network, and map each client to this network drive.

5.  Click the Close Toolbar when you are finished to save your changes.
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Creating and Updating a Custom Dictionary
FireRMS version 4.4 and later allows you to create and maintain your own custom dictionary. The 
option is now available on all operating systems and Microsoft network drives. The custom 
dictionary can be shared with FireRMS mobile devices as well. 
The spell-check dictionary is read-only on mobile devices.
To use and share the custom dictionary: 

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.
The Custom Spell-check dictionary file is saved as filename ‘chcustom.cud’ and the default 
location for the file is in the directory c:\winnt. 
Use one of the following options to update the dictionary file:

From the Incident module, use the EMS & Incident Narrative tab to type the word. 
You can see options for a correct spelling, and then cancel the spell-check, change the word, 
ignore the word, or add the word to the custom dictionary.   
If the custom dictionary does not exist and the administrator has not changed the default file 
location for the custom dictionary, a new local copy of the custom dictionary file is created 
on the hard drive of the local client machine when the user chooses to add a word to the 
dictionary. 

3.  You can also use Notepad to add new words and definitions. Save the Notepad file and 
retain the ‘.cud’ extension.

4.  If the custom dictionary is located on a shared network drive, and the user running FireRMS 
does not have modify privileges on that drive, the user cannot add new words to the 
dictionary.

Sharing the dictionary with FireRMS Mobile 
Users

To share the dictionary with FireRMS mobile users:

1.  Click the Tools menu, then select Administration, followed by System.

2.  Select the Mobile Preferences tab.

3.  Press the button labeled “update root files on the mobile.”
The custom dictionary gets updated on the mobile systems, and the mobile user has to 
restart the program to ensure that the FireRMS Mobile client reads all updated root files, 
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including the custom dictionary file. 
The FireRMS Mobile users cannot add words to the custom dictionary.   

Setting Local/Centralized Reporting
FireRMS reports can either be printed locally or centrally. The Central Reporting feature allows 
maximum flexibility when choosing a reporting option because the reporting option chosen, Local, 
Central Network, or Web, is stored in the Windows registry and can be unique for each Windows 
user. For example, one Windows user on a client PC can set their reports to run locally, while 
another Windows user can login to the same PC and select the central reporting option to run 
reports.

FireRMS Administrators can choose one of the following reporting options: print reports locally, 
print reports from a network path, or print reports through a network browser. The administrator 
must follow the steps below to select which reporting option will be used by their department. Once 
the administrator selects a reporting option, all department users must also choose this same 
reporting option from their client.

Note that FireRMS 4.8 or later, allows you to run Local Reports and replace the default reports by 
clicking on the Print icon in several modules. The reports must be located in the designated reports 
folder and may be pushed out to mobiles. After adding local module reports, the administrator must 
reset Report Security for at least one security group to allow access to the reports. 
The report naming convention is module_modulename.rpt and may include spaces in the name 
such as module_incident report two.rpt. When multiple reports for a single module are available, 
the user is presented with a list of reports from which he may select any one to run. 
When a single custom report exist for any module, it is automatically used when the print icon is 
selected. 
The new local report option is available for the following modules: 

module_incident
module_occupancies
module_VE
module_hydrants
module_otherentry

Note: Central Web Reporting and Central Network Reporting are not available on Mobile 
Clients. Mobile Clients can only utilize Local reporting. 

Note: Users can always select the reporting option Local even if the Administrator does 
not select this as the default. This is useful for users running mobile FireRMS who need to 
print reports while disconnected from the network.
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Before you can use Central Web Reporting, you must install the Central Web Reporting software 
located in the Add-On Apps section of the FireRMS installation CD. You also need a separate Web 
server running IIS and you must create an ODBC connection to RMS5SQL_DSN on the Web 
server. (IIS server is included with Windows Server 2003 and Windows XP.)

In order to use Central Network Reporting, each client PC must have access to the network drive/
folder where the reports reside.

To select a reporting type:

1.  Click the Tools menu, then select Administration, followed by System. In the System 
Administration dialog, click the Settings tab.

2.  In the Settings tab, beneath Specify Reporting Solution: select Administrator next to 
Who chooses reporting solution?

3.  You have three choices:

Use the default Local reporting solution
Use Central Network Depository

a)  First, copy the Reports folder in C:\Firerms5sql to the network location on which 
you want to create the reports.

b)  Using Windows Explorer, map a drive to the Reports folder on this network.

Caution:   If you are using the Central Network reporting option, you can delete the reports 
from the Reports folder on your local drive but you must leave the empty Reports folder in 
the Firerms5sql directory or errors may occur.
5-12     Chapter 5: Controlling User Settings



FireRMS Administrator’s Guide
c)  Run FireRMS and on the Settings tab, click the Central Network Depository radio 
button.

d)  In the Path/URL text box, enter the path of the centralized server on which your 
reports will be stored or click the Browse button to select the path. (For example, if 
you mapped drive G: to the reports folder, you can enter G:\ or you can enter the 
path \\Fireserver\Fire\Reports.)

e)  Click the Check Path/URL button to verify the path is valid. (After saving your 
settings, clicking the Reports button will display the Crystal reports located on the 
network server.)

Use Central Web Reporting
a)  In the Path/URL text box, use the following format to enter the URL of the Web 

server on which your reports will be stored:
http://[machine name or IP address]/firereportscentral

where [machine name or IP address] specifies either the name of the machine on 
which the reports will be stored or the IP address where the reports will be stored

For example:
http://FIRE-W2008/firereportscentral
http://10.101.17.39/firereportscentral

b)  Click the Check Path/URL button to verify the reports display at the specified 
URL. (After saving your settings, clicking the Reports button will display the 
Crystal reports at the specified URL.)

4.  Click the Close Toolbar button when you are finished to save your changes.

Setting Central Reporting For Department Personnel
After you, as the Administrator, have selected a central reporting option, your personnel cannot use 
this reporting option until it has been manually set on each client machine. If no reporting option is 
selected on a client PC, the default of Local is utilized. You can choose the central reports option on 
each client machine or each user can make this setting. You should be aware of the following:

Because the report option used is stored in each user's Windows Preferences (registry), the 
user must be logged into Windows when the reporting option is set so that it is saved in the 
user’s registry. If Administrator’s use their own Windows logon on a client machine, the 
setting will be saved in the Administrator’s registry.

Note: The reporting path the Administrator specifies for network or web reporting is 
global. When each user selects the same reporting type, e.g. network or web, they should 
not enter a path; the path entered by the administrator is used. If users enter a different path; 
that path would then become the default for each user.
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If users will be choosing the reporting option, you must give them full access to the 
Settings tab via the Menu,Tools,Administration, System security object.

From each client machine, on the Settings tab, select User next to the Who chooses 
reporting solution? prompt, before choosing a central reporting option.

Displaying Mandatory and Recommended 
Fields

In addition to the current red mandatory NFIRS fields, you can select your own Mandatory or 
Recommended fields.

For Information on setting up or changing the list of recommended or mandatory fields, see 
“Selecting Mandatory and Recommended Fields, Repositioning Fields, or Changing 
Visibility” on page 4-59.

After you select the mandatory and recommended fields, you can display them in your records. 
These fields display in new and existing records. If you selected a Start Date for Mandatory fields, 
records created as of that date display the mandatory fields you selected.
To display mandatory or recommended fields:

1.  Click the Tools menu, then select Administration, followed by System.

2.  In the System Administration dialog, click the Settings tab.

3.  In the Settings tab, click Enable Recommended Fields, and/or the Enable Mandatory 
Fields check box.
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4.  Click the Close button. 

Sharing System-wide Messages and 
Notifications Using FYI

On a system hosting multiple databases, the FYI Messages can be set up to send messages to 
designated system administrators for each or all of the Databases available through the SQL server 
system. Two new security options are available to support sending and receiving system messages.
 To set up the system-wide messages using FYI feature:

1.  You must first designate a central database to store and forward the messages. 
Use SQL Utils to create a new empty FireRMS database and name the database so it can be 
easily recognized by all local administrators, such as FYIMessages. 
You do not need to license the new database or perform any other maintenance on it for use 
as a central message database.

2.  Use SQL Query Analyzer to run two scripts provided in the Text and Scripts folder which 
exists in the FireRMS Program folder. 

The first script is named SetFYIPermissions.sql and should be run against the 
FYIMessages Database. 

The second script is named job_getsystemmessages.sql.When you open this script, 
change the default database name provided in the script on line 6 to match the name you 
gave your FYIMessages Database if necessary. After updating the name if necessary, 
run the script. 

When both scripts are run, permissions to write to the FYI Messages database are set 
up and the job is registered with the local SQL Agent and runs every 5 minutes to 
check/pass new system wide messages.

3.  Go to the FireRMS System Settings tab>More Settings section and enable the option 
Centralize Requests. When this option is enabled, a new dropdown choice box labeled 
Central DB for FYI Messaging is enabled. Use this dropdown choice box to select the 
database to use for Message Store & Forward. 

4.  Set this option on all Databases that are able to share messages. Each database must use the 
same Central Database for message sharing.

5.  The System Messages that are created are received/read through the Daybook FYI/Request 
tab. 
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6.  To enable system messages in your local database, enable the security options for the 
groups of users who should be able to send or receive the messages. 
When you have the right to create System Messages, a new level displays in the Daybook 
List Filter when you click on the explorer to select to whom a new message should be sent. 
“System Message” displays in the list just above the Department name. Any user in a 
security group with rights to view System Messages will receive the message regardless of 
their assignment within the Department. 

7.  You may choose to display a prompt message that will inform all authorized users that new 
system messages are available. 
To have the prompt display during logon, select the new option Startup Message on the 
System Settings tab to cause the prompt to display when an authorized user logs into the 
FireRMS system. The prompt provides an option to allow the user to go directly to the FYI/
Request tab where they can read the new Message.

8.  You can also choose to have the prompt display during a FireRMS session so that users are 
informed about the new message without needing to logoff and then back in to FireRMS. 

9.  To enable the timed prompt, use the FYI Timer spinner control on the system settings tab 
to set the desired number of minutes for the prompt. 

If the timer is set to ‘1’, the message displays within 1 minute of receipt. 
If the timer is set to ‘2’, the prompt displays after 2 minutes and so on.

There are two new security options to support sending and receiving system messages.

System, Receive System Messages: When this security option is set to 3 – Full Access, 
users in the security group with this access are able to receive System Messages sent by 
other users.

System, Send System Messages: When this security option is set to 3 – Full Access, users 
in the security group with this access will be able to send System Messages to users in the 
local database, or to any other database that subscribes to the Central Messaging System. 

Using the EMS Module Filters for Incidents
To set a system to use Advanced EMS if you were using Basic EMS, click the button labeled Use 
Advanced EMS on the System Settings tab and update the choice box on the System>More 
Settings tab to select Advanced EMS.

To set a system to use NEMSIS if you were using Advanced EMS, click on the checkbox 
NEMSIS V2, and create your demographics database and import your NEMSIS Codes (as 
defined in the NEMSIS Admin Guide). Select NEMSIS V2 from the choice list after 
restarting FireRMS.
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To set a system to use Basic EMS if you were using Advanced EMS, select Basic EMS 
from the choice list located on the System>More Settings tab. Incidents previously entered 
using Advanced EMS forms continue to display those forms. The new Incidents display the 
Basic EMS forms.

To set a system to use Basic EMS or Advanced EMS if you were using NEMSIS forms, 
clear the checkbox labeled NEMSIS V2 in the More Settings list. Restart FireRMS and 
select Basic EMS from the choice list. 

Note: You have the option of retaining or discarding your Demographics Database 
connection when clearing the NEMSIS V2 checkbox. If you select Yes, clear the 
connection, you must create a new demographics database or contact Customer Support 
for assistance to restore the connection if you later decide to go back to using NEMSIS 
forms. If you select No, don’t clear the connection, you can revert back to NEMSIS 
without performing any extra steps. 
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Chapter 6:Changing System Settings

This chapter describes the tasks associated with changing or viewing system settings for your 
FireRMS application. 

Viewing System Information
You can view information about your installation of FireRMS that is useful to the ZOLL technical 
support staff if you need to contact us regarding your software.

To view information about your FireRMS installation:

1.  Click the Tools menu, then select Administration, followed by System. The System 
Administration dialog displays.

2.  In the System Administration dialog, click the System Info tab and view the information 
described in Table 6-1.

Table 6-1: System Info Tab Fields 

Information Description

License Level The edition of the FireRMS client that you have installed. The two 
license levels of FireRMS are Standard and Enterprise.

Executable Version The version number of the client.

Database Type The type of database to which the client is attached; SQL Server 
or MSDE. MSDE is a run-time version of FireRMS that installs 
locally as a service on the workstation and acts as a database 
management system (DBMS) and FireRMS client all in one. 
MSDE is designed for smaller user bases, performing best with 
five or fewer concurrent users. MSDE does not allow the database 
size to exceed 2 gigabytes (GB).
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Database Version The version of FireRMS database you are using. This is the script 
number used to build/update the database. A reference table in the 
database compares the database version to the client version. 
These numbers may not necessarily match. This information can 
also be accessed by clicking About on the Help menu, and 
clicking the Details button.

System DSN The name of the DSN (data source name) used to connect to the 
FireRMS database. The DSN stores connection information for 
the selected database. The DSN is created using the ODBC Data 
Source Administrator in Windows Control Panel.

Server Name The name of the server that FireRMS is logged onto.

Database Name The name of the database to which FireRMS is connected.

SQL Script Version The version of SQL script that you are using.

Error Log The Error Log provides an error history for FireRMS. This 
information helps technical support to troubleshoot FireRMS 
issues.

View Error Log When you click this button, you can view the Error Log. The Error 
Log displays ten FireRMS errors at a time.

Clear Error Log When you click this button, you can delete ten errors at a time 
from the error log.

FireRMS License Keys Current Level - The level of your software.
Current Expiration Date - The expiration date of your license key.
Key - The current product key.
Code - When you update the software, enter your code and click 
Validate.

Supplies & Inventory 
License Keys

Key - The current product key.
Code - When you update the software, enter your code and click 
Validate.

Table 6-1: System Info Tab Fields (Continued)

Information Description
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Changing System Settings
You can view/change basic system settings on the Settings tab. For example, you can enable login
security, enable or disable dynamic properties, and choose your default personnel explorer.
To change basic system settings information:

1.  Click the Tools menu, then select Administration, followed by System. The System 
Administration dialog displays.

2.  In the System Administration dialog, click the Settings tab and view the information 
described in Table 6-2.

Enable Automatic 
Updates

Click this check box if you want users to be prompted to 
automatically update their FireRMS client software after you have 
updated the database using SQL Utilities. The prompt is displayed 
the next time a user logs into the FireRMS client.
Click the Browse button and select the location of the client 
software on the shared network drive. The path will display in the 
Path to FireRMS upgrade text box.

Table 6-1: System Info Tab Fields (Continued)

Information Description

Table 6-2: Settings Info Tab Fields 

Information Description

Don’t Show Welcome Wizard at Startup Disables the Welcome Wizard during Initial 
Database setup. 

Enable Login Security Enables Login Security and requires users to 
enter their username and password. 

Disable Automatic Incident Numbers Automatically increments Incident numbers as 
each incident is created. Using this option 
disables the automatic assignment of incident 
numbers. 

Enable LOSAP Tracking Enables LOSAP tracking. For more 
information, see Appendix A: “Tables of Field 
Values.”.
Changing System Settings     6-3



Central DB for FYI Messaging Allows selection of the database to be used for 
shared FYI Messages on a multi-database 
system.
Note: You must enable the shared message 
option on the ‘More Settings’ tab for this field 
to be available. 

FYI Timer Displays the number of minutes that may 
elapse before users are prompted if they have 
messages in their FYI message store. 
Note: You must enable the shared message 
option on the ‘More Settings’ tab for this field 
to be available.

Additional Spell Check Dictionary Enables you to specify your own spell check
dictionary. This dictionary is used when
you run spell check on your narratives. 

Edit Config.fpw file Contact ZOLL customer support for more 
information on use of this option.

Table 6-2: Settings Info Tab Fields (Continued)

Information Description
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Specify Reporting Solution Displays three options for Crystal Reports 
from the FireRMS Reports module:

Local: Uses the default set of report 
files installed with the FireRMS 
program.

Central Network Repository: 
Designates a central location from 
which all users will run reports. This 
option allows you to easily roll out 
new custom reports for your users 
while preventing users from running 
default reports that may not be 
approved for your department. 

Central Web Reporting: A good 
option for systems that use terminal 
services or a Citrix environment, as 
the web server will typically provide a 
faster connection than a local or shared 
network drive. 

Set Date Format Enables you to specify the format for dates:
ccyy/mm/dd, mm/dd/ccyy, or mm-dd-ccyy.

Inactivity Logout Allows the selection of the number of minutes 
of no activity before FireRMS will shut down.

Dynamic Property Changes Enables you to view or make design changes 
to FireRMS fields. Design Changes including 
Tab Order, Local Help, Hiding Fields or Label 
changes are enabled/disabled by enabling or 
clearing this checkbox.

Table 6-2: Settings Info Tab Fields (Continued)

Information Description
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Enable Recommended or Mandatory Fields Allows you to set fields as Recommended or 
Mandatory when used together with design 
mode. Clear the checkbox(es) to set fields 
back to the default value (not recommended or 
required).
NOTE: Recommended or Mandatory fields 
are available in the Incident and Occupancy 
modules only. 

Default view of Personnel Explorer Enables you to set the default view for the
Personnel Explorer:

Roster - Select this option to view 
personnel based on Daily Roster 
assignments. This option is only 
available if the Daily Roster has been 
created for the day.

Personnel - Select this option to view 
personnel based on department 
structure.

Alphabetical - Select this option to 
view personnel in alphabetical order 
by last name. 

Collector Export – Collector Cut-off date Enables you to use the Collector Cut off Date 
field if you have the add-on program FireRMS 
Collector. Setting a date for this field prevents 
records earlier than the date entered from 
being exported to the Collector database for
additional review. 
Contact the ZOLL Sales
Team for more information on the Collector
Program.

Advanced EMS When FireRMS is setup to use AdvEMS or 
NEMSIS, this button is disabled. Clicking on 
the button will update the system to use 
AdvEMS. Do not enable this option if you are 
using the ePCR to FireRMS Incident transfer.

Table 6-2: Settings Info Tab Fields (Continued)

Information Description
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Changing Additional System Settings
To view and change additional features and feature settings, go to the More Settings tab. 

1.  Click the Tools menu and select Administration and System. The System Administration 
dialog displays.

2.   In the System Administration dialog, click the More Settings tab and view the information 
described in Table 6-3. . 

Table 6-3: Additional System Setting Field Descriptions

Field Description 

Actions Sort by Code Updates the Activity Lists to show and sort Activities by Code 
value rather than the default Description value alpha sort.

Apparatus Narrative  Creates a Required Narrative Entry automatically for each 
Apparatus added to an Incident Report. The narrative may be 
completed by any authorized user. 

Append SMS Narrative Appends multiple CAD created narratives into a single Incident 
Level narrative when used with SMS.

Ask prior file tran Displays a prompt before initiating file transfer of attachments to 
or from mobile computers. This allows you to defer those file 
transfers is your network is currently busy with other activities.
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Audit by Field Used together with Design Mode to designate only selected fields 
to be audited. See the SQL Utils guide for more information on 
auditing.

 Auto Neg Longitude  Sets the longitude value on the Incident Location tab to be 
preceded by a negative value. Most locations in N. America are 
located in a ‘negative’ longitude. 
NOTE: NFIRS reporting is not affected by changing this value.

Calc EMS Patient Age Sets the age of the patient by calculating the age based on the Date 
of Birth entered on the Patient form.

Centralize Requests Enables the sharing of messages between multiple FireRMS 
databases when they are located on a single SQL Server. 
See the section on ‘Shared System Messages’ for more 
information.

Create Rosters Enables the creating of multiple Rosters with a single Date 
Selection. Enable this option and open the Roster Module and 
select the Calendar icon. You will be able to create Rosters for a 
month at a time or for an entire date range.

Disable Inc. Shift Selecting this value will update the Incident module so that no 
default shift is set when creating a new Incident.

EMS Adv expand vital Enables additional fields for data entry on Vitals Assessments 
when using the V2 version of the AdvEMS Flow Chart Form.

EMS Adv GCS by age Enables age appropriate choices to be displayed to the user when 
entering a Trauma assessment on the V2 version of the Adv EMS 
Flow Chart Tab.

EMS for All Incs Enables users to enter EMS data for any incident type, including 
those where EMS data is not allowed by NFIRS.   If EMS Data is 
not supported by NFIRS for the incident type, the EMS data will 
be stripped on export to NFIRS.

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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EMS Mobile Unique ID Ensures that a unique value is generated for all patient records 
created on a mobile device. Do not disable this option without 
direction from Customer Support.

Finding Sort by Desc Updates the Occupancy Findings List to show and sort Findings 
by Description rather than the default Numeric Code sort. 
Note: Group order does not change as a result of this setting. 

First Arriving Unit Sets the checkbox automatically on the Incident Apparatus form 
for the unit with the earliest arrival time on an Incident Report. If 
more than one unit it set to have the exact same arrival time, the 
checkbox is set for the first listed unit.

Inc Require Validate Prevents marking an incident complete until the Validate routine 
has been run successfully when used with the ‘My Fire Rules’ 
Validation product.

Lock Activity (Hyd)
Lock Activity (Occ)
Lock Activity (V&E)

Controls Lock Activity option, When enabled, completed activity 
records cannot be updated. Supplemental activity records may be 
created if a modification is required.

Lock Incident Enables the Lock Incident option. 
When enabled, incidents marked complete are set to read-only and 
may no longer be updated. Users with access rights may create a 
Supplemental Incident Records if required.

 Lock PCR Enables an alternative to using HIPAA encryption. When this 
option is enabled, patient records may be assigned to a specific 
person and no one but that person will be able to view the patient 
record data unless they have overriding security rights to view the 
data.    

Multiple FDIDs Enabling this setting will force users to select the appropriate 
FDID value for each incident during data entry. FDID values are 
added through the City Finder. For use on systems where multiple 
agencies share a single FireRMS database. 

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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NEMSIS V2 Enables or disables the View of NEMSIS forms. Replaces the 
previous option ‘NEMSIS Start Date’. See the Using FireRMS 
NEMSIS Administrator Guide for more information on this option.

Occupancy Search Allows users from each database to view occupancy data from any 
other database on systems where multiple FireRMS databases 
reside on a single SQL Server.

Personnel Security Enabling this option allows System Administrators to setup 
multiple tiers of security. For more information on this option, 
please see the section “Creating Personnel Security Settings” 
elsewhere in this document. 

Protect Daybook Enabling this option restricts the default view of each user to 
Incidents or Activities assigned to their Level in the Department 
Structure or below when viewing the Daybook list of Incidents 
and Activities.

Protect Desktop Enabling this option restricts the default view of each user to 
Incidents assigned to their Level in the Department Structure or 
below when viewing the Incident module list.

Protect Personnel Enabling this option limits the view of Personnel displayed in the 
Personnel module to the current Users Department Level and 
below.

Protect Roster Enabling this option limits the view of Personnel displayed in the 
Roster module to the current Users Department Level and below.

Push Desktop Att Enables linking documents posted in the Documents module and 
allows replication to the mobile when the administrator closes the 
FireRMS client. Files and links posted in the Documents module 
may also be pushed out to the Mobile clients by clicking the 
“Update Desktop” button on the Mobile Preferences System 
Administration form. This option works in conjunction with User 
Preferences Administrative option “Push Mobile Attachments on 
Close.” 

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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Push Desktop Doc Enables sending Desktop Documents to the mobile on shut down 
of the core client when the user preference ‘Push mobile 
attachments on close’ is enabled. 
Note: Users must have proper security rights for this option.

Push Incident Att Enables sending Incident record Attachments to the mobile on 
shut down of the core client when the user preference ‘Push 
mobile attachments on close’ is enabled. 
Note: Users must have proper security rights for this option.

Push Occupancy Att Enables sending Occupancy record Attachments to the mobile on 
shut down of the core client when the user preference ‘Push 
mobile attachments on close’ is enabled. 
Note: Users must have proper security rights for this option.

 Push Personnel Att  Enables sending Personnel record Attachments to the mobile on 
shut down of the core client when the user preference ‘Push 
mobile attachments on close’ is enabled. Note: Users must have 
proper security rights for this option.

Push V&E Att Enables sending Vehicle and Equipment record Attachments to the 
mobile on shut down of the core client when the user preference 
‘Push mobile attachments on close’ is enabled. Note: Users must 
have proper security rights for this option.

Refresh Timer Calls the SQL Server to update FireRMS with changes from the 
Database. By default, the timer runs every five (5) minutes. 
The option may be disabled to reduce the volume of network 
traffic, but updates or new Incidents created by CAD do not 
display to users unless they manually refresh the Incident or 
Daybook forms.

Roster Appr Only Enabling this option assigns personnel to a station, but not to any 
apparatus and will not be added to any incident automatically.

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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Roster Access Lock Restricts access to the Roster Module to a single user at any given 
time. Restricting access to the Roster can help avoid conflicts that 
could otherwise occur when multiple users attempt to make 
updates to the same date at the same time. If the user locks the 
roster and fails to disconnect properly (if their machine or network 
access goes down unexpectedly while in the Roster module), the 
lock can be cleared by running Reset Permissions in SQL Utils.

Show Log Entry Enabling this option updates Incidents, Training or Other Entries 
through the Daybook. Users are prompted to enter Log Comments 
after each update. Disabling this option removes that prompt.

SMS Date Overwrite Disabling this option by clearing the checkbox prevents updating 
of existing values in Incident date/time fields by any successive 
CAD feed messages (whether initially created by a CAD message 
or by a manual user update). If a date/time field does not have any 
current value, then the date/time field is updated through the CAD 
feed one time.

Startup Message Enabling this option allows users to receive a prompt when they 
logon to FireRMS if they have any system or other FYI Messages 
waiting in their Inbox.

Synch Rank w/ Roster By default, when a member of personnel is added to an Incident, 
FireRMS will set the field “Position” to the selection as made in 
the Personnel Module. This option allows you to override this 
value with a temporary rank as setup and assigned in the Roster 
module for the day of the Incident.    Note: Using this option may 
cause a slowdown during data entry in the Incident module.

Timed Message Notice Enabling this option displays a prompt to users after a set interval 
when they have new FYI or System Messages in their inbox.

ToDo Activity Start Enabling this option sets the Start Date of any Activity record to 
be displayed in the Start Time column on the To Do list form. 
When disabled, the Scheduled Date displays in that module.

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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Changing a User’s Login Information
You can change a user’s login name and password. For example, you may want to change a user’s 
login name and password to match their NT login name and password.

To change a user’s login information:

Use NT Login Allows you to synchronize a users FireRMS logon with their local 
computer username /logon.

EMS Module Select the forms you wish to use for EMS reporting. The options 
available are: Basic EMS, Advanced EMS or NEMSIS V2.

Max Logins Enabling this option allows you to define a maximum number of 
failed logon attempts that may be made by any user before that 
user is locked out of the FireRMS system.

Lat/Long Decimal 
Position

Allows the administrator to define the number of characters that 
will be listed before the decimal point in either field. This can be 
useful when latitude and longitude values are posted through a 
CAD feed.

Replicate Incident Disabling this option by clearing the checkbox prevents new 
Incident reports from being replicated in FireRMS Mobile clients. 

Roster Access Lock Restricts access to the Roster Module to a single user at any given 
time. Restricting access to the Roster can help avoid conflicts that 
could otherwise occur when multiple users attempt to make 
updates to the same date at the same time. If any user locks the 
roster and fails to disconnect properly (if their machine or network 
access goes down unexpectedly while in the Roster module), the 
lock may be cleared by running Reset Permissions in SQL Utils.

SMS Date Overwrite Disabling this option by clearing the checkbox prevents updating 
of existing values in Incident date/time fields. This applies to 
situations in which a message that was initially created by a CAD, 
or by a manual user update, does not get updated again by any 
successive CAD feed messages. If a date/time field does not have 
any current value, then the date/time field will be updated through 
the CAD feed one time.

Table 6-3: Additional System Setting Field Descriptions

Field Description 
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1.  In the Tools menu, click Administration, followed by Change Login.

2.  Type the current login name in the Name field.

3.  Type the current password in the Password field.

4.  Click the OK button.

5.  Type the new login name in the Name field.

6.  Type the new password in the Password field.

7.  Retype the password in the Confirm field.

8.  Click the OK button.

Click the Close Toolbar button to save your changes and close the System Administration dialog. 
box.
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Chapter 7:Using FireRMS Mobile

FireRMS Mobile Setup Overview
Using the FireRMS Mobile module and a mobile device, Tablet PC or a laptop computer, users can 
collect FireRMS data while away from the fire station. This includes data for all modules that users 
have access rights to, for example, occupancies, incidents, or hydrants. Data that you enter on a 
mobile device, such as a Tablet PC or laptop is merged with the FireRMS database when you 
reconnect the mobile device to the network. If you are using a mobile device in a wireless network, 
data is automatically merged with the FireRMS database when your mobile device is within range 
of the wireless network, for example, your fire station.

After obtaining an agency supplied Mobile Tablet PC/laptop that is loaded with the appropriate 
software, you can configure the mobile device using SQL Utilities. Complete the following steps to 
enable users to collect data using a FireRMS Mobile device:

Step 1: Install mobile software on each mobile device.
For information, see “Security for Crystal Reports” on page 2-5.

Step 2: Connect each mobile device to your network.
Step 3: Using a FireRMS client connected to the network, set the security object 

Mobile, New Incident to Full Access for each user who will be entering incidents on a 
mobile device.
Refer to the Creating Security Groups and Defining Access Rights section of Chapter 3 

for information about defining access to security objects.
Step 4: Using SQL Utilities, configure the mobile devices.

Note: You can also merge your data with the FireRMS database while in the field using a 
service provider with connectivity to your network via a wireless “hot spot” and a Virtual 
Private Network (VPN). Contact your Administrator to verify you have this capability.

Note: Administrative settings cannot be entered on a Mobile device; these selections are 
disabled. You must make Administrative changes on a FireRMS client that is connected to 
your network.
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For information, refer to Chapter 6 in the SQL Utilities Guide.

Step 5 (OPTIONAL): In the FireRMS application, create Disclosures to be Used by 
Fire Personnel.
For information, see “Creating Advanced EMS Disclosures” on page 4-47.

Step 6: Using SQL Utilities, update the subscriber properties. This includes 
updating each subscriber’s login, changing the time interval of the Merge Sync 
Agent, and reviewing a sync history of actions. You can also run a bi-directional Ping 
test.
For information, refer to Chapter 7 in the SQL Utilities Guide.

After collecting data on mobile devices disconnected from the network, a person designated by the 
System Administrator can choose settings on the Reconcile tab to reconcile records entered on a 
mobile device. (The Reconcile tab displays on a FireRMS client PC connected to the network. It 
does not display on a mobile device.)

For information about using Reconcile, refer to Chapter 14 in the FireRMS User’s Guide.

Installing the FireRMS Mobile Software
These installation procedures describe how to install software on each FireRMS Mobile device. In 
this scenario, mobile devices include tablet PCs or laptop computers.
Before installing this software, make sure you have a version of Microsoft SQL Express installed 
on your mobile device that matches the version of SQL Server installed on the server hosting the 
FireRMS database. If you use a non-matching version of SQL Server, the replication fails. After 
installing the FireRMS mobile software on each Mobile device, you must set up each device as a 
subscriber using SQL Utilities.

For information about setting up Mobile devices, see the FireRMS SQL Utilities Guide.
To install FireRMS Mobile:

1.  Insert the FireRMS Mobile installation CD in the client CD drive. After a pause, the CD 
options screen appears. (If the CD options screen does not start automatically, in Windows 

Note: Database snapshots are loaded on each mobile device when you add the devices as 
subscribers. If you previously added subscribers and the database has changed, you must 
again add each mobile device as a subscriber. The most recent snapshot of the database is 
loaded on each mobile device.

Note: You can optionally allow users to create new incidents or new occupancies while 
they are away from the fire station. If you choose to do this, we recommend that you do not 
also create new Incidents or Occupancies at the fire station. For information, see “Changing 
a User’s Login Information” on page 6-13.
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Explorer open the FireRMS Mobile installation CD directory and double-click 
Launch.exe.) 

2.  Click the Install FireRMS Mobile button. The Welcome Wizard screen displays.

3.  Click Next. The Customer Information screen displays.

4.  Enter a User Name and Company and click Next. The Choose Destination Location screen 
displays with a destination of C:\Firerms5sql\.

5.   Click Next. A Setup Type screen displays.

6.  Choose Complete or Custom and click Next. If you select Custom, you can deselect the 
following: FireRMS Core Application, Crystal Reports 11 Runtime, or Replication 
Configuration.

7.  Click Next. The File Copy screen displays with your selections.

8.  Click Next. The Setup Status screen displays. After completing the install, click Finish.
 The install continues with Crystal Reports 11 Runtime. Note that the Welcome screen may 
take a few minutes to display.

9.  Click Next. The Customer Info screen displays.

10.  Enter a User Name and Company and click Next. Crystal Reports 11 Runtime is installed.

11.  After completing the install, click Finish. The main screen displays.

12.  Click Exit twice to close the FireRMS Mobile install program and restart your mobile 
client computer.

After installing the software on each mobile client, you must complete the mobile configuration on 
the server. Refer to the SQL Utilities Guide for information on configuring the FireRMS DB 
servers, databases, and utilities for the mobile clients for proper database synchronization. 

After installing the software on each mobile client, refer to the SQL Utilities Guide for information 
on setting up servers, databases, and subscribers.

Note: If an administrator uses design mode to create local configuration options, the 
mobile users should run the SQLUtilsMobile program to reset permissions before running 
the FireRMS Mobile again. This ensures all changes to the local version of the program are 
set properly.
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If you are using FireRMS 4.3 or later, note that you must drop all subscribers and the publication 
process prior to upgrading to FireRMS 4.3. After the upgrade, you can enable the publication and 
add the subscribers again. Your FireRMS Mobile license keys remains unaltered.

Setting Security on Mobile Devices
After installing FireRMS Mobile Client software, you must set the security on each mobile device 
to enable users who are not OS Administrators, to enter data on the mobile devices:

1.  Right click on the FireRMS5SQL folder.

2.  Select Properties from the menu to display the Properties dialog.

3.  Click the Security tab.

4.  Select the “Group” Users.

5.  In the Permissions for Administrators list box, select the Full Control check box and 
click OK.

Database Synchronization for FireRMS 
Mobile on Windows XP with a Firewall 
After installing Windows XP (SP2) the firewall is turned on by default. You cannot synchronize 
databases with the firewall turned on. You can either turn off the firewall, or set up your client PC 
to run database synchronization with the firewall turned on. 
To set up your PC, you must enable TCP/IP on Windows XP (SP2) for SQL Server 2000:

1.  . Click Start, and then click Run. 

2.  Enter Firewall.cpl in the text box and click OK. The Windows Firewall dialog displays.

3.  In the Windows Firewall dialog box, click the Exceptions tab and click Add a Program. 

4.  In the Add Program dialog box, you can select an instance of SQL Server or click the 
Browse button to locate the instance of SQL Server that you want to add to the exception 
list. 

5.  The default installation locations for SQL Server typically are:

Version\File Path 
SQL Server 2000 Default Instance Program Files\Microsoft SQL 
Server\Mssql\Binn\Sqlservr.exe 
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SQL Server 2000 Named Instance Program Files\Microsoft SQL 
Server\Mssql$instancename\Binn\Sqlservr.exe

Select the name of the instance (sqlservr.exe), and then click OK. 

6.  In the Windows Firewall dialog, under Programs and Services, select the check box next to 
sqlservr.exe and click OK. 

7.  You can now merge and replicate data.

Enabling Mobile Filtering and File Transfer 
You can synchronize mobile records for custom reports, local or custom program files for the 
Personnel, Occupancies, Vehicles and Incidents modules. This feature also lets you enable or 
disable the creation of occupancy records on mobile devices.
Starting with FireRMS 4.3 or later, mobile users can view and add attachments to the modules that 
support attachments. Attachments sent or received with mobile devices are stored locally and in the 
FireRMS database in an encrypted format.

Mobile Filtering and File Transfer Options
Starting with FireRMS 4.3 or later, several optional settings are available for Mobile configuration. 
Use the fields available on the Mobile Preferences tab under Tools> Administration >System> 
Mobile Preferences to manage these settings. The new fields support automatic synchronization of 
updated custom reports, local or custom program files, and attachments for the modules Personnel, 
Occupancies, Vehicles & Equipment & Incidents. An additional setting allows you to support or 
prevent the creation of new Occupancy Records on the mobile device. The filter for incident 
records is modified to default to a 7 day limit and a new filter to limit training records has been 
added.

Earlier releases did not allow mobile users to view or add attachments to the modules that support 
attachments.Starting in version 4.3, an administrator can choose to allow the transfer of the 
attachments to be viewed by mobile users as well as to support the addition of attachments by 
mobile users that will then be added to the core database so they can be viewed and shared by all 
users. 
Note the following additional details” 

 A network or OS path must be setup on the server to store attachments created on the 
mobile device. Mobile device users are unable to add new attachments until this path has 
been defined.

Note: You must use the new checkboxes on the Mobile Preferences tab to reset
permissions for mobile users if they should have the ability to create new incidents or
occupancies after the upgrade is complete.
.
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There is a 200 character limit for the name of the attachment, and a combined file name + 
path (as listed on the server) limit of 240 characters. This limit has always been in effect for 
attachments created on core clients. 

An optional setting under Tools>Administration>System>Settings>More Settings: 
Clicking on this checkbox prevents file transfer of attachments from mobiles until approved 
by the administrator.This option is intended to help ensure that file transfers do not slow 
down the transference of other data such as new dispatches or other more time-relevant 
data. 

As new attachments are added from core clients, the administrator may choose when to 
send them to the mobile clients by using the new buttons available under Mobile Settings. A 
field next to each button displays the last date/time that attachments were sent to the mobile 
clients. 

Note that you can share attachments with mobile devices, and the attachment files created on the 
mobiles are stored locally on the mobile and also in the FireRMS database as encrypted objects. It 
can take several minutes for the encryption process to complete before the new attachments can be 
viewed on the server or other mobile devices. Very large files or inherent network lag time can 
cause additional delays in the File Transfer process.
Attachments viewed on the mobile device are stored in a default folder - attachments in the mobile 
program directory. The following shows a sample screenshot:

Allowing Users to Create Incident or Occupancy Records 
From a Mobile Device 
You can allow users to create new Incident or Occupancy records from a Mobile device such as a 
tablet or a laptop computer. You can also limit the number of incident records to be displayed on 
mobile devices.
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To create new Incident or Occupancy records, or limit incident records displayed from a mobile 
device:

1.  In the Tools menu, click Administration, followed by System. 

2.  In the System Administration dialog, click the Mobile Preferences tab.

3.  Click the following:

Allow new incidents on the mobile device - Check this box to allow users to create 
new Incident records from a mobile tablet

Allow new occupancy records on the mobile device - Click this check box to allow 
users to create new Occupancy records from a mobile tablet.

4.  Click the Close Toolbar button.

Options for Customizing FireRMS Mobile

Creating Individualized Signature Files for Inspection Reports
FireRMS allows you to create individualized signature titles for use in the FireRMS Mobile 
Inspection Reports. Use Tools>Customize>Occupancies>Occupancies>Letter Templates to 
access this option.This option includes adding specific names such as Inspector or Recipient. 
You may also choose to add text that displays immediately above or below the signature set. 
The following screenshot shows an example:

Note: You should not allow users to create new incidents on a mobile device if you are 
collecting Incident data via a CAD system. Duplicate incident numbers can be created and 
when the mobile device is synchronized with the FireRMS server, incidents with duplicate 
numbers will be merged into one incident.
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To create the new signature titles, highlight the line ―—signature in the Letter Templates list box, 
and enter the new signature title in the main data entry field. In order for the signature file to be 
recognized by Crystal Reports, each signature must be enclosed in bracket characters (such as 
<Recipient> or <Inspector>. 
Alternately, you can directly type the text into the textbox and add to the report by pressing the 
‗insert button. A new line must be used for each new signature. You may also choose to add custom 
text that will appear at the very top or very bottom of the complete inspection report by entering the 
text in the fields labeled ―Header or ―Footer.

An example of the appearance of the signature and text might look during setup is shown below: 
The recipient acknowledges receipt of the 2008 Property 
Inspection Report with all the findings listed hereon. 
<Recipient>
<Inspector>

Each signature entered in the data entry box is available for individual signing on the mobile unit 
when the report is completed and displayed for signature entry.

Previous versions of the Mobile Inspection Report supported the signature of one person – the 
recipient. By default and until or unless modified by the Administrator using the steps documented 
here, the recipient signature continues to be the only title displayed on new inspection reports.

Additionally, administrators can create and add department specific sub reports to the default 
Inspection Report. Using Crystal Reports, the administrator may choose to create and add new 
department specific reports to the default FireRMS Mobile Inspection Report. 
For each newly created signature sub-report, you must create a new report ―type and select the 
checkbox labeled ‗Mobile Building Inspection Signature Sub-reports‘. You can define an unlimited 
number of sub-reports & signatures to capture.
7-8     Chapter 7: Using FireRMS Mobile



User’s Guide
Installing the Microsoft Tablet Ink SDK is required to use Mobile Inspection Reports on Windows 
XP Pro operating systems: 
The Microsoft Ink Software Development Kit (SDK) is provided on the FireRMS Mobile 
CD-Rom. You must install this program on XP Pro systems using the mobile software in order to 
use the new Inspection Form. The Ink SDK allows you to use the mouse or touch screen pointer as 
an ―Ink device, supporting signature capture on the XP Pro operating system. You do not need to 
install the Tablet Ink SDK if you are using XP Tablet or Windows 7 Operating Systems for your 
mobiles.

Synchronizing with Physio-Control LIFEPAK Defibrillator
Use the EKG selection under AdvEMS added to Tools>Customize>Incidents>Tab Control to 
synchronize with the Physio-Control LIFEPAK Defibrillator systems using BlueTooth connections 
on your FireRMS Mobile clients.You must use this with a Physio-Control device and the additional 
licensing from ZOLL.

Customizing the Mobile Dashboard
In FireRMS, the administrator may choose to add links to programs, URLs or custom Crystal 
Reports. These processes may be grouped into a series of categories with as many URLs, 
Commands or Reports added to each category as you like.  

To setup custom mobile processes:

1.  For the security group that should be able to setup Dashboard program options, set the new 
security option "Menu, Tools, Customize, Mobile" to 3.

2.  Click on Tools\Customize\Mobile\Dashboard.

3.  Enter the category for each group of processes, then add the processes for that category. 
In the example shown here, a Category named Maps is set up with two processes added as 
URLs. The URLs may be added as HTTP:\\ addresses or WWW. addresses.
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4.  You may add up to five processes per category and an unlimited number of categories. Each 
category acts as a group and displays on its own command line on the mobile as is shown in 
the screenshot below: 

Moving FireRMS Reports to Mobile for Dashboard
To add new reports for Dashboard users, you must first place the reports in the Reports folder on 
the server and enable access for each group of users that should have access to them. The security 
options for Reports are Allow Viewing, Allow Printing and Allow Exporting. Click on the 
checkboxes next to reach report name to enable the options as desired.   

After enabling security access to the reports, you must also copy them down to the mobile. You can 
do this via the mobile options form on the server-based client: 

1.  Copy the reports to a directory on the server client machine or on a network share accessible 
to the server. 

2.  Then go to: Tools, Administration, System, Mobile Preferences. 

3.  In the section titled File Management, enter the name and path for the directory where the 
updates reports have been located. You can use the browse icon to ensure you have the path 
setup properly. Once the path is set, click on the button labeled Update Crystal Report(s) 
on mobiles. When you launch the mobile program the next time, the reports are copied into 
its local FireRMS reports folder for use by the dashboard program.
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Note: To use the Crystal Reports that come pre-packaged with the Dashboard product, or 
new ones you have created, remember to select an address in the Dashboard before running 
the report so the data can be properly selected & displayed.
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Appendix A:Tables of Field Values

This appendix contains tables listing all the security objects to which you can assign your group 
levels of access. Each security object corresponds to menu items, forms or the desktop. You can 
assign or restrict access on the Access Rights tab.

Access Rights Definitions
Table A-1 lists the security objects and describes the access rights that you can assign to your 
personnel. You can set access levels for menus, forms, and the FireRMS desktop on the Access 
Rights tab. This tab is displayed when you click the Tools menu, then select Administration, 
followed by Security. You can choose from the following access levels:

1 - No Access prevents a user from viewing or modifying an object. The object is either 
invisible or disabled.

2 - Limited Access allows a user to view but not modify an object. Limited Access is not 
available for some of the objects.

3 - Full Access allows a user to view or modify an object.

Table A-1: Access Rights 

Object 1 - No Access 2 - Limited Access 3 - Full Access

Desktop, Delete, 
Incidents

No access to Delete 
button on Incident 
module toolbar or to 
Delete command on 
File menu. If a user 
selects this command 
or a button, a message 
displays: “You do not 
have security rights to 
delete this record!”

N/A Full access to Delete 
button on Incident 
module toolbar and to 
Delete command on 
File menu in Incident 
module.
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Desktop, Delete, 
Other Entries

No access to Delete 
button on Other 
Entries module toolbar 
or to Delete command 
on File menu in Other 
Entries module. If a 
user selects this 
command or a button, 
a message displays: 
“You do not have 
security rights to 
delete this record!”

N/A Full access to Delete 
button on Other 
Entries module toolbar 
and to Delete 
command on File 
menu in Other Entries 
module.

Desktop, Delete, 
Training

No access to Delete 
button on Training 
module toolbar or to 
Delete command on 
File menu in Training 
module. If a user 
selects this command 
or a button, a message 
displays: “You do not 
have security rights to 
delete this record!”

N/A Full access to Delete 
button on Training 
module toolbar and to 
Delete command on 
File menu in Training 
module.

Desktop, New 
Daybook

No access to Create 
New Entry toolbar 
button. The button is 
dimmed to prevent a 
user from creating a 
new Daybook item, 
e.g. Requests.

N/A Full access to create 
new Daybook 
Requests.
(Note: If you set this 
security object to Full 
Access and you set the 
corresponding menu 
command’s object to 
No Access, you will be 
unable to create 
Daybook items with 
the toolbar button.)

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Desktop, New 
Incident

No access to Create 
New Entry toolbar 
button. The button is 
dimmed to prevent a 
user from creating 
incidents.

N/A Full access to Create 
New Entry toolbar 
button.

Desktop, New 
Training

No access to Create 
New Entry toolbar 
button. The button is 
dimmed to prevent a 
user from creating 
new training sessions 
or make changes to 
training sessions.

N/A Full access to schedule 
new training sessions 
or make changes to 
training sessions.
(Note: If you set this 
security object to Full 
Access and you set the 
corresponding menu 
command’s object to 
No Access, you will be 
unable to create a new 
training session with 
the toolbar button.)

Desktop, New Other 
Entry

No access to create a 
new Other Entry. The 
toolbar button is 
dimmed to prevent a 
user from creating 
other entries.

N/A Full access to create a 
new Other Entry.
(Note: If you set this 
security object to Full 
Access and you set the 
corresponding menu 
command’s object to 
No Access, you will be 
unable to create a new 
Other Entry with the 
toolbar button.)

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Desktop, Page, 
Daybook

No access to Daybook 
parent tab on FireRMS 
desktop. The tab is 
dimmed to prevent a 
user from opening the 
Daybook.

N/A Full access to 
Daybook parent tab on 
FireRMS desktop. 
Access to records 
within Daybook is 
based on access rights 
set for Incidents, 
Training, and Other 
Entries.

Desktop, Page, 
Daybook, Daily Check

This option does not 
currently have a 
matching function.

N/A This option does not 
currently have a 
matching function. 

Desktop, Page, 
Incidents

No access to Incidents 
parent tab on FireRMS 
desktop. The tab is 
dimmed to prevent a 
user from opening the 
Incidents module.

N/A Full access to 
Incidents parent tab on 
FireRMS desktop. 
Select this option if 
granting access (2 or 
3) to any Form, 
Company or Form, 
Incident option.

Desktop, Page, Other 
Entries

No access to Other 
Entries parent tab on 
FireRMS desktop. The 
tab is dimmed to 
prevent a user from 
opening the Other 
Entries module.

N/A Full access to Other 
Entries parent tab on 
FireRMS desktop. 
Select this option if 
granting access (2 or 
3) to any Form, Other 
Entries option.

Desktop, Page, 
Reconcile

No access to the 
Reconcile tab on 
FireRMS desktop. The 
tab is not displayed.

N/A Full access to the 
Reconcile tab on 
FireRMS desktop. 
Select this option if 
granting full access to 
reconcile incidents 
created on a Tablet 
PC, using the 
FireRMS Mobile 
software.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
A-4     Appendix A: Tables of Field Values



FireRMS Administrator’s Guide
Desktop, Page, 
Training

No access to Training 
parent tab on FireRMS 
desktop. The tab is 
dimmed to prevent a 
user from opening the 
Training module.

N/A Full access to Training 
parent tab on FireRMS 
desktop. Select this 
option if granting 
limited or full access 
to any Form or 
Training option.

Desktop, Page, 
Documents

No access to 
Documents tab. 
Users in the security 
group are unable to 
open, launch, add or 
remove files from this 
module. 

Read-only Access to 
the Documents tab. 
Users in the security 
group can open or 
launch files, but 
cannot add or remove 
files.

Full access to 
Documents tab allows 
users in the security 
group to add, update, 
open or launch files 
from this module. This 
is the default setting. 

Desktop, Toolbar, 
Daily Roster

No access to Daily 
Roster button on 
FireRMS desktop. The 
button is dimmed to 
prevent a user from 
opening the Daily 
Roster. If you select 
this option, you should 
also select 1 for Menu, 
Info, Daily Roster to 
deny access to Daily 
Roster from Info 
menu.

N/A Full access to Daily 
Roster button on 
FireRMS desktop. 
Select this option if 
granting limited or full 
access to any Form, or 
Daily Roster option. 

Table A-1: Access Rights (Continued)
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Desktop, Toolbar, 
Hydrants

No access to Hydrants 
button on FireRMS 
desktop. The button is 
dimmed to prevent 
users from opening the 
Hydrants module. If 
you select this option, 
you should also select 
1 for Menu, Info, 
Hydrants to deny 
access to Hydrants 
module from Info 
menu.

N/A Full access to 
Hydrants button on 
FireRMS desktop. 
Select this option if 
granting limited or full 
access to any Form, or 
Hydrants option. 

Desktop, Toolbar, 
Occupancies

No access to 
Occupancies button on 
FireRMS desktop. The 
button is dimmed to 
prevent a user from 
opening the 
Occupancies module. 
If you select this 
option, you should 
also select 1 for Menu, 
Info, Occupancies to 
deny access to 
Occupancies from 
Info menu.

N/A Full access to 
Occupancies button on 
FireRMS desktop. 
Select this option if 
providing limited or 
full access to any 
Form, Occupancies 
option.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Desktop, Toolbar, 
Personnel

No access to 
Personnel button on 
FireRMS desktop. 
This button is dimmed 
to prevent a user from 
opening the Personnel 
module. If you select 
this option, you should 
also select 1 for Menu, 
Info, Personnel to 
deny access to 
Personnel from Info 
menu.

N/A Full access to 
Personnel button on 
FireRMS desktop. If 
you select 3 for this 
option, but select 1 for 
all Form, Personnel 
options, a user will 
still be able to access 
Personnel List and 
print Group and 
Individual Personnel 
reports.

Desktop, Toolbar, 
Personnel, Lock 
Personnel

Prevents the user from 
accessing the Show 
Locked Out option in 
the Personnel Module. 

N/A Allows the User to 
view and clear the 
locked status of any 
Personnel who have 
been locked out of the 
system.
Used in conjunction 
with the Max Logins 
option.

Desktop, Toolbar, 
Reports

No access to Reports 
button on FireRMS 
desktop. The button is 
dimmed to prevent a 
user from opening the 
Reports module. If 
you select this option, 
you should also select 
1 for Menu, Info, 
Reports to deny access 
to Reports from Info 
menu.

N/A Full access to Reports 
button on FireRMS 
desktop. 

Table A-1: Access Rights (Continued)
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Desktop, Toolbar, 
Scheduling & 
Tracking

No access to 
Scheduling & 
Tracking button on 
FireRMS desktop. The 
button is dimmed to 
prevent a user from 
opening the 
Scheduling & 
Tracking module. If 
you select this option, 
you should also select 
1 for Menu, Info, 
Scheduling & 
Tracking to deny 
access to Scheduling 
& Tracking from Info 
menu.

N/A Full access to 
Scheduling & 
Tracking button on 
FireRMS desktop. 
Select this option if 
granting limited or full 
access to any Form, 
Scheduling & 
Tracking option. 

Desktop, Toolbar, 
Vehicles & Equipment

No access to Vehicles 
and Equipment button 
on FireRMS desktop. 
The button is dimmed 
to prevent a user from 
opening the Vehicles 
& Equipment module. 
If you select this 
option, you should 
also select 1 for Menu, 
Info, Vehicles & 
Equipment to deny 
access to Vehicles & 
Equipment from Info 
menu.

N/A Full access to Vehicles 
and Equipment button 
on FireRMS desktop. 
Select this option if 
granting limited or full 
access to any Form, 
Vehicles & Equipment 
option. 

Table A-1: Access Rights (Continued)
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Form, Company, 
Completed

No access to any 
“completed” (Select 
“Complete” check box 
in Incident Form's 
Authorization tab) 
company (modified 
incident) report. 

Full access (read/
write) to any 
completed company 
report. 

Form, Company, 
Incomplete

No access to any 
incomplete (Do not 
select “Complete” 
check box in 
Authorization tab of 
incident report) 
company (modified 
incident) report. The 
user cannot view 
incomplete company 
reports or create a new 
company report.

Full access (read/
write) to any 
incomplete company 
report. 

Form, Company, 
Reviewed

No access to any 
reviewed (Select 
“Reviewed” check 
box in Authorization 
tab of incident report) 
company (modified 
incident) report.

Full access (read/
write) to any reviewed 
company report. 

Form, Credentials No access to 
Credentials Explorer. 
The user cannot view 
or select credentials 
for training classes.

Read-only access to 
Credentials Explorer. 
The user can view and 
select credentials for 
training classes, but 
cannot add, modify or 
delete credentials in 
Credentials Explorer.

Full access (read/
write) to Credentials 
Explorer. The user can 
view, select, add, 
modify and delete 
credentials.

Table A-1: Access Rights (Continued)
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Form, Credentials 
Earned

No access to 
Credentials Earned 
Explorer from Info > 
Personnel menu. The 
command is active, 
but if selected, a 
message displays 
indicating that a user 
does not have access 
rights.

Read-only access to 
Credentials Earned 
Explorer.

Full access (read/
write) to Credential 
Earned Explorer. 

Form, Daily Roster No access to Daily 
Roster for any day. 

Read-only access to 
Daily Roster for any 
day, provided roster 
has been already been 
created. The user 
cannot create or 
modify the roster.

Full access (read/
write) to Daily Roster. 
The user can preview, 
create and modify the 
roster for any day. 

Form, Daily Roster, 24 
Hours or Older

If you set Form, Daily 
Roster to 1, the user 
has no access to any 
Daily Roster.
If you set Form, Daily 
Roster to 2, the user 
has read only access to 
rosters within the last 
24-hours.
If you set Form, Daily 
Roster to 3, the user 
has full access to 
rosters within the last 
24-hours.

N/A If you set Form, Daily 
Roster to 1, the user 
has no access to any 
roster.
If you set Form, Daily 
Roster to 2, the user 
has read only access to 
all rosters within the 
last 24 hours.
If you set Form, Daily 
Roster to 3, you have 
full access to all 
rosters.

Form, Daily Roster, 
Create New

Prevents the user from 
creating a new Roster. 

N/A Allows the user to 
create a new Roster. 
Note: this option is not 
available on FireRMS 
mobile units.

Table A-1: Access Rights (Continued)
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Form, Hydrants No access to Hydrants 
module.

Read-only access to 
Hydrants module. The 
user can view but not 
modify hydrant 
information. If you 
select this option, you 
may also want to 
select 2 for Form, 
Scheduling & 
Tracking, Hydrants to 
grant read-only access 
to hydrants in 
Scheduling & 
Tracking module.

Full access (read/
write) to Hydrants 
module.

Form, Incident, Add 
Apparatus 

Prevents the user from 
adding new Apparatus 
records to an Incident.

N/A Allows the user to add 
new Apparatus 
records to an Incident.

Form, Incident, 
Advanced EMS

No access to 
Advanced EMS tab in 
Incidents module. The 
tab is dimmed to 
prevent the user from 
accessing it.

N/A Access to Advanced 
EMS tab in Incidents 
module. The level of 
access is determined 
by the settings for 
Form Incident 
Incomplete, Form 
Incident Completed, 
Form Incident 
Reviewed and the 
completion/reviewed 
state of the incident 
report.

Form, Incident, 
Advanced EMS, 
Attach, Delete

Prevents the user from 
deleting attachments 
on the AdvEMS Tab. 

N/A Allows the user to 
delete attachments 
from the AdvEMS 
attachments tab. 
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Form, Incident, 
AdvancedEMS, All 
patient info

Prevents users from 
viewing patient 
information in an 
Incident when the 
Lock PCR option is 
enabled.

N/A Allows the user to 
view patient 
information in an 
incident when the 
Lock PCR option is 
enabled, regardless of 
the user to whom the 
data is assigned.

Form, Incident, 
Advanced EMS, 
AutoNarrative

No access to the EMS 
Auto Narrative button 
on the EMS Narrative 
tab. The button is 
greyed; users must 
manually enter 
narrative text.

N/A Access to the EMS 
Auto Narrative button. 
The automatic 
narrative text entered 
is based on 
information entered in 
the Advanced EMS 
module.

Form, Incident, Arson No access to Arson tab 
in Incidents module. 
The tab is dimmed to 
prevent the user from 
accessing it.

N/A Access to Arson tab in 
Incidents module. The 
user can view and 
modify information on 
this tab. The level of 
access is determined 
by the settings for 
Form Incident 
Incomplete, Form 
Incident Completed, 
Form Incident 
Reviewed and the 
completion/reviewed 
state of the incident 
report.

Form, Incident, Arson, 
Attachments

Prevents the user from 
deleting attachments 
on the Incident Arson 
Tab. 

Allows the user to 
delete attachments 
from the Incident 
Arson tab.
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Form, Incident, Arson, 
Attachments, Delete

Prevents the user from 
deleting attachments 
on the Incident Arson 
Tab. 

Allows the user to 
delete attachments 
from the Incident 
Arson tab.

Form, Incident, 
Authoriz, Member, 
Personnel

No access to the 
Personnel Explorer 
button in the Member 
Making Report section 
of the Incident 
Authorization tab. The 
user cannot select who 
will authorize the 
Incident from the list 
of personnel. Only the 
Set to Current User 
button can be used.

N/A Access to the 
Personnel Explorer 
button in the Member 
Making Report section 
of the Incident 
Authorization tab. The 
user can select 
personnel to authorize 
the Incident.

Form, Incident, 
Authoriz, Officer, 
Personnel

No access to the 
Personnel Explorer 
button in the Officer in 
Charge section of the 
Incident Authorization 
tab. The user cannot 
select who will 
authorize the Incident 
from the list of 
personnel. Only the 
Set to Current User 
button can be used.

N/A Access to the 
Personnel Explorer 
button in the Officer in 
Charge section of the 
Incident Authorization 
tab. The user can 
select an officer to 
authorize the Incident.
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Form, Incident, 
Authoriz, Reviewer, 
Personnel

No access to the 
Personnel Explorer 
button in the Reviewer 
section of the Incident 
Authorization tab. The 
user cannot select who 
will authorize the 
Incident from the list 
of personnel. Only the 
Set to Current User 
button can be used.

N/A Access to the 
Personnel Explorer 
button in the Reviewer 
section of the Incident 
Authorization tab. The 
user can select a 
reviewer to authorize 
the Incident.

Form, Incident, Basic, 
Attachments, Delete

Prevents the user from 
deleting attachments 
on the Incident Basic 
Attachments tab.

N/A Allows the user to 
delete attachments 
from the Incident 
Basic Attachment tab.

Form, Incident, 
Casualties, Civ, Count 

Prevents the user from 
changing the Civilian 
Casualty Count value 
in the Ontario 
Province version of 
FireRMS.

N/A Allows the user to 
change the Civilian 
Casualty Count value 
in the Ontario 
Province version of 
FireRMS.

Form, Incident, 
Casualties, Civilian

Prevents the user from 
accessing the Civilian 
Casualty tabs.

N/A Allows the user to 
access the Civilian 
Casualty tabs.

Form, Incident, 
Casualties, Fire 
Service

Prevents the user from 
accessing the Fire 
Service Casualty tabs.

N/A Allows the user to 
access the Fire Service 
Casualty tabs.

Form, Incident, 
Casualties, FS, Count

Prevents the user from 
changing the Fire 
Service Casualty 
Count value in the 
Ontario Province 
version of FireRMS.

N/A Allows the user to 
change the Fire 
Service Casualty 
Count value in the 
Ontario Province 
version of FireRMS.
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Form, Incident, Fire, 
Exposure Count 

Prevents the user from 
changing the Exposure 
Count value in the 
Ontario Province 
version of FireRMS.

N/A Allows the user to 
change the Exposure 
Count value in the 
Ontario Province 
version of FireRMS.

Form, Incident, 
Completed

No access to any 
completed (Select 
“Complete” check box 
in Authorization tab) 
incident report.

Read-only access to 
any completed 
incident report.

Full access (read/
write) to any 
completed incident 
report. The user can 
also review (select 
“Reviewed” check 
box) incident reports.

Form, Incident, 
Incident Scroll 
Buttons

No access to scroll 
buttons in Incidents 
module.

N/A Full access to scroll 
buttons in the 
Incidents module.

Form, Incident, 
Incomplete

No access to any 
incomplete (Do not 
select “Complete” 
check box in 
Authorization tab) 
incident report.

Read-only access to 
any incomplete 
incident report. The 
user can view but not 
modify the report. 
Users cannot create a 
new incident report.

Full access (read/
write) to any 
incomplete incident 
report. 

Form, Incident, 
Narrative, Author 

No access to edit the 
Incident Narrative for 
users who login and 
are not the original 
author of the 
Narrative.

No access to change 
the Author of any 
narrative unless you 
are the Author. 

Access to edit the 
Incident Narrative for 
logged in users who 
are not the original 
author.

Form, Incident, 
Narrative, 
Auto-Narrative 

No access to the Auto 
button on the 
Narrative tab that 
inserts the auto 
narrative. Narratives 
must be manually 
entered.

N/A Access to the Auto 
button on the 
Narrative tab that 
inserts the auto 
narrative. Users can 
insert the auto 
narrative or insert the 
auto narrative.
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Form, Incident, 
Number & Times

Read-only access to 
incident times and 
numbers on the 
Incident Form.

N/A Full access (read/
write) to incident 
times and number on 
Incident Form.

Form, Incident, PSAP 
Time 

Prevents unauthorized 
access to the PSAP 
Time Field. 

Access to enter or 
update the PSAP time 
on an Incident. 

Form, Incident, Older 
Than 48 Hour

No access to incidents 
older than 48 hours.

Read only access to 
incidents older than 48 
hours. 

Access to incidents 48 
hours or older. The 
level of access is 
determined by the 
settings for Form 
Incident Incomplete, 
Form Incident 
Completed, Form 
Incident Reviewed 
and the completion/
reviewed state of the 
incident report.

Form, Incident, Other 
Than Your Narrative

No access to 
narratives other than 
your own, based on 
login ID. Access to the 
remainder of the 
incident report is 
determined by the 
other Form Incident 
Security settings.

Full access to 
narratives other than 
your own. Access to 
the remainder of the 
incident report is 
determined by the 
other Form Incident 
Security settings.

Form, Incident, 
Personnel, Delete 

Prevents the user from 
deleting Personnel 
records that exist on 
an Incident.

N/A Allows the user to 
delete personnel 
records that exist on 
an Incident.

Form, Incident, 
Personnel, Delete

No access to the 
Delete button on the 
Incident>Resources>P
ersonnel tab.

N/A Access to the Delete 
button on the 
Incident>Resources>P
ersonnel tab.
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Form, Incident, Print No access to print for 
incidents.

N/A Full access to printing 
incidents.

Form, Incident, 
Reviewed

No access to any 
reviewed (Select 
“Reviewed” check 
box in Authorization 
tab) incident report.

Read-only access to 
any reviewed incident 
report. The user can 
view but not modify a 
report.

Full access (read/
write) to any reviewed 
incident report. The 
user can clear 
(“de-select”) 
Complete and 
Reviewed check boxes 
so that those with 
security rights can 
modify an incident 
report. 

Form, Incident, 
Supplemental Reports

Prevents the user from 
creating supplemental 
reports when the Lock 
Incident option is in 
use.

N/A Allows a user to create 
supplemental reports 
when the Lock 
Incident option is in 
use.

Form, Occupancies No access to the 
Occupancies module. 
If you select this 
option, you should 
also select 1 for 
Desktop, Toolbar, 
Occupancies and 
Menu, Info, 
Occupancies to deny 
access to desktop 
button and menu 
command used to 
open Occupancies 
module.

Read-only access to 
the Occupancies 
module. The user can 
view occupancies but 
cannot add or modify 
occupancies or 
schedule occupancy 
inspections.

Full access (read/
write) to Occupancies 
module. 
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Form, Other Entry, 
Completed

No access to any 
completed (Select 
“Complete” check box 
in Other Entry Form's 
Authorization tab) 
Other Entry event.

Read-only access to 
any completed Other 
Entry event.

Full access to any 
completed Other Entry 
event. The user can 
also review (select 
“Reviewed” check 
box in Authorization 
tab) Other Entry 
events.

Form, Other Entry, 
Incomplete

No access to any 
incomplete (Do not 
select “Complete” 
check box in Other 
Entry Form's 
Authorization tab) 
Other Entry event.

Read-only access to 
any incomplete Other 
Entry event.

Full access to any 
incomplete Other 
Entry event. The user 
can create, modify and 
delete entries. The 
user can also complete 
(Select “Complete” 
check box) events. 

Form, Other Entry, 
LOSAP

Prevents a user from 
accessing the LOSAP 
points or type fields in 
an Other Entry form.

Provides read-only 
access to the LOSAP 
points and type fields 
in an Other Entry 
form.

Allows the user to 
access and/or modify 
the LOSAP points and 
type fields in an Other 
Entry form.

Form, Other Entry, 
Reviewed

No access to any 
reviewed (Select 
“Reviewed” check 
box in Other Entry 
Form's Authorization 
tab) Other Entry event.

Read-only access to 
any reviewed Other 
Entry event.

Full access to any 
reviewed Other Entry 
event. Clear 
(“uncheck”) Reviewed 
and Completed check 
boxes so that those 
with security rights 
can modify the Other 
Entry event. 

Form, Personnel, 
Personal, View 
exposures

No access to 
Personnel>Personal>E
xposure notes which 
contain information 
about users exposed to 
diseases or chemicals.

N/A Full access to 
Personnel>Personal>
Exposure notes.
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Form, Personnel Info, 
Basic, Security Group

Prevents the user from 
changing the security 
group setting for any 
record in the 
Personnel module.

N/A Allows the user to 
change the security 
group setting in 
personnel unless 
overridden by other 
security objects.

Form, Personnel Info, 
All, Non-Restricted

No access to 
non-restricted 
personnel information 
other than the user's 
own (based on login 
ID). If you select this 
option, you may also 
want to select 1 for 
Desktop, Toolbar, 
Personnel and Menu, 
Info, Personnel to 
deny access to the 
Personnel List and 
prevent the user from 
printing Individual 
and Group Personnel 
reports.

Read-only access to 
non-restricted 
personnel information 
other than the user's 
own.

Full access (read/
write) to all 
non-restricted 
personnel information. 
The user can add, 
modify and delete 
non-restricted 
personnel records. 
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Form, Personnel Info, 
All, Restricted

No access to restricted 
personnel information 
other than the user's 
own (based on login 
ID). If you select this 
option, you may also 
want to select 1 for 
Desktop, Toolbar, 
Personnel and Menu, 
Info, Personnel to 
deny access to 
Personnel List and 
prevent the user from 
printing Individual 
and Group Personnel 
reports.

Read-only access to 
restricted personnel 
information, including 
information such as 
SSN and restricted 
phone numbers, for all 
records but the user's 
own.

Full access (read/
write) to restricted 
personnel information 
for all records but the 
user's own. Should be 
reserved for 
administrators and 
staff designated to 
maintain personnel 
records. 

Form, Personnel Info, 
All, Scheduling

No access to the 
Scheduling tab in the 
Personnel module for 
all records other than 
the user's own (based 
on login ID).

Read-only access to 
the Scheduling tab in 
the Personnel module 
for all records other 
than the user's own.

Full access (read/
write) to the 
Scheduling tab in the 
Personnel module for 
all records other than 
the user's own. The 
user can add, delete 
and modify scheduling 
changes. Should be 
reserved for those 
making scheduling 
changes in advance 
such as changes to 
future rosters, vacation 
lists and future 
personnel changes. 

Form, Personnel Info, 
Attachments, Delete 

Prevents the user from 
deleting attachments 
in the Personnel 
module.

N/A Allows the user to 
delete attachments in 
the Personnel module.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
A-20     Appendix A: Tables of Field Values



FireRMS Administrator’s Guide
Form, Personnel Info, 
You, Non-Restricted

No access to the user's 
own non-restricted 
personnel information 
(based on login ID).

Read-only access to 
the user's own 
non-restricted 
personnel info. The 
user can view but not 
modify their own 
non-restricted 
personnel info.

Full access (read/
write) to the user's 
own non-restricted 
personnel information. 
The user can add, 
delete and modify 
non-restricted 
information in their 
own personnel record. 

Form, Personnel Info, 
Basic, Logon Info

Prevents additions or 
updates to the Logon, 
Password and Security 
Group Sections of a 
Personnel Record.

Not available. Allows additions or 
updates to the Logon, 
Password and Security 
Group Sections of a 
Personnel Record. 

Form, Personnel Info, 
LOSAP

Prevents the user from 
accessing the LOSAP 
tab in the Personnel 
module.

Provides read only 
access to the LOSAP 
tab in the Personnel 
module.

Allows the user full 
access to fields and 
reports available on 
the LOSAP tab in the 
Personnel module.

Form, Personnel Info, 
Basic, Demographic

Prevents users from 
making unauthorized 
changes to the 
NEMSIS section of 
the Personnel Basic 
Info form. This 
information is used to 
automatically update 
the Personnel 
information in the 
Demographics 
database for systems 
using NEMSIS 
Reporting. 

Does not apply to this 
option. 

Allows full access and 
enables the user   to 
enter the information 
in the NEMSIS 
section of the 
personnel form. 
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Form, Personnel Info, 
You, Restricted

No access to the user's 
own restricted 
personnel information 
(based on login ID).

Read-only access to 
the user's own 
restricted personnel 
information. The user 
can view but not 
modify their own 
information such as 
SSN, evaluation 
information and 
restricted phone 
numbers.

Full access (read/
write) to the user's 
own restricted 
personnel information. 
The user can add, 
delete and modify 
restricted information 
in their own personnel 
record. Should be 
reserved for 
administrators and 
staff designated to 
maintain restricted 
personnel information. 

Form, Personnel Info, 
You, Scheduling

No access to the user's 
own information on 
the Scheduling tab in 
the Personnel module.

Read-only access to 
the user's own 
information on the 
Scheduling tab in the 
Personnel module. 
The user can view but 
not change their own 
scheduling 
information.

Full access (read/
write) to the user's 
own information on 
the Scheduling tab in 
the Personnel module. 
The user can change 
their own scheduling 
information. Should 
be reserved for those 
responsible for 
making scheduling 
changes in advance, 
such as changes to 
future rosters, vacation 
changes and future 
personnel changes.
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Form, Scheduling & 
Tracking, Credentials

No access to 
Credentials 
information in the 
Scheduling & 
Tracking module. The 
Credentials node is 
hidden in the 
Scheduling & 
Tracking tree view.

Read-only access to 
Credentials 
information in 
Scheduling & 
Tracking. The user can 
view but not modify 
Credentials in 
Scheduling & 
Tracking.

Full access to 
Credentials 
information in 
Scheduling & 
Tracking. The user can 
view and modify 
Credentials in 
Scheduling & 
Tracking. 

Form, Scheduling & 
Tracking, Equipment

No access to 
Equipment 
information in the 
Scheduling & 
Tracking module. The 
Equipment node is 
hidden in Scheduling 
& Tracking tree view.

Read-only access to 
the Equipment 
information in the 
Scheduling & 
Tracking module.

Full access (read/
write) to Equipment 
information in the 
Scheduling & 
Tracking module. 

Form, Scheduling & 
Tracking, Hydrants

No access to the 
Hydrant information 
in the Scheduling & 
Tracking module. The 
Hydrant node is 
hidden in the 
Scheduling & 
Tracking tree view.

Read-only access to 
Hydrant information 
in the Scheduling & 
Tracking module. The 
user can view but not 
modify hydrants in 
Scheduling & 
Tracking.

Full access (read/
write) to Hydrant 
information in the 
Scheduling & 
Tracking module. The 
user can modify the 
hydrant information in 
Scheduling & 
Tracking.

Form, Scheduling & 
Tracking, 
Occupancies

No access to the 
Occupancy 
information in the 
Scheduling & 
Tracking module. The 
Occupancies node is 
hidden in the 
Scheduling & 
Tracking tree view.

Read-only access to 
Occupancy 
information in the 
Scheduling & 
Tracking module. The 
user can view but not 
modify the Occupancy 
information in 
Scheduling & 
Tracking.

Full access (read/
write) to Occupancy 
information in the 
Scheduling & 
Tracking module. The 
user can view and 
modify Occupancy 
information in 
Scheduling & 
Tracking. 

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
Access Rights Definitions     A-23



Form, Scheduling & 
Tracking, Personnel

No access to 
Personnel information 
in the Scheduling & 
Tracking module. The 
Personnel node is 
hidden in the 
Scheduling & 
Tracking tree view.

Read-only access to 
Personnel information 
in the Scheduling & 
Tracking module. The 
user can view but not 
modify Personnel 
information in 
Scheduling & 
Tracking

Full access (read/
write) to Personnel 
information in the 
Scheduling & 
Tracking module. The 
user can view and 
modify Personnel 
information in 
Scheduling & 
Tracking. 

Form, Scheduling & 
Tracking, Training

No access to Training 
information in the 
Scheduling & 
Tracking module. The 
Training node is 
hidden in the 
Scheduling & 
Tracking tree view.

Read-only access to 
the Training 
information in the 
Scheduling & 
Tracking module. The 
user can view but not 
modify Training 
information in 
Scheduling & 
Tracking.

Full access (read/
write) to Training 
information in the 
Scheduling & 
Tracking module. The 
user can view and 
modify Training 
information in 
Scheduling & 
Tracking. 

Form, Scheduling & 
Tracking, Vehicles

No access to Vehicle 
information in the 
Scheduling & 
Tracking module. The 
Vehicle node is hidden 
in the Scheduling & 
Tracking tree view.

Read-only access to 
Vehicle information in 
the Scheduling & 
Tracking module. The 
user can view but not 
modify Vehicle entries 
in Scheduling & 
Tracking.

Full access (read/
write) to Vehicle 
information in the 
Scheduling & 
Tracking module. The 
user can view and 
modify Vehicle entries 
in Scheduling & 
Tracking. 

Form, Training, Any 
User for Authorities

No access to 
authorizing training 
classes. The Explorer 
buttons on the 
Authorization tab are 
dimmed to prevent 
you from selecting a 
name.

N/A Full access to 
authorize training 
classes. The user can 
click the Explorer 
buttons and select a 
name from the list of 
personnel.
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Form, Training 
Classes

No access to Class 
Explorer from the 
Training module. The 
user cannot open Class 
Explorer to view or 
select from the list of 
classes.

Read-only access to 
Class Explorer from 
the Training module. 
The user can select 
classes but not add, 
modify or delete 
classes in the Class 
Explorer.

Full access (read/
write) to list of classes 
in Class Explorer from 
the Training module. 
The user can select, 
add, modify and delete 
classes in Class 
Explorer.

Form, Training 
Objectives/Skills

No access to Objective 
Explorer from the 
Training module. The 
user cannot open 
Objectives Explorer to 
view or select from the 
list of objectives and 
skills.

Read-only access to 
Objective Explorer 
from the Training 
module. The user can 
select objectives and 
skills but cannot add, 
modify or delete 
objectives and skills in 
the Objectives 
Explorer.

Full access (read/
write) to the Objective 
Explorer from the 
Training module. The 
user can select, add, 
modify and delete 
objectives and skills in 
the Objective 
Explorer. 

Form, Training, 
Completed

No access to 
completed (Select 
“Complete” check box 
on Training Form's 
Authorization tab) 
entries in the Training 
module.

Read-only access to 
completed entries in 
the Training module. 
The user can view but 
not modify these 
records.

Full access (read/
write) to completed 
entries in Training 
module. The user can 
view and modify these 
records. The user can 
also review (select 
“Reviewed” check 
box on Training 
Form's Authorization 
tab) training entries. 
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Form, Training, 
Incomplete

No access to 
incomplete (Do not 
select “Complete” 
check box in Training 
Form's Authorization 
tab) entries in the 
Training module. The 
user cannot view these 
records or create new 
training sessions.

Read-only access to 
incomplete entries in 
the Training module. 
The user can view but 
not modify these 
records. The user 
cannot create a new 
training session.

Full access (read/
write) to incomplete 
entries in Training 
module. The user can 
view and modify these 
records and create new 
training sessions. 

Form, Training, 
LOSAP 

Prevents a user from 
accessing the LOSAP 
points or type fields in 
a Training form.

Provides read only 
access to the LOSAP 
points and type fields 
in a Training form.

Allows the user full 
access to the LOSAP 
points and type fields 
in a Training form.

Form, Training, 
Participant

No access to the 
Participants tab. The 
access levels for the 
remainder of the 
training event form are 
determined by the 
settings for Form 
Training Incomplete, 
Form Training 
Completed, Form 
Training Reviewed, 
and the completion/
reviewed state of the 
training report.

N/A Full access to the 
Participants tab. The 
access levels for the 
remainder of the 
training event form are 
determined by the 
settings for Form 
Training Incomplete, 
Form Training 
Completed, Form 
Training Reviewed, 
and the completion/
reviewed state of the 
training report.
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Form, Training, 
Preregistration

No access to the 
Preregistration box. 

N/A Full access to the 
Preregistration box. 
Select this check box 
to include 
preregistration 
information, which is 
comprised of 
minimum class size 
and maximum class 
size, in the default 
class description.

Form, Training, 
Reviewed

No access to any 
reviewed (Select 
“Reviewed” check 
box in the 
Authorization tab) 
training session.

Read-only access to 
any reviewed training 
session. The user can 
view but not modify 
details.

Full access (read/
write) to any reviewed 
training session. The 
user can clear 
(“de-select”) the 
Complete and 
Reviewed check box 
so that those with 
security rights can 
modify session details. 

Form, Training, 
Reviewer

The user cannot select 
a Reviewer/Instructor 
on the Authorization 
tab.

N/A The user can select a 
Reviewer/Instructor 
on the Authorization 
tab.
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Form, Vehicles & 
Equipment

No access to the 
Vehicles & Equipment 
module. If selected, 
you should also select 
1 for Desktop, 
Toolbar, Vehicles & 
Equipment and Menu, 
Info, Vehicles & 
Equipment to deny 
access to the desktop 
button and the menu 
command used to 
access the Vehicles & 
Equipment module.

Read-only access to 
entries in the Vehicles 
& Equipment module. 
The user can view but 
not modify entries.

Full access to entries 
in the Vehicles & 
Equipment module. 
The user can add, 
modify and delete 
entries. 

Hydrants, Activities, 
Delete 

Prevents a user from 
deleting activities 
from the Hydrants 
module.

N/A Allows the user to 
delete activity records 
from the Hydrants 
module.

Hydrants, Activities, 
Tab 

Allows full access to 
the Activities tab in 
the Hydrants module.

Provides read only 
access to the activities 
tab in the Hydrants 
module.

Allows Full access to 
the Activity tab in the 
Hydrant Module.

Hydrants, Schedules, 
Tab

Prevents a user from 
accessing the 
Recurring Schedule 
tab in the Hydrants 
module.

Provides read-only 
access to the recurring 
schedule tab in the 
Hydrants module.

Allows full access to 
the recurring schedule 
tab in the Hydrants 
module.

Menu, Forms, New 
Incident

No access to the New 
Incident command on 
the Forms menu. The 
command is dimmed 
to prevent the user 
from creating an 
incident.

N/A Full access to the New 
Incident command on 
the Forms menu. The 
user can select the 
command to create a 
new incident.
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Menu, Forms, New 
Other Entry

No access to create 
new Other Entries. 
The menu command is 
dimmed to prevent the 
user from creating a 
new entry.

N/A Full access to create 
new Other Entries

Menu, Forms, New 
Training

No access to create 
new Training sessions. 
The menu command is 
dimmed to prevent the 
user from creating 
new sessions.

N/A Full access to create 
new Training sessions.

Menu, Help, Web 
Support

No access to the Web 
Support command on 
the Help menu. The 
command is dimmed 
to prevent the user 
from linking to the 
FireRMS Internet 
support site.

N/A Full access to the Web 
Support command on 
the Help menu. The 
user can select the 
command to link to 
the FireRMS Internet 
support site.

Menu, Info, Daily 
Roster

No access to the Daily 
Roster command on 
the Info menu. The 
command is dimmed 
to prevent the user 
from opening the 
Daily Roster. If you 
select this option, you 
should also select 1 for 
Desktop, Toolbar, 
Daily Roster to deny 
access to the desktop 
button used to open 
the Daily Roster.

N/A Full access to the 
Daily Roster 
command on the Info 
menu. The user can 
select the command to 
open the Daily Roster.
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Menu, Info, Hydrants No access to the 
Hydrants command on 
the Info menu. The 
command is dimmed 
to prevent the user 
from opening the 
Hydrants module. If 
you select this option, 
you should also select 
1 for Desktop, 
Toolbar, Hydrants to 
deny access to the 
desktop button used to 
open the Hydrants 
module.

N/A Full access to the 
Hydrants command on 
the Info menu. The 
user can select the 
command to open the 
Hydrants module. 

Menu, Info, 
Occupancies

No access to the 
Occupancies 
command on the Info 
menu. The command 
is dimmed to prevent 
the user from opening 
the Occupancies 
module. If you select 
this option, you should 
also select 1 for 
Desktop, Toolbar, 
Occupancies to deny 
access to the desktop 
button used to open 
the Occupancies 
module.

N/A Full access to the 
Occupancies 
command on the Info 
menu. The user can 
select the command to 
open the Occupancies 
module.
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Menu, Info, Personnel No access to the 
Personnel command 
on the Info menu. The 
command is dimmed 
to prevent the user 
from opening the 
Personnel module. If 
you select this option, 
you should also select 
1 for Desktop, 
Toolbar, Personnel to 
deny access to the 
desktop button used to 
open the Personnel 
module.

N/A Full access to the 
Personnel command 
on the Info menu. The 
user can select this 
command to open the 
Personnel module. 

Menu, Info, Reports No access to the 
Reports command on 
the Info menu. The 
command is dimmed 
to prevent the user 
from opening the 
Reports module. If 
you select this option, 
you should also select 
1 for Desktop, 
Toolbar, Reports to 
deny access to the 
desktop button used to 
open the Reports 
module.

N/A Full access to the 
Reports command on 
the Info menu. The 
user can select the 
command to open the 
Reports module. 
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Menu, Info, 
Scheduling & 
Tracking

No access to the 
Scheduling & 
Tracking command on 
the Info menu. The 
command is dimmed 
to prevent the user 
from opening the 
Scheduling & 
Tracking module. If 
you select this option, 
you should also select 
1 for Desktop, 
Toolbar, Scheduling & 
Tracking to deny 
access to the desktop 
button used to open 
the Scheduling & 
Tracking module.

N/A Full access to the 
Scheduling & 
Tracking command on 
the Info menu. The 
user can select the 
command to open the 
Scheduling & 
Tracking module. 

Menu, Info, Vehicles 
& Equipment

No access to the 
Vehicles & Equipment 
command on the Info 
menu. The command 
is dimmed to prevent 
the user from opening 
the Vehicles & 
Equipment module. If 
you select this option, 
you should also select 
1 for Desktop, 
Toolbar, Vehicles & 
Equipment to deny 
access to the desktop 
button used to open 
the Vehicles & 
Equipment module.

N/A Full access to the 
Vehicles & Equipment 
command on the Info 
menu. The user can 
select the command to 
open Vehicles & 
Equipment module. 
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Menu, Tools, Add, 
Chemicals

Prevents the user from 
modifying the 
Security Exclusions 
tab.

N/A Allows a user to add 
new Chemical codes 
to the Chemical Code 
list.

Menu, Tools, Admin, 
Security, Exclusions

Prevents the user from 
modifying the 
Security Exclusions 
tab.

N/A Allows a user to 
modify the Security 
Exclusions tab.

Menu, Tools, 
Administration, 
Security

No access to the 
Security command on 
the Tools > 
Administration menu. 
The command is 
dimmed to prevent the 
user from opening the 
Security dialog and 
modifying security 
rights.

N/A Full access to Security 
command on the Tools 
> Administration 
menu. The user can 
open the Security 
dialog and modify the 
security rights. This 
should be reserved for 
system administrators.

Menu, Tools, 
Administration, 
Security, SecLev

Prevents a user from 
modifying the security 
level for any security 
group.

N/A Allows a user to 
modify the security 
level for any security 
group.

Menu, Tools, 
Administration, 
System

No access to the 
System command on 
the Tools > 
Administration menu. 
The command is 
dimmed to prevent the 
user from opening the 
System dialog and 
modifying the system 
settings.

N/A Full access to the 
System command on 
the Tools > 
Administration menu. 
The user can open the 
System dialog and 
modify the system 
settings. This should 
be reserved for system 
administrators.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
Access Rights Definitions     A-33



Menu, Tools, 
Administration, 
System, Change 
Encrypt

No access to the 
Enable HIPPA 
Encryption check box 
on the Settings tab. 
The box is dimmed to 
prevents users from 
encrypting current and 
future patient data.

N/A Full access to the 
Enable HIPPA 
Encryption check box 
on the Settings tab. 
Users can select this 
check box to encrypt 
the current and future 
patient data. The 
following data is 
encrypted: name, date 
of birth and social 
security number. 
Encrypted data 
appears as asterisks.

Menu, Tools, 
Administration, 
System, View 
Encrypted

No access to view 
encrypted patient data. 
Fields with encrypted 
data (name, DOB, 
SS#) display asterisks.

N/A Full access to view 
encrypted data. The 
data displays on the 
tabs and in reports 
instead of asterisks.

Menu, Tools, 
Administration, 
Demographics

No access - user 
cannot access 
demographics form 
used to set up 
NEMSIS reporting.

N/A Full access allows user 
to update the 
demographics form 
available in 
Tools>Administration
>Demographics for 
NEMSIS reporting.

Menu, Tools, 
Customize, Advanced 
EMS

No access to the menu 
command Tools > 
Customize > 
Advanced EMS that 
enables users to create 
their own Flow Chart 
protocols.

N/A Full access to the 
command Tools > 
Customize > 
Advanced EMS > 
Protocols. Users can 
design their own 
protocols that appear 
on the Advanced EMS 
Flow Chart tab.
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Menu, Tools, 
Customize, Apparatus

No access to the 
Apparatus command 
on the Tools > 
Customize menu. The 
command is dimmed 
to prevent the user 
from opening the 
Customize Apparatus 
dialog and modifying 
the apparatus setup 
codes.

N/A Full access to the 
Apparatus command 
on the Tools > 
Customize menu. The 
user can open the 
Customize Apparatus 
dialog and modify the 
apparatus setup codes. 
This should be 
reserved for system 
administrators.

Menu, Tools, 
Customize, Cities

No access to the Cities 
command on the Tools 
> Customize menu. 
This command is 
dimmed to prevent the 
user from opening the 
Customize Cities 
dialog and modifying 
the city entries.

N/A Full access to the 
Cities command on 
the Tools > Customize 
menu. The user can 
select the command to 
open the Customize 
Cities dialog and 
modify city entries. 
This should be 
reserved for system 
administrators.

Menu, Tools, 
Customize, Codes

No access to the 
Codes command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from opening 
the Customize Codes 
dialog and modifying 
the FireRMS setup 
codes.

N/A Full access to the 
Codes command on 
the Tools > Customize 
menu. The user can 
select the command to 
open the Customize 
Codes dialog and 
modify the setup 
codes. This should be 
reserved for system 
administrators.
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Menu, Tools, 
Customize, Codes, 
901 Codes

Prevents the user from 
accessing the 901 
codes form.

N/A Allows a user to 
access the 901 codes 
form if Menu, Tools, 
Customize, Codes is 
also set 3 – Full 
Access.

Menu, Tools, 
Customize, Codes, 
Dept Codes

Prevents a user from 
accessing the 
Department codes 
form.

N/A Allows a user full 
access to the 
Department codes 
form if Menu, Tools, 
Customize, Codes is 
also set 3 – Full 
Access.

Menu, Tools, 
Customize, Codes, 
EMS Codes

Prevents a user from 
accessing the EMS 
codes form.

N/A Allows a user full 
access to the EMS 
codes form if Menu, 
Tools, Customize, 
Codes is also set 3 – 
Full Access.

Menu, Tools, 
Customize, 
Department

No access to the 
Department command 
on the Tools > 
Customize menu. The 
command is dimmed 
to prevent the user 
from opening the 
Customize 
Department dialog and 
customizing 
department 
information.

N/A Full access to the 
Department command 
on the Tools > 
Customize menu. The 
user can select the 
command to open the 
Customize 
Department dialog and 
customize department 
information such as 
the structure and shift 
schedule. This should 
be reserved for system 
administrators.
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Menu, Tools, 
Customize, Hydrants

No access to the 
Hydrants command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from opening 
the Customize 
Hydrants dialog and 
modifying the Hydrant 
setup codes.

N/A Full access to the 
Hydrants command on 
the Tools > Customize 
menu. The user can 
select the command to 
open the Customize 
Hydrants dialog and 
modify the Hydrant 
setup codes. This 
should be reserved for 
system administrators.

Menu, Tools, 
Customize, Incidents

No access to the 
Incidents command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from opening 
the Customize 
Incidents dialog and 
modifying the Incident 
setup codes.

N/A Full access to the 
Incidents command on 
the Tools > Customize 
menu. The user can 
select the command to 
open the Customize 
Incidents dialog and 
modify the incident 
setup codes. This 
should be reserved for 
system administrators.

Menu, Tools, 
Customize, Incidents, 
Customize

No access to the 
Customize Incidents 
menu item on the 
Tools>Customize>Inc
idents menu. These 
settings include 
Incident Billing, Aid 
Given Codes, and 
Incident Defaults.

N/A Access to the 
Customize Incidents 
menu item on the 
Tools>Customize>Inc
idents menu.
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Menu, Tools, 
Customize, EMS 
Trans

No access to the EMS 
Translation Codes 
command on the Tools 
> Customize > 
Incidents menu. The 
command is dimmed 
to prevent the user 
from mapping your 
EMS codes to those of 
another agency to 
whom you submit 
EMS data.

N/A Full access to the EMS 
Translation Codes 
command on the Tools 
> Customize > 
Incidents menu. The 
user can select the 
command to map your 
EMS codes to those of 
another agency to 
whom you submit 
EMS data.

Menu, Tools, 
Customize, LOSAP 

Prevents the user from 
accessing the LOSAP 
setup form.

N/A Allows a user full 
access to the LOSAP 
configuration form 
available under Tools, 
Customize, LOSAP.

Menu, Tools, 
Customize, Mobile 

Prevents a user from 
accessing the 
Customize Mobile 
form.

N/A Allows full access to 
the Customize Mobile 
form. 
Note: You must be 
setup for mobile units 
in order to access this 
form.

Menu, Tools, 
Customize, Other 
Entries

No access to the Other 
Entries command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from 
customizing the 
information such as 
setup codes.

N/A Full access to the 
Other Entries 
command on the Tools 
> Customize menu. 
The user can select the 
command to open the 
Customize Other 
Entries dialog and 
modify the setup 
codes. This should be 
reserved for system 
administrators.
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Menu, Tools, 
Customize, 
Occupancies

Occupancies 
command on the Tools 
> Customize menu. 
The command is 
dimmed to prevent the 
user from opening the 
Customize 
Occupancies dialog 
and modifying the 
Occupancy setup 
codes.

Full access to the 
Occupancies 
command on the Tools 
> Customize menu. 
The user can select the 
command to open the 
Customize 
Occupancies dialog 
and modify the 
Occupancy setup 
codes. This should be 
reserved for system 
administrators.

Menu, Tools, 
Customize, Streets

No access to the 
Streets command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from opening 
the Customize Streets 
dialog and modifying 
the street entries.

N/A Full access to the 
Streets command on 
the Tools > Customize 
menu. The user can 
select the command to 
open the Customize 
Streets dialog and 
modify the street 
entries. This should be 
reserved for system 
administrators.
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Menu, Tools, 
Customize, Tab 
Control

No access to the Tab 
Control command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from 
customizing Incident 
and Advanced EMS 
tabs.

N/A Full access to the Tab 
Control command on 
the Tools > Customize 
menu. Selecting this 
command displays the 
Tab Control box. 
Users can customize 
Incident or Advanced 
EMS tabs. Users can 
change tab captions, 
select a different 
version of some tabs, 
make tabs invisible, or 
change the order of 
tabs.

Menu, Tools, 
Customize, Training

No access to the 
Training command on 
the Tools > Customize 
menu. The command 
is dimmed to prevent 
the user from 
accessing the Training 
setup options.

N/A Full access to the 
Training command on 
the Tools > Customize 
menu. You can select 
the command to 
access the Training 
setup options. This 
should be reserved for 
system administrators 
and training officers 
only.

Menu, Tools, 
Customize, Vehicles & 
Equipment

No access to the 
Vehicles & Equipment 
command on the Tools 
> Customize menu. 
The command is 
dimmed to prevent 
you from accessing 
the Vehicles and 
Equipment setup 
options.

N/A Full access to the 
Vehicles & Equipment 
command on the Tools 
> Customize menu. 
The user can select the 
command to access 
the Vehicles and 
Equipment setup 
options. This should 
be reserved for system 
administrators.
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Menu, Tools, Delete, 
Chemicals 

Prevents a user from 
deleting Chemicals 
from the Chemical 
Code list.

N/A Allows a user to delete 
Chemical codes from 
the Chemical code list.

Menu, Tools, Export No access to the 
Export command on 
the Tools menu. This 
command is dimmed 
to prevent you from 
performing incident or 
advanced EMS export.

N/A Full access to the 
Export command on 
the Tools menu. The 
user can select the 
command to perform 
incident or advanced 
EMS export.

Menu, Tools, Import No access to the 
Import command on 
the Tools menu. The 
command is dimmed 
to prevent you from 
importing files.

N/A Full access to the 
Import command on 
the Tools menu. The 
user can select the 
command to import 
files.

Menu, Tools, Incident 
Query Builder

No access to the 
Incident Query 
Builder command on 
the Tools menu. The 
command is dimmed 
to prevent the user 
from using the 
Incident Query 
Builder.

N/A Full access to the 
Incident Query 
Builder command on 
the Tools menu. The 
user can select the 
command to create 
incident queries and 
send the results to a 
Microsoft Excel 
spreadsheet as a pivot 
table.

Menu, Tools, Incident 
Run Query 

Prevents a user from 
running a previously 
created query.

N/A Allows a user to run 
previously created 
queries.
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Menu, Tools, User 
Pref, Admin, Push Att

Prevents a user from 
accessing the User 
Preference Option, 
‘Push Attachments’

N/A Push attachments to 
the mobile when 
closing out from the 
local core client. Note: 
this option must be 
used in conjunction 
with the new System 
Settings for the 
desired attachment 
types.

Mobile Form, Incident 
Number

Users cannot update 
the Incident Number 
when using a mobile 
FireRMS client. 

N/A Users can update the 
Incident Number 
when using a mobile 
FireRMS client.  
NOTE: When this 
security object is set to 
3 and the security 
object "Form, 
Incident, Number and 
Times" is set to 1 – No 
Access, the mobile 
users are able to 
update the Incident 
Number value (to 
match an Incident 
Number posted by 
CAD, for example), 
even though they are 
prevented from 
changing any Incident 
date/time values that 
would be posted by 
the CAD. 
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Mobile, New Incident Prevents creation of 
new incidents on a 
Mobile Unit.

N/A Allows creating new 
Incidents on a mobile 
unit when System 
Settings Mobile 
Preferences are set up 
to allow this action. 

Occupancy, Activities, 
Actions

No access to the 
Actions drop-down on 
the Occupancies, 
Activities tab. The 
drop-down is dimmed 
to prevent users from 
assigning actions to an 
occupancy.

Full access to the 
Actions drop-down on 
the Occupancies, 
Activities tab. Users 
can assign an action to 
an occupancy.

Occupancy, Activities, 
Findings

No access to the 
Findings tab. Findings 
are the list of findings 
that may result from 
an occupancy activity. 
The Finding tab and 
New Finding button 
are dimmed to prevent 
users from accessing 
Findings. These 
findings are added to 
look-up tables 
(drop-down lists, 
Explorers) in the 
Occupancies module.

N/A Full access to the 
Findings tab. Findings 
are the list of findings 
that may result from 
an occupancy activity. 
These findings are 
added to look-up 
tables (drop-down 
lists, Explorers) in the 
Occupancies module 
and can be selected by 
users who are entering 
the results of 
occupancy-related 
activities.

Occupancy, Activities, 
Delete 

Prevents a user from 
deleting activities in 
the Occupancy 
module.

N/A Full access allows user 
to delete activity 
records.
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Occupancy, Activities, 
Tab

No access to the 
Occupancy, Activities 
tab. Users cannot 
assign actions to 
occupancies or track 
completion.

Read Only access to 
the Occupancy 
Activities tab. 

Full access to the 
Occupancy Activities 
tab. Users can assign 
actions to occupancies 
and track them to 
completion.

Occupancy, 
Attachments, Delete 

Prevents the user from 
deleting attachments 
in the Occupancy 
module.

N/A Allows a user to delete 
attachments from the 
Occupancy module.

Occupancy, 
Attachments, Tab

No access to the 
Occupancy, 
Attachments tab. The 
tab is dimmed to 
prevent users from 
attaching files from 
other programs to an 
occupancy record.

Read Only access to 
the Occupancy 
Attachments tab. 

Full access to the 
Occupancy 
Attachments tab. 
Users can attach files 
from other programs, 
e.g., pictures, to an 
occupancy record. 

Occupancy, History, 
Create

No access to the 
Create History button 
on the Occupancy List 
tab. Users cannot 
create a history of any 
of the current 
occupancies.

N/A Full access to the 
Create History button 
on the Occupancy List 
tab. Users can create a 
history of the current 
occupancy and enter 
new occupancy data.

Occupancy, Letters, 
Delete Inspection 
Report

Prevents the user from 
deleting inspection 
reports created by 
mobile users and 
saved to the 
Occupancy Letters 
tab.

N/A Allows a user to delete 
inspection reports 
created by mobile 
users from the 
Occupancy letters tab.
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Occupancy, Letters, 
Tab

No access to 
Occupancy, Letters 
tab. The tab is dimmed 
to prevent users from 
creating letters for 
occupancies. 

Read Only access to 
the Occupancy Letters 
tab.

Full access to the 
Occupancy, Letters 
tab. Users can create 
letters pertaining to 
the occupancy. For 
example, an 
introductory letter to 
be sent to a new 
occupancy, describing 
an upcoming 
inspection.

Occupancy, List, 
Delete

No access to the 
Delete button on the 
List tab. The Delete 
button is dimmed to 
prevent users from 
deleting occupancies.

N/A Full access to the 
Delete button on the 
List tab. Users can 
delete occupancies 
from the list.

Occupancy, List, 
History

No access to the 
History radio button 
on the List tab. The 
History radio button is 
dimmed to prevent 
users from reviewing 
history records 
associated with an 
occupancy.

N/A Full access to the 
History radio button 
on the List tab. Users 
can review history 
records associated 
with an occupancy.

Occupancy, List, New No access to the New 
button on the List tab. 
The New button is 
dimmed to prevent 
users from creating 
occupancies.

N/A Full access to the New 
button on the List tab. 
Users can create new 
occupancies.
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Object 1 - No Access 2 - Limited Access 3 - Full Access
Access Rights Definitions     A-45



Occupancy, OccInfo, 
Basic

No access to the Basic 
Data tab on the 
Occupancy Info tab. 
The Basic Data tab is 
dimmed to prevent 
users from viewing/
changing the data.

Read Only access to 
the Occupancy Info 
Basic Data tab. 

Full access to the 
Basic Data tab on the 
Occupancy Info tab. 
Users can change the 
data on this tab.

Occupancy, OccInfo, 
Build

No access to the 
Building tab on the 
Occupancy Info tab. 
The Building tab is 
dimmed to prevent 
users from viewing/
changing the data.

Read Only access to 
the Occupancy Info 
Building Tab.

Full access to the 
Building tab on the 
Occupancy Info tab. 
Users can change the 
data on this tab.

Occupancy, OccInfo, 
Contacts

No access to the 
Contacts tab on the 
Occupancy Info tab. 
The Contacts tab is 
dimmed to prevent 
users from viewing/
changing the contact 
persons for the 
occupancy.

Read Only access to 
the Occupancy Info 
Contacts Tab.

Full access to the 
Contacts tab on the 
Occupancy Info tab. 
Users can change the 
data on this tab.

Occupancy, OccInfo, 
Hydrants

No access to the 
Hydrants tab on the 
Occupancy Info tab. 
The Hydrants tab is 
dimmed to prevent 
users from viewing/
changing the data.

Read Only access to 
the Occupancy Info 
Hydrants Tab.

Full access to the 
Hydrants tab on the 
Occupancy Info tab. 
Users can change the 
data on this tab.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Occupancy, OccInfo, 
Load

No access to the Occ 
Load tab on the 
Occupancy Info tab. 
This tab indicates the 
number of people that 
the occupancy can 
accommodate. The 
Occ Load tab is 
dimmed to prevent 
use.

Read Only access to 
the Occupancy Info 
Load Tab.

Full access to the Occ 
Load tab on the 
Occupancy Info tab. 
Users can change the 
data on this tab.

Occupancy, OccInfo, 
MBuild

No access to the More 
Building tab on the 
Occupancy Info tab. 
The More Building tab 
is dimmed to prevent 
users from viewing/
changing the data.

Read Only access to 
the Occupancy Info 
More Building Tab.

Full access to the 
More Building tab on 
the Occupancy Info 
tab. Users can change 
the data on this tab.

Occupancy, OccInfo, 
Tab

No access to the 
Occupancy Info tab. 
This tab is dimmed to 
prevent users from 
changing the 
occupancy 
information.

Read Only access to 
the Occupancy Info 
Tab and sub-tabs.

Full access to the 
Occupancy Info tab. 
Users can change the 
data on this tab, unless 
access is restricted on 
the sub-tabs.

Occupancy, PrevInfo, 
HazMat

No access to the 
HazMat tab on the 
Prevention Info tab. 
This tab is dimmed to 
prevent users from 
changing the HazMat 
information.

Read Only access to 
the Occupancy 
Prevention Info 
HazMat Tab.

Full access to the 
HazMat tab on the 
Prevention Info tab. 
Users can change the 
data on this tab.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Occupancy, PrevInfo, 
Loc

No access to the 
Locations & Other 
Info tab on the 
Prevention Info tab. 
This tab is dimmed to 
prevent users from 
changing the 
information.

Read Only access to 
the Occupancy 
Prevention Info 
Locations Tab.

Full access to the 
Locations tab on the 
Prevention Info tab. 
Users can change the 
data on this tab.

Occupancy, PrevInfo, 
Permits

No access to the 
Permits tab on the 
Prevention Info tab. 
This tab is dimmed to 
prevent users from 
changing the 
information.

Read Only access to 
the Occupancy 
Prevention Info 
Permits Tab.

Full access to the 
Permits tab on the 
Prevention Info tab. 
Users can change the 
data on this tab.

Occupancy, PrevInfo, 
Systems

No access to the 
Systems tab on the 
Prevention Info tab. 
This tab is dimmed to 
prevent users from 
changing the 
information.

Read Only access to 
the Occupancy 
Prevention Info 
Systems Tab.

Full access to the 
Systems tab on the 
Prevention Info tab. 
Users can change the 
data on this tab.

Occupancy, PrevInfo, 
Tab

No access to the 
Prevention Info tab. 
This tab is dimmed to 
prevent users from 
changing the 
information.

Read Only access to 
the Occupancy 
Prevention Info Tab 
and sub-tabs.

Full access to the 
Prevention Info tab. 
Users can change the 
data on this tab.

Occupancy, 
Schedules, Tab

No access to the 
Schedules tab. This 
tab is dimmed to 
prevent users from 
changing the 
information.

Read Only access to 
the Occupancy 
Recurring Schedule 
Tab.

Full access to the 
Schedules tab. Users 
can change the data on 
this tab.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
A-48     Appendix A: Tables of Field Values



FireRMS Administrator’s Guide
Reports, Occupancies No access to the 
Occupancy Reports. 
Users cannot create or 
print any Occupancy 
reports.

N/A Full access to the 
Occupancy Reports. 
Users can create and 
print reports.

System, Receive 
System Messages 

Prevents the user from 
receiving FYI or other 
messages sent through 
the System Messaging 
option.

N/A Allows the user to 
receive and view FYI 
or other messages sent 
through the System 
Messaging Option.

System, Send System 
Messages

Prevents the user from 
sending FYI or other 
messages through the 
System Messaging 
option.

N/A Allows the user to 
send FYI or other 
messages to the 
System Message list. 
Note, the option 
Centralize Requests 
must be enabled to 
send system messages.

Vehicles and 
Equipment, Activities, 
Delete   

Prevents the user from 
deleting activities in 
the Vehicles and 
Equipment module.

N/A Allows a user to delete 
activities from the 
Vehicles and 
Equipment module.

Vehicles and 
Equipment, Activities, 
Tab

Prevents a user from 
accessing the 
Activities tab in the 
Vehicles and 
Equipment module.

Provides read-only 
access to the activities 
tab in the Vehicles and 
Equipment module.

Provides full access to 
the Activities tab in 
the Vehicles and 
Equipment module.

Vehicles and 
Equipment, 
Attachments, Delete

Prevents the user from 
deleting attachments 
in the Vehicles and 
Equipment module.

N/A Allows a user to delete 
attachments from the 
Vehicles and 
Equipment module.

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Vehicles and 
Equipment, List, 
Delete 

Prevents the user from 
deleting existing 
Vehicle or Equipment 
records from the List 
form in that module.

N/A Allows the user to 
delete Vehicle or 
Equipment records 
from the List form in 
that module.

Vehicles and 
Equipment, Schedule, 
Tab

Prevents a user from 
accessing the 
Recurring Schedule 
tab in the Vehicle and 
Equipment module.

Provides read-only 
access to the 
Recurring Schedule 
tab in the Vehicle and 
Equipment module.

Allows a user full 
access to the 
Recurring Schedule 
tab in the Vehicle and 
Equipment module.

Form, Incident, Delete 
Apparatus 

No access to delete 
apparatus from an 
Incident. 

N/A Full access to delete 
apparatus from an 
Incident.

User defined tab 
access rights

If one or more User 
Defined Tabs exist, 
setting the security 
object for that tab to 1 
will prevent users in 
that security group 
from accessing the tab.

Read Only access to 
the specified User 
Defined Tab.

Full access to the User 
defined tab. 

Table A-1: Access Rights (Continued)

Object 1 - No Access 2 - Limited Access 3 - Full Access
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Appendix B:Example Department Structures

The diagrams in this Appendix guide you in defining your department structure in FireRMS. The 
relationships among Division, Battalion and Station depict associations among operational levels 
within your department. In many agencies, personnel are assigned to either a station or a specific 
apparatus or unit. This unit is then assigned to a station. The station can then be assigned to a 
battalion and each battalion to a division.

Large Agency
The department structure in the following example depicts a large agency. Division 1 contains two 
battalions. Each battalion has four stations. Each station has 1 to 3 apparatus. Each apparatus has 
from 1 to 4 personnel assigned to it. The numbered divisions are emergency response divisions. 
The named divisions, Training and Prevention, provide functional support.
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Moderate Agency
The following structure depicts a moderate-sized agency. Divisions separate functional groups 
within the department. Battalions are assigned to a single division.
     B-3



Small Agency
The following structure depicts a small agency. Smaller agencies may create a single division 
named Department and associate the stations and apparatus assignments with that single division, 
opting not to use battalions at all.
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Appendix C:Customizing Field Codes

The dialog boxes in FireRMS contain fields that include list boxes, drop-down list boxes, explorers, 
and finders. The values or “codes” that appear in these fields are associated with the category 
assigned to that list. You can modify the lists of codes in the dialog boxes by adding to or removing 
codes from the category. This is referred to as “code setup.”
The following Code types are available in FireRMS:

Department Codes - User-definable codes that do not adhere to NFIRS restrictions. 
Department codes can be used to define a broad range of department information such 
as Apparatus, Employee Status, Safety Equipment, and Vehicle Type.

901 Codes - Predefined NFIRS codes used for incident reporting, e.g., Aid Given or 
Received, and Cause of Injury.

Chemical Codes - Predefined codes that users can reference when entering Hazmat 
information. Users cannot modify these codes.

EMS Codes - Predefined set of codes for EMS incident reporting, e.g., Injury Type, 
and Medical History.

This appendix displays the dialog boxes with the fields you can modify. A table is displayed 
following each dialog box that contains:

The names of the fields you can customize
The dialog box/tab on which you can change codes in the Category
The name of the category with which the field is associated
A reference to the procedure you can follow to change the codes in the list

After modifying the codes for any of the lists, you must always close and restart FireRMS in order 
for the changes to take effect.
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Customizing Fields for the Tools/Customize 
Menu Commands

This section displays the dialog boxes with the fields you can customize for the FireRMS 
Customize commands.

Apparatus
When you click the Tools menu, then select Customize, followed by Apparatus, the Basic Info tab 
displays.

Table C-1: Apparatus Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type Department Codes 
tab of the Customize 
Codes dialog box

Apparatus or 
Resource Type

For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Cities
When you click the Tools menu, then select Customize, followed by Cities, the Cities tab displays. 
You can view the fields in Table C-2 in which you can modify the codes.

Assigned To Structure tab of the 
Customize 
Department dialog 
box

Division For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Agency Department Codes 
tab of the Customize 
Codes dialog box

Other Agencies For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-1: Apparatus Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-2: City Field

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

State/Province Department Codes 
tab of the Customize 
Codes dialog box

Apparatus or 
Resource Type

For information, see 
“Entering 
Department Codes” 
on page 3-10.
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City Numbers
When you click the Tools menu, then select Customize, followed by Cities, you can click the 
Numbers tab to customize the numbers you want to associate with a city. You can view the fields in 
Table C-3 in which you can modify the codes.

Table C-3: City Number Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

County Department Codes 
tab of the Customize 
Codes dialog box

Counties For information, see 
“Entering 
Department Codes” 
on page 3-10.

Agency Department Codes 
tab of the Customize 
Codes dialog box

Other Agencies For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Streets
When you click the Tools menu, then select Customize, followed by Cities, you can click the 
Streets tab to customize your streets. You can view the fields in Table C-4 in which you can modify 
the codes.

Table C-4: City and Street Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

City Customize Cities 
dialog box

City For information, see 
“Entering Cities” on 
page 3-25.

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Street Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Billing
When you click the Tools menu, then select Customize, and Incidents, followed by Customize 
Incidents, you can click the Incident Billing tab to set billing rates to be used by your agency's 
resources in response to incidents. You can view the fields in Table C-5 in which you can modify 
the codes.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-5: Incident Billing Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Item (for Code Type 
Apparatus)

Department Codes 
tab of the Customize 
Codes dialog box

Apparatus or 
Resource Type

For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-4: City and Street Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

C t i I id t /I id t Billi
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Item (for Code Type 
Personnel)

Department Codes 
tab of the Customize 
Codes dialog box

Positions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-5: Incident Billing Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Aid Given Codes
When you click the Tools menu, then select Customize, and Incidents, followed by Customize 
Incidents, you can click the Aid Given Codes tab to select forms for Aid Given Codes to be 
completed in the Advanced EMS section of incident reports.

You can customize different fields on this dialog box, depending on what you select from the Type 
drop-down list box. You can view the fields in Table C-6 in which you can modify the codes.

Table C-6:  Incident Aid Given Codes Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

N/A Aid Given Medical Actions For information, see 
“Entering EMS 
Codes” on page 3-14.

Delivery Presentations
Complications
Gender

Presentation
Complications
Delivery Gender

For information, see 
“Entering EMS 
Codes” on page 3-14.

EKG Rhythm
Ectopy

Cardiac Rhythm
Ectopy

For information, see 
“Entering EMS 
Codes” on page 3-14.
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IV Solution
Rate

IV Solutions
IV Rate

For information, see 
“Entering EMS 
Codes” on page 3-14.

Medication Type
Route

Medication Types
Medication Route

For information, see 
“Entering EMS 
Codes” on page 3-14.

Oxygen Route Oxygen Route For information, see 
“Entering EMS 
Codes” on page 3-14.

Physical Location Temperature 
Location

For information, see 
“Entering EMS 
Codes” on page 3-14.

Vitals Skin
Pupil Left
Pupil Right
Position

Vital Signs Skin
Pupils
Pupils
Vital Signs Position

For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-6:  Incident Aid Given Codes Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Training
Using the Training module, you can create a list of training credentials, create objectives and skills, 
or create or modify training classes.

Training Credentials
When you click the Tools menu, then select Customize, and Training, followed by Credentials, and 
the Requirements tab, you can create a list of credentials related to your training classes. 
Credentials are used to measure a person's progress towards a particular goal, such as a 
certification. You can view the fields in Table C-7 in which you can modify the codes.

               

Table C-7:  Training Credential Customizable Fields 

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes

Identification 901 Codes
EMS Codes

Actions Taken
Aid Given

Actions Taken
Medical Actions

For information, 
see 
“Customizing 
Codes” on page 
3-10.
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Training Objectives/Skills
After selecting the Tools menu, then Customize, and Training, followed by Objectives/Skills, you 
can click the Data Entry tab and then the Results tab to define the firefighter's role in the agency 
and to demonstrate an ability, such as properly placing a ground ladder. You can view the fields in 
Table C-8 in which you can modify the codes.

Initial 
(Category/
Class)

Class Explorer 
Default Results
Class Explorer 
Default Results
Class Explorer 
Default Results

with a minimum 
__
with a “Y” for 
__
Accumulate__w
ithin

N/A
N/A
N/A

For information, 
see  “Setting Up 
the Class 
Explorer Default 
Results.”

Initial 
(Objective/Skill)

Objective 
Explorer Default 
Results
Objective 
Explorer Default 
Results
Objective 
Explorer Default 
Results

with a minimum 
__
with a “Y” for 
__
Accumulate__w
ithin

N/A
N/A
N/A

For information, 
see  “Setting Up 
the Objective 
Explorer Default 
Results.”

Table C-7:  Training Credential Customizable Fields (Continued)

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes
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Table C-8: Training Objective/Skills Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Default Result 1
Default Result 2
Default Result 3

Objective Explorer 
Default tab of the 
Customize Training 
dialog box

Default Result 1
Default Result 2
Default Result 3

For information, see 
“Setting Up the 
Objective Explorer 
Default Results” on 
page 4-45.
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Training Classes
When you click the Tools menu, then select Customize, and Training, followed by Classes, you can 
customize different fields on this dialog box, depending on the tabs you select. You can view the 
fields in Table C-9 in which you can modify the codes.

Table C-9:  Training Class Customizable Fields 

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes

Defaults Structure
Department 
Codes
Department 
Codes
Department 
Codes

Station
Other
Method
Providers

N/A
Other Training 
Locations
Training 
Methods
Training 
Providers

For information, 
see “Entering 
Department 
Codes” on page 
3-10.

Results Class Explorer 
Default Results
Class Explorer 
Default Results
Class Explorer 
Default Results

Default Result 1
Default Result 2
Default Result 3

Default Result 1
Default Result 2
Default Result 3

For information, 
see “Setting Up 
the Class 
Explorer Default 
Results” on 
page 4-44.
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Objective/Skills Objective 
Explorer Default 
Results
Objective 
Explorer Default 
Results
Objective 
Explorer Default 
Results

Default Result 1
Default Result 2
Default Result 3

Default Result 1
Default Result 2
Default Result 3

For information, 
see “Setting Up 
the Objective 
Explorer Default 
Results” on 
page 4-45.

Table C-9:  Training Class Customizable Fields (Continued)

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes
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Occupancies
After selecting Occupancies on the Customize menu, you can click the Findings tab to create a list 
of findings that may result from an occupancy activity. The fields you can customize depend on the 
tab you select. You can view the fields in Table C-10 in which you can modify the codes.

Table C-10:  Occupancy Findings Customizable Fields 

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes

Findings/
Standards

Standards Standard N/A For information, 
see “Creating a 
List of 
Occupancy 
Findings” on 
page 4-8.
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Hydrants
When you click the Tools menu, then select Customize, followed by Hydrants, you can click the 
Assignments tab to identify staff available you can assign to hydrant activities. You can view the 
fields in Table C-11 in which you can modify the codes.

Assignments Customize 
Department, 
Structure tab

Customize 
Apparatus, 
Basic Info tab

Customize 
Department, 
Shifts tab

Location
Apparatus
Shift

N/A
N/A
N/A

For information, 
see “Entering 
Basic 
Department 
Information” on 
page 3-1.
For information, 
see “Adding 
Apparatus and 
Staffing 
Apparatus” on 
page 3-18.
For information, 
see “Entering 
Department 
Shift Patterns” 
on page 3-6.

Table C-10:  Occupancy Findings Customizable Fields (Continued)

Tab Type Customizable 
Field

Category You 
Can 
Customize

Procedure To 
Modify The 
Codes
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Table C-11:  Hydrant Assignment Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Apparatus Default Result text 
boxes

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Shift Default Result text 
boxes

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Name Personnel 
Information List tab

N/A For information, see 
“Adding Personnel” 
on page 3-21.

C i H d A i
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Vehicles and Equipment
When you click the Tools menu, then select Customize, followed by Vehicles Equipment & 
Locations, you can click the Assignments tab to create a list of staff and positions available for 
assignment to actions in the Vehicles & Equipment module. You can view the fields in Table C-12 
in which you can modify the codes.
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Locations

Tab Creator
When you click the Tools menu, then select Customize, followed by Tab Creator, you can create 
your own customized tabs containing labels, text boxes, combo boxes, check boxes, date/time 
fields, or reports. You can define the items you can choose from the combo boxes. You can view the 
fields in Table C-13 in which you can modify the codes.

Table C-12:  V&E Assignment Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Apparatus Default Result text 
boxes

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Shift Default Result text 
boxes

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Person Personnel 
Information List tab

N/A For information, see 
“Adding Personnel” 
on page 3-21.
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Table C-13:  Tab Creator Custom table

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Combo Box Department Codes 
tab of the Customize 
Codes dialog box

<ADD NEW> For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Customizing Fields for Incident, 
Training, Other Entries and Daybook Forms

This section describes the fields you can modify on the forms associated with the four main 
FireRMS tabs. These tabs include: Incidents, Training, Other Entries, and Daybook.

Incidents Form
This section describes the fields on the Incident form that you can customize.

Response Time
When you click the Basic tab, followed by the Response tab, you can view the fields in Table C-14 
in which you can modify the codes. On the Response tab, you can set a response time threshold for 
incident response. When the first unit arrival time exceeds the response time threshold, the 
response Time label on the Incident Form's Response sub-tab is displayed in Red.
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Table C-14:  Incidents Response Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type 901 Codes tab of the 
Customize Codes 
dialog box

Incident Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Shift Shifts tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Mutual Aid 901 Codes tab of the 
Customize Codes 
dialog box

Aid Given or 
Received

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Actions Taken 901 Codes tab of the 
Customize Codes 
dialog box

Actions Taken For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Detector 901 Codes tab of the 
Customize Codes 
dialog box

Detector Alerted 
Occupants

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Locations
When you click the Basic tab, followed by the Location tab, you can view the fields in Table C-15 
in which you can modify the codes. On the Location tab, you can record information about where 
an incident occurred.

Hazardous Materials 
Released

901 Codes tab of the 
Customize Codes 
dialog box

Hazardous Materials 
Released

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Incident Delay Department Codes 
tab of the Customize 
Codes dialog box

Incident Delay For information, see 
“Entering 
Department Codes” 
on page 3-10.

Incident Reported By Department Codes 
tab of the Customize 
Codes dialog box

Incident Reports By For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-14:  Incidents Response Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-15:  Incidents Location Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department 
Codes tab of the 
Customize Codes 
dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Direction 901 Codes tab of the 
Customize Codes 
dialog box

Direction For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Subsection Department Codes 
tab of the Customize 
Codes dialog box

Subsection For information, see 
“Entering 
Department Codes” 
on page 3-10.

Meridian 901 Codes tab of the 
Customize Codes 
dialog box

Meridian For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-15:  Incidents Location Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Persons Involved

When you click the Basic tab, followed by the Persons Involved tab, you can view the fields in 
Table C-16 in which you can modify the codes. On the Persons Involved tab, you can identify the 
Persons and entities involved in an incident.

.

Table C-16:  Incidents Persons Involved Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Province For information, see 
“Entering 
Department Codes” 
on page 3-10.

Other Involvement Department Codes 
tab of the Customize 
Codes dialog box

Incident Involvement 
Types

For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-16:  Incidents Persons Involved Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Highway

When you click the Basic tab, followed by the Highway tab, you can view the fields in Table C-17 
in which you can modify the codes. On the Highway tab, you can identify the investigating police 
force, cause of emergency, obstruction, and location of emergency.

Table C-17: Incidents Highway Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Investigating Police 
Force

Department Codes 
tab of the Customize 
Codes dialog box

Other For information, see 
“Entering 
Department Codes” 
on page 3-10.

Cause of Emergency Department Codes 
tab of the Customize 
Codes dialog box

Other For information, see 
“Entering 
Department Codes” 
on page 3-10.

Location of 
Emergency

Department Codes 
tab of the Customize 
Codes dialog box

Other For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Aircraft Involved
When you click the Basic tab, followed by the Aircraft Involved tab, you can view the fields in 
Table C-18 in which you can modify the codes. On the Aircraft Involved tab, you can identify the 
aircraft that was damaged, destroyed, or otherwise damaged in an incident.

Obstruction Department Codes 
tab of the Customize 
Codes dialog box

Other For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-17: Incidents Highway Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-18:  Incidents Aircraft Involved Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Use 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft use For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Fuel Type 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft fuel type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Engine Type 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft engine type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Area of Origin 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft area of fire 
origin

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Alert Type 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft alert type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Actions Taken 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft actions taken For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Problem Areas 901 Codes tab of the 
Customize Codes 
dialog box

Aircraft problem 
areas

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Resources
When you click the Resources tab, you can add codes to the fields in three sub-tabs; Apparatus, 
Personnel, and Summary.

On the Apparatus tab, you can identify the units that responded to an incident. You can add codes to 
the fields in Table C-19. 

Table C-19:  Incidents Apparatus Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Actions Taken 901 Codes tab of the 
Customize Codes 
dialog box

Actions Taken For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type 901 Codes tab of the 
Customize Codes 
dialog box

Apparatus or 
Resource Type

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Dispatch Type EMS Codes tab of 
the Customize Codes 
dialog box

Dispatch Type For information, see 
“Entering EMS 
Codes” on page 3-14.
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On the Personnel tab, you can identify the fire staff from your department who responded to an 
incident. You can add codes to the fields in Table C-20. 

Alarms Department Codes of 
the Customize Codes 
dialog box

Alarms For information, see 
“Entering 
Department Codes” 
on page 3-10.

App Delay Department Codes of 
the Customize Codes 
dialog box

Apparatus Delay For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-19:  Incidents Apparatus Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Fire
When you click the Fire tab, followed by the Property & Ignition tab, you can view the fields in 
Table C-21 in which you can modify the codes. On the Property & Ignition tab, you can enter 
details about property damaged by a fire and identify factors that contributed to the fire's ignition.

Table C-20:  Incidents Personnel Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Actions Taken 901 Codes tab of the 
Customize Codes 
dialog box

Actions Taken For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.

Role 901 Codes tab of the 
Customize Codes 
dialog box

Usual Assignment For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Position in Vehicle 901 Codes tab of the 
Customize Codes 
dialog box

Additional Role For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Table C-21:  Incidents Property & Ignition Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Structure Type 901 Codes tab of the 
Customize Codes 
dialog box

Structure Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Cause 901 Codes tab of the 
Customize Codes 
dialog box

Cause of Ignition For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Area of Origin 901 Codes tab of the 
Customize Codes 
dialog box

Area of Fire Origin 
or Specific Location 
at Time of Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Heat Source 901 Codes tab of the 
Customize Codes 
dialog box

Heat Source For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-35



When you click the Fire tab, followed by the Involved tab, you can view the fields in Table C-23 in 
which you can modify the codes. On the Involved tab, you can identify factors involved in the 
ignition of the fire.

Item 901 Codes tab of the 
Customize Codes 
dialog box

Item First Ignited or 
Contributing Most to 
Flame Spread

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type of Material 901 Codes tab of the 
Customize Codes 
dialog box

Type of Material 
First Ignited or 
Contributed Most to 
Flame

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Factors Contributing 
to Ignition

901 Codes tab of the 
Customize Codes 
dialog box

Factors Contributing 
to Ignition

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

On-Site Materials or 
Products

901 Codes tab of the 
Customize Codes 
dialog box

On-site Materials For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Roof Covering Type Department Codes 
tab of the Customize 
Codes dialog box

Roof Covering Type For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-21:  Incidents Property & Ignition Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-22:  Incidents Involved Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type (Equipment 
Involved in Ignition)

901 Codes tab of the 
Customize Codes 
dialog box

Equipment Involved 
in Ignition or 
Equipment Involved 
in Release

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Portability 901 Codes tab of the 
Customize Codes 
dialog box

Equipment 
Portability

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Power 901 Codes tab of the 
Customize Codes 
dialog box

Equipment Power 
Source

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Customize Incidents/Fire/Involved
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Structure
When you click the Structure tab, followed by the Description & Damage tab, you can view the 
fields in Table C-23 in which you can modify the codes. On the Description & Damage tab, you can 
describe the damage caused by a building fire.

Fire Suppression 
Factors

901 Codes tab of the 
Customize Codes 
dialog box

Fire Suppression 
Factors

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Mobile 
Property Involved in 
Ignition)

901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Type

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ignition 901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Involved

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Make 901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Make

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

State 901 Codes tab of the 
Customize Codes 
dialog box

States & Provinces For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-22:  Incidents Involved Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-23:  Incidents Structure Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Building Status 901 Codes tab of the 
Customize Codes 
dialog box

Building Status For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Fire Spread 901 Codes tab of the 
Customize Codes 
dialog box

Fire Spread For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Item 901 Codes tab of the 
Customize Codes 
dialog box

Item First Ignited or 
Contributing Most To 
Flame Spread

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Structure tab, followed by the Systems tab, you can view the fields in Table 
C-24 in which you can modify the codes. On the Systems tab, you can identify any detectors and 
extinguishment systems that were present in the origin of the fire.

Material 901 Codes tab of the 
Customize Codes 
dialog box

Type Of Material 
First Ignited Or 
Contributed Most To 
Flame

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-23:  Incidents Structure Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-24:  Incidents Structure Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type (Detectors) 901 Codes tab of the 
Customize Codes 
dialog box

Detector Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Power Supply 901 Codes tab of the 
Customize Codes 
dialog box

Detector Power 
Supply

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Operation 
(Detectors)

901 Codes tab of the 
Customize Codes 
dialog box

Detector Operation For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Effectiveness 901 Codes tab of the 
Customize Codes 
dialog box

Detector 
Effectiveness

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Failure Reason 
(Detectors)

901 Codes tab of the 
Customize Codes 
dialog box

Detector Failure 
Reason

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Automatic 
Extinguishment 
System)

901 Codes tab of the 
Customize Codes 
dialog box

Type of Automatic 
Extinguishing 
System

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Operation 
(Automatic 
Extinguishment 
System)

901 Codes tab of the 
Customize Codes 
dialog box

Operation of 
Automatic 
Extinguishing 
System

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Failure Reason 
(Automatic 
Extinguishment 
System)

901 Codes tab of the 
Customize Codes 
dialog box

Reason System Not 
Effective

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-24:  Incidents Structure Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Hazmat
When you click the Hazmat tab, followed by the Release tab, you can view the fields in Table C-25 
in which you can modify the codes. On the Release tab, you can describe the conditions of a 
hazardous materials release and the control efforts made.

Table C-25:  Incidents Hazmat Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Cause of Release 901 Codes tab of the 
Customize Codes 
dialog box

Cause of Release For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Factors Contributing 
To Release

901 Codes tab of the 
Customize Codes 
dialog box

Factors Contributing 
To Release

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Involved tab, you can view the fields in Table C-26 in which you can modify 
the codes. On the Involved tab, you can identify the equipment and mobile property in a hazardous 
materials release.

Mitigating Factors or 
Impediments

901 Codes tab of the 
Customize Codes 
dialog box

Factors Affecting 
Mitigation

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Hazmat Actions 
Taken

901 Codes tab of the 
Customize Codes 
dialog box

Hazmat Actions 
Taken

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Population Density 901 Codes tab of the 
Customize Codes 
dialog box

Population Density 
for Hazmat

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Units 901 Codes tab of the 
Customize Codes 
dialog box

Area Affected or 
Area Evacuated

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Which Occurred First 901 Codes tab of the 
Customize Codes 
dialog box

Fire or Explosion 
Involved in Release

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Disposition 901 Codes tab of the 
Customize Codes 
dialog box

Hazmat Disposition For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-25:  Incidents Hazmat Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
C-44     Appendix C: Customizing Field Codes



FireRMS Administrator’s Guide
Table C-26:  Incidents Involved Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type (Equipment 
Involved in Release)

901 Codes tab of the 
Customize Codes 
dialog box

Equipment Involved 
in Ignition or 
Equipment Involved 
in Release

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Mobile 
Property Involved in 
Release)

901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Type

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Make 901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Make

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Identification tab, you can view the fields in Table C-27 in which you can 
modify the codes. On the Identification tab, you can identify the hazardous materials involved in an 
incident.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, 
see “Entering 
Department Codes” 
on page 3-10.

Tier Level Department Codes 
tab of the Customize 
Codes dialog box

Tier Levels For information, 
see “Entering 
Department Codes” 
on page 3-10.

PPE/Suite Lvl Department Codes 
tab of the Customize 
Codes dialog box

Suite/PPE Levels For information, 
see “Entering 
Department Codes” 
on page 3-10.

Table C-26:  Incidents Involved Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-27:  Incidents ID Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

DOT Class 901 Codes tab of the 
Customize Codes 
dialog box

DOT Hazard 
Classification

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type 901 Codes tab of the 
Customize Codes 
dialog box

Container Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Units 901 Codes tab of the 
Customize Codes 
dialog box

Units Capacity or 
Units Released

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

C t i I id t /H t/Id tifi ti
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-47



When you click on the Responsible tab, you can view the field that can be customized. 

Physical State 901 Codes tab of the 
Customize Codes 
dialog box

Physical State For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Released Into 901 Codes tab of the 
Customize Codes 
dialog box

Released Into For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-27:  Incidents ID Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-28: Hazmat Responsible

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type Department Codes of 
the Customize Codes 
dialog box

Hazmat Agency 
Responding

For information, 
see “Entering 
Department Codes” 
on page 3-10.
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Arson
When you click the Arson tab, followed by the Investigation tab, you can view the fields in Table 
C-29 in which you can modify the codes. On the Investigation tab, you can record the details of an 
arson investigation related to an incident.

Table C-29:  Incidents Arson Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Case Status 901 Codes tab of the 
Customize Codes 
dialog box

Case Status For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Availability of 
Material First Ignited

901 Codes tab of the 
Customize Codes 
dialog box

Availability of 
Material First Ignited

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Suspected 
Motivation Factors

901 Codes tab of the 
Customize Codes 
dialog box

Suspected 
Motivation Factors

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Juvenile Firesetter tab, you can view the fields in Table C-30 in which you can 
modify the codes. On the Juvenile Firesetter tab, you can to identify juvenile suspects in an arson 
investigation.

Apparent Group 
Involvement

901 Codes tab of the 
Customize Codes 
dialog box

Apparent Group 
Involvement

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Entry Method 901 Codes tab of the 
Customize Codes 
dialog box

Entry Method For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Extent of Fire 
Involvement on 
Arrival

901 Codes tab of the 
Customize Codes 
dialog box

Extent of Fire 
Involvement

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Property Ownership 901 Codes tab of the 
Customize Codes 
dialog box

Property Ownership For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Container 901 Codes tab of the 
Customize Codes 
dialog box

Container for 
Incendiary Device

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ignition 901 Codes tab of the 
Customize Codes 
dialog box

Ignition/Delay 
Device for 
Incendiary Device

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Fuel 901 Codes tab of the 
Customize Codes 
dialog box

Fuel for Incendiary 
Device

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-29:  Incidents Arson Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-30:  Incidents Juvenile Firesetter Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Gender 901 Codes tab of the 
Customize Codes 
dialog box

Gender For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Race 901 Codes tab of the 
Customize Codes 
dialog box

Race For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ethnicity 901 Codes tab of the 
Customize Codes 
dialog box

Ethnicity For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Family Type 901 Codes tab of the 
Customize Codes 
dialog box

Family Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Referred To tab, you can view the fields in Table C-31 in which you can modify 
the codes. On the Referred To tab, you can identify investigators and outside agencies to which the 
arson incident was referred.

Disposition 901 Codes tab of the 
Customize Codes 
dialog box

Disposition For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Motivation/Risk 
Factors

901 Codes tab of the 
Customize Codes 
dialog box

Motivation/Risk 
Factors

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-30:  Incidents Juvenile Firesetter Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-53



Table C-31:  Incidents Referred To Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Casualty
When you click the Casualty tab, followed by the Fire Service tab, you can view the fields in Table 
C-32 in which you can modify the codes. On the Fire Service tab, you can identify firefighters who 
were injured or killed either as a result of the incident or during the mitigation of the incident. An 
injury is physical damage to a person that requires either (a) treatment by a practitioner of medicine 
within one year of the incident, or (b) at least one day of restricted activity immediately following 
the incident. Deaths include people who die within one year of the incident because of injuries 
sustained from the incident.

Table C-32:  Incidents Casualty Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Physical Condition 901 Codes tab of the 
Customize Codes 
dialog box

Physical Condition 
Just Prior To Injury

For information, 
see “Entering 901 
Sub-Codes” on page 
3-12.

Usual Assignment 901 Codes tab of the 
Customize Codes 
dialog box

Usual Assignment For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Fire Service Injury tab, you can view the fields in Table C-33 in which you can 
modify the codes. 

Activity at Time of 
Injury

901 Codes tab of the 
Customize Codes 
dialog box

Activity at Time of 
Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-32:  Incidents Casualty Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

C I d /C l /F S I
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Table C-33:  Incidents Fire Service Injury Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Severity 901 Codes tab of the 
Customize Codes 
dialog box

Severity (Loss Time) For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Primary Symptoms 901 Codes tab of the 
Customize Codes 
dialog box

Primary Apparent 
Symptom

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Area of Body 901 Codes tab of the 
Customize Codes 
dialog box

Primary Part of Body 
Injured

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Cause of Injury 901 Codes tab of the 
Customize Codes 
dialog box

Cause of Firefighter 
Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Factors Contributing 
to Injury

901 Codes tab of the 
Customize Codes 
dialog box

Factors Contributing 
to Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Object Involved 901 Codes tab of the 
Customize Codes 
dialog box

Object Involved in 
Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Where Injury 
Occurred

901 Codes tab of the 
Customize Codes 
dialog box

Where Injury 
Occurred

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-57



When you click the Protective Equipment tab, you can view the fields in Table C-34 in which you 
can modify the codes. On the Protective Equipment tab, you can identify equipment failures that 
contributed to an injury. Complete this section only if protective equipment failed and was a factor 
in the injury.

Specific Location 901 Codes tab of the 
Customize Codes 
dialog box

Specific Location 
Where Injury 
Occurred

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Taken To 901 Codes tab of the 
Customize Codes 
dialog box

Taken To For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Vehicle Type 901 Codes tab of the 
Customize Codes 
dialog box

Vehicle Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-33:  Incidents Fire Service Injury Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-34:  Incidents Protective Equipment Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Protective Equipment 901 Codes tab of the 
Customize Codes 
dialog box

Protective Equipment 
Item

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Protective Equipment 
Problem

901 Codes tab of the 
Customize Codes 
dialog box

Protective Equipment 
Problem

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Civilian tab, you can view the fields in Table C-35 in which you can modify the 
codes. On the Civilian tab, you can identify civilians who were injured or killed as a result of an 
incident. As with fire serviceicasualties, an injury is physical damage to a person that requires 
either (a) treatment by a practitioner of medicine within one year of the incident, or (b) at least one 
day of restricted activity immediately following the incident. Deaths include people who die within 
one year of the incident because of injuries sustained from the incident.

Table C-35:  Incidents Civilian Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Gender Department Codes 
tab of the Customize 
Codes dialog box

Gender For information, see 
“Entering 
Department Codes” 
on page 3-10.

Race 901 Codes tab of the 
Customize Codes 
dialog box

Race For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ethnicity 901 Codes tab of the 
Customize Codes 
dialog box

Ethnicity For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Affiliation 901 Codes tab of the 
Customize Codes 
dialog box

Affiliation For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-35:  Incidents Civilian Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Civilian Injury tab, followed by the Fire Service tab, you can view the fields in 
Table C-36 in which you can modify the codes. On the Civilian Injury tab, you can enter details of 
a civilian casualty. Civilians include emergency personnel who are not members of the fire 
department, such as police officers or utility workers.

Table C-36:  Incidents Fire Service Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Cause of Injury 901 Codes tab of the 
Customize Codes 
dialog box

Cause of Injury For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Activity When 
Injured

901 Codes tab of the 
Customize Codes 
dialog box

Activity When 
Injured

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Primary Symptom 901 Codes tab of the 
Customize Codes 
dialog box

Primary Apparent 
Symptom

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Factors Contributing 
to Injury

901 Codes tab of the 
Customize Codes 
dialog box

Factors Contributing 
to Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Severity 901 Codes tab of the 
Customize Codes 
dialog box

Severity For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Area of Body 901 Codes tab of the 
Customize Codes 
dialog box

Body Site of Injury For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Location at Time of 
Injury

901 Codes tab of the 
Customize Codes 
dialog box

Location For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

General Location at 
Time of Injury

901 Codes tab of the 
Customize Codes 
dialog box

General Location at 
Time of Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Specific Location 901 Codes tab of the 
Customize Codes 
dialog box

Specific Location 
Where Injury 
Occurred

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-36:  Incidents Fire Service Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Advanced EMS
When you click the Advanced EMS tab, followed by the Scene tab, you can view the fields in Table 
C-37 in which you can modify the codes. On the Scene tab, you can to describe the scene of an 
incident where emergency medical services were provided.

Table C-37  Incidents Scene Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

MCI EMS Codes tab of 
the Customize Codes 
dialog box

Consulting Facility 
ID

For information, see 
“Entering EMS 
Codes” on page 3-14.

Location EMS Codes tab of 
the Customize Codes 
dialog box

Location Type For information, see 
“Entering EMS 
Codes” on page 3-14.
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When you click the Patient Info tab, you can view the fields in Table C-38 in which you can modify 
the codes. On the Patient Info tab, you can create a record for each patient who received EMS 
services at an incident.

Service Type EMS Codes tab of 
the Customize Codes 
dialog box

Service Type For information, see 
“Entering EMS 
Codes” on page 3-14.

Area EMS Codes tab of 
the Customize Codes 
dialog box

Area Type For information, see 
“Entering EMS 
Codes” on page 3-14.

Response Mode EMS Codes tab of 
the Customize Codes 
dialog box

Response & 
Transport Mode

For information, see 
“Entering EMS 
Codes” on page 3-14.

Special Factors EMS Codes tab of 
the Customize Codes 
dialog box

Special Factors For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-37  Incidents Scene Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-38:  Incidents Patient Info Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Title 901 Codes tab of the 
Customize Codes 
dialog box

Name Prefix For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Suffix (Address) Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Gender 901 Codes tab of the 
Customize Codes 
dialog box

Gender For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Race 901 Codes tab of the 
Customize Codes 
dialog box

Race For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ethnicity 901 Codes tab of the 
Customize Codes 
dialog box

Ethnicity For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Code EMS Codes tab of 
the Customize Codes 
dialog box

Chief Complaint For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-38:  Incidents Patient Info Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the History tab, you can view the fields in Table C-39 in which you can modify the 
codes. On the History tab, you can create a profile for an EMS patient.

Table C-39:  Incidents History Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Signs & Symptoms EMS Codes tab of 
the Customize Codes 
dialog box

Symptoms For information, see 
“Entering EMS 
Codes” on page 3-14.

Past Medical History EMS tab of the 
Customize Codes 
dialog box

Medical History For information, see 
“Entering EMS 
Codes” on page 3-14.

Provider Impression/
Assessment

901 Codes tab of the 
Customize Codes 
dialog box

Provider Impression 
Assessment

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Assessment tab, you can view the fields in Table C-40 in which you can modify 
the codes. On the Assessment tab, you can enter an assessment of the patient's relevant systems 
based on the EMS provider's observations.

Cause of Illness/
Injury

901 Codes tab of the 
Customize Codes 
dialog box

Cause of Illness/
Injury

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Severity EMS Codes tab of 
the Customize Codes 
dialog box

Severity For information, see 
“Entering EMS 
Codes” on page 3-14.

Pregnancy EMS Codes tab of 
the Customize Codes 
dialog box

Pregnancy For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-39:  Incidents History Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-40:  Incidents Assessment Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

HEENT EMS Codes tab of 
the Customize Codes 
dialog box

HEENT Assessment 
(1)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Lungs/Respiration EMS Codes tab of 
the Customize Codes 
dialog box

Lungs/Respiration 
Assessment (2)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Abdomen/Pelvis EMS Codes tab of 
the Customize Codes 
dialog box

Abdomen/Pelvis 
Assessment (3)

For information, see 
“Entering EMS 
Codes” on page 3-14.
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When you click the Flow Chart tab, you can view the field listed in Table C-41 in which you can 
modify the codes. On the Flow Chart tab, you can create a patient care history by recording each 
event (step or phase) in an EMS patient's treatment. 

Extremities EMS Codes tab of 
the Customize Codes 
dialog box

Extremities 
Assessment (4)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Spine/Back EMS Codes tab of 
the Customize Codes 
dialog box

Spine/Back 
Assessment (5)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Skin EMS Codes tab of 
the Customize Codes 
dialog box

Skin Assessment (6) For information, see 
“Entering EMS 
Codes” on page 3-14.

Neurological EMS Codes tab of 
the Customize Codes 
dialog box

Neurological (7) For information, see 
“Entering EMS 
Codes” on page 3-14.

Cardiac EMS Codes tab of 
the Customize Codes 
dialog box

Cardiac Assessment 
(8)

For information, see 
“Entering EMS 
Codes” on page 3-14.

GI/GU EMS Codes tab of 
the Customize Codes 
dialog box

GI/GU Assessment 
(9)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Chest EMS Codes tab of 
the Customize Codes 
dialog box

Chest Assessment 
(10)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Obvious Death EMS Codes tab of 
the Customize Codes 
dialog box

Obvious Death 
Assessment (11)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-40:  Incidents Assessment Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Trauma tab, you can view the fields in Table C-42 in which you can modify the 
codes. On the Trauma tab, you can record the details of an EMS patient’s injuries.

Table C-41:  Incidents Flow Chart Customizable Fields 

Type Customizable 
Field

Category You Can 
Customize

Procedure To 
Modify The Codes

N/A Aid Given Medical Actions For information, see 
“Entering EMS 
Codes” on page 3-14.

C I d /Ad d EMS/Fl Ch
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Table C-42:  Incidents Trauma Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Triage Criteria EMS Codes tab of 
the Customize Codes 
dialog box

Triage Criteria For information, see 
“Entering EMS 
Codes” on page 3-14.

12 - Bleeding EMS Codes tab of 
the Customize Codes 
dialog box

Bleeding Assessment 
(12)

For information, see 
“Entering EMS 
Codes” on page 3-14.

Body Site EMS Codes tab of 
the Customize Codes 
dialog box

Trauma Body Site of 
Injury

For information, see 
“Entering EMS 
Codes” on page 3-14.

d / d d /
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When you click the CPR tab, you can view the fields in Table C-43 in which you can modify the 
codes. On the CPR tab, you can describe the CPR care provided to the patient.

Injury Type EMS Codes tab of 
the Customize Codes 
dialog box

Injury Type For information, see 
“Entering EMS 
Codes” on page 3-14.

Location EMS Codes tab of 
the Customize Codes 
dialog box

Trauma Injury 
Location

For information, see 
“Entering EMS 
Codes” on page 3-14.

Severity EMS Codes tab of 
the Customize Codes 
dialog box

Trauma Injury 
Severity

For information, see 
“Entering EMS 
Codes” on page 3-14.

Injury Intent EMS Codes tab of 
the Customize Codes 
dialog box

Injury Intent For information, see 
“Entering EMS 
Codes” on page 3-14.

Table C-42:  Incidents Trauma Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-43:  Incidents CPR Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Provider EMS Codes tab of 
the Customize Codes 
dialog box

Provider of First CPR For information, see 
“Entering EMS 
Codes” on page 3-14.

Pre/Post Arrival 
Arrest

901 Codes tab of the 
Customize Codes 
dialog box

Cardiac Arrest For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Pre/Post Arrival 
Arrest Details

901 Codes tab of the 
Customize Codes 
dialog box

Pre-Arrival Arrest 
Details

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Accident tab, you can view the fields in Table C-44 in which you can modify 
the codes. On the Accident tab, you can describe EMS services given to a patient involved in a 
vehicle accident.

Initial Arrest Rhythm 901 Codes tab of the 
Customize Codes 
dialog box

Initial Arrest Rhythm For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Rhythm at 
Destination

901 Codes tab of the 
Customize Codes 
dialog box

Initial Arrest Rhythm For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-43:  Incidents CPR Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-44:  Incidents Accident Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Safety Device EMS Codes tab of 
the Customize Codes 
dialog box

Safety Devices For information, see 
“Entering EMS 
Codes” on page 3-14.

Involved/In On EMS Codes tab of 
the Customize Codes 
dialog box

Vehicle Involvement For information, see 
“Entering EMS 
Codes” on page 3-14.

Involved With EMS Codes tab of 
the Customize Codes 
dialog box

Vehicle Involvement For information, see 
“Entering EMS 
Codes” on page 3-14.

Location Re: Vehicle EMS Codes tab of 
the Customize Codes 
dialog box

Location in Vehicle For information, see 
“Entering EMS 
Codes” on page 3-14.

Path EMS Codes tab of 
the Customize Codes 
dialog box

Ejection Path For information, see 
“Entering EMS 
Codes” on page 3-14.

Condition of 
Windshield

EMS Codes tab of 
the Customize Codes 
dialog box

Condition of 
Windshield

For information, see 
“Entering EMS 
Codes” on page 3-14.

Condition of Steering 
Wheel

EMS Codes tab of 
the Customize Codes 
dialog box

Condition of Steering 
Wheel

For information, see 
“Entering EMS 
Codes” on page 3-14.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.
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When you click the OB/GYN tab, you can view the fields in Table C-45 in which you can modify 
the codes. On the OB/GYN tab, you can enter details of the EMS provided to pregnant patients 
during an incident.

Table C-45:  Incidents OB/GYN Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Discharge EMS Codes tab of 
the Customize Codes 
dialog box

Discharge For information, see 
“Entering EMS 
Codes” on page 3-14.

Bag of Water EMS Codes tab of 
the Customize Codes 
dialog box

Bag of Water For information, see 
“Entering EMS 
Codes” on page 3-14.
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When you click the Other tab, you can view the fields in Table C-46 in which you can modify the 
codes. On the Other tab, you can identify the transporting unit, care facility, and patient disposition 
for an EMS incident.

Table C-46:  Incidents Other Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Treatment 
Authorization

EMS Codes tab of 
the Customize Codes 
dialog box

Treatment 
Authorization

For information, see 
“Entering EMS 
Codes” on page 3-14.

Facility (Medical 
Consult)

EMS Codes tab of 
the Customize Codes 
dialog box

Facility Type For information, see 
“Entering EMS 
Codes” on page 3-14.

Method EMS Codes tab of 
the Customize Codes 
dialog box

Consult Method For information, see 
“Entering EMS 
Codes” on page 3-14.
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Initial 901 Codes tab of the 
Customize Codes 
dialog box

Initial Level of 
Provider

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Highest 901 Codes tab of the 
Customize Codes 
dialog box

Highest Level of 
Provider on Scene

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Originating Facility Department Codes 
tab of the Customize 
Codes dialog box

Medical Facilities For information, see 
“Entering 
Department Codes” 
on page 3-10.

Facility (Receiving 
Facility)

Department Codes 
tab of the Customize 
Codes dialog box

Medical Facilities For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type EMS Codes tab of 
the Customize Codes 
dialog box

Facility Type For information, see 
“Entering EMS 
Codes” on page 3-14.

Hospital Chosen By EMS Codes tab of 
the Customize Codes 
dialog box

Destination Selection For information, see 
“Entering EMS 
Codes” on page 3-14.

Disposition 901 Codes tab of the 
Customize Codes 
dialog box

Disposition For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Status 901 Codes tab of the 
Customize Codes 
dialog box

Status For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-46:  Incidents Other Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Billing tab, you can view the fields in Table C-47 in which you can modify the 
codes. On the Billing tab, you can identify the guarantor in an EMS incident. Even if the guarantor 
is the same as the patient you should complete this tab.

When you click the Narrative tab, you can view the fields in Table C-48 in which you can modify 
the codes. On the Narrative tab, you can summarize a patient’s EMS treatment.

Table C-47:  Incidents Billing Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Patient’s Relation to 
Guarantor

EMS Codes tab of 
the Customize Codes 
dialog box

Patient’s Relation to 
Guarantor

For information, see 
“Entering EMS 
Codes” on page 3-14.

Title 901 Codes tab of the 
Customize Codes 
dialog box

Name Prefix For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Prefix Department Codes 
tab of the Customize 
Department dialog 
box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Department dialog 
box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix (Address) Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-81



When you click the Disclosures tab, you can view the fields in Table C-49 in which you can modify 
the codes. On the Disclosures tab, you select a patient’s Disclosure and obtain signatures.

Wildland
When you click the Wildland tab, followed by the Cause & Factors tab, you can view the fields in 
Table C-50 in which you can modify the codes. On the Cause & Factors tab, you can identify a 
wildland fire’s cause and contributing factors.

Table C-48:  Incidents Narrative Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Positions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Assignment 901 Codes tab of the 
Customize Codes 
dialog box

Usual Assignment For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-49:  Incidents Narrative Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Language Department Codes 
tab of the Customize 
Codes dialog box

Language For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Table C-50:  Incidents Wildland Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Fire Cause 901 Codes tab of the 
Customize Codes 
dialog box

Wildland Fire Cause For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Heat Source 901 Codes tab of the 
Customize Codes 
dialog box

Heat Source For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Factors Contributing 
to Ignition

901 Codes tab of the 
Customize Codes 
dialog box

Factors Contributing 
to Ignition

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Property and Responsible tab, you can view the fields in Table C-51 in which 
you can modify the codes. On the Property and Responsible tab, you can enter information about 
the property and the person responsible for the fire.

Fire Suppression 
Factors

901 Codes tab of the 
Customize Codes 
dialog box

Fire Suppression 
Factors

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Mobile Property 
Type

901 Codes tab of the 
Customize Codes 
dialog box

Mobile Property 
Type

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Equipment Involved 
in Ignition

901 Codes tab of the 
Customize Codes 
dialog box

Equipment Involved 
in Ignition or 
Equipment Involved 
in Release

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-50:  Incidents Wildland Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Weather & Behavior tab, you can view the fields in Table C-52 in which you 
can modify the codes. On the Weather & Behavior tab, you can describe the weather at the time of 
a wildland fire. 

Table C-51:  Incidents Property & Responsible Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

At Origin 901 Codes tab of the 
Customize Codes 
dialog box

Property 
Management

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Area Type 901 Codes tab of the 
Customize Codes 
dialog box

Population Density 
for Wildland

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Fuel Model at Origin 901 Codes tab of the 
Customize Codes 
dialog box

Fuel Model at Origin For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type of Right of Way 901 Codes tab of the 
Customize Codes 
dialog box

Type of Right of Way For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Identification 901 Codes tab of the 
Customize Codes 
dialog box

Person Responsible 
for Fire

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Gender 901 Codes tab of the 
Customize Codes 
dialog box

Gender For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Activity of Person 901 Codes tab of the 
Customize Codes 
dialog box

Activity of Person For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Table C-52: Incidents Weather & Behavior Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Weather type 901 Codes tab of the 
Customize Codes 
dialog box

Weather type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Fire Danger Rating 901 Codes tab of the 
Customize Codes 
dialog box

Fire Danger Rating For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Relative Position 901 Codes tab of the 
Customize Codes 
dialog box

Relative Position on 
Slope

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Narrative
When you click the Narrative tab, you can view the fields in Table C-53 in which you can modify 
the codes. On the Narrative tab, you can summarize a patient’s EMS treatment.

Aspect 901 Codes tab of the 
Customize Codes 
dialog box

Aspect For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-52: Incidents Weather & Behavior Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Authorization
When you click the Authorization tab, you can view the fields in Table C-54 in which you can 
modify the codes. On the Authorization tab, you can authorize and release an incident report. An 
incident can’t be exported to NFIRS until it has been authorized.

Table C-53:  Incidents Narrative Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Table C-54:  Incidents Authorization Customizable Fields

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Training Form
The Training Form displays information about the employees that have been trained, employees 
who need training, and the classes that are available. You can update and schedule classes as 
needed.

Training Definition
When you click the Training tab on the desktop and click New, you can view the fields in Table 
C-55 in which you can modify the codes. On the Training Definition tab, you can schedule a 
training session.

Table C-55: Training Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Method Department Codes 
tab of the Customize 
Codes dialog box

Training Methods For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Provider Department Codes 
tab of the Customize 
Codes dialog box

Training Providers For information, see 
“Entering 
Department Codes” 
on page 3-10.

Default Result 1 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 1 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Default Result 2 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 2 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Default Result 3 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 3 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Other Department Codes 
tab of the Customize 
Codes dialog box

Other Training 
Locations

For information, see 
“Entering 
Department Codes” 
on page 3-10.

Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Table C-55: Training Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Training Participants
When you click the Participants tab on the desktop and click New, you can view the fields in Table 
C-56 in which you can modify the codes. You can use the Training Participants tab to schedule 
people for a training session.
 

Table C-56:  Training Participants Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Shift Shifts tab of the 
Customize 
Departments dialog 
box

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Station Structure tab on the 
Customize 
Departments dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Apparatus Basic Info tab of the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Default Result 1 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 1 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Default Result 2 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 2 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Default Result 3 Class Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 3 For information, see 
“Setting Up the Class 
Explorer Default 
Results” on page 
4-44.

Table C-56:  Training Participants Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Training Objectives/Skills
When you click the Training Objectives/Skills tab on the desktop, you can view the fields in Table 
C-57 in which you can modify the codes. You can define up to three default results lists. You can 
use the Training Participants tab to schedule people for a training session. 

Table C-57:  Training Obj/Skills Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Default Result 1 Objective Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 1 For information, see 
“Setting Up the 
Objective Explorer 
Default Results” on 
page 4-45.

Default Result 2 Objective Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 2 For information, see 
“Setting Up the 
Objective Explorer 
Default Results” on 
page 4-45.
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Training Authorization
When you click the Training Authorization tab on the desktop, you can view the fields in Table 
C-58 in which you can modify the codes. You can use the Training Participants tab to schedule 
people for a training session. A training session that is authorized indicates to FireRMS that the 
training session is complete and that the results are accurate. The training session is also available 
to many FireRMS training reports.

Default Result 3 Objective Explorer 
Default Results on 
the Customize 
Training dialog box

Default Result 3 For information, see 
“Setting Up the 
Objective Explorer 
Default Results” on 
page 4-45.

Table C-57:  Training Obj/Skills Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-58:  Training Authorization Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Other Entries Form
The Other Entries Form enables you to schedule and store results for non-training events. The 
Other Entries List displays the current other entry events in FireRMS and allows you to schedule 
events, modify and delete events, and filter, sort and print the list.

Other Entries Definition
When you click the Other Entries tab on the desktop and click New, you can view the fields in 
Table C-59 in which you can modify the codes. You can use the Other Entries Definition tab to 
schedule a new event or modify the details of an existing event. 

Table C-59:  Other Entries Definition Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type Department Codes 
tab of the Customize 
Codes dialog box

Other Entry Types For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Station Structure of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Default Result 1 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 1 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Default Result 2 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 2 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Default Result 3 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 3 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Table C-59:  Other Entries Definition Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Other Entries Participants
When you click the Other Entries Participants tab on the desktop, you can view the fields in Table 
C-60 in which you can modify the codes. You can use the Other Entries Participants tab to add 
participants to an event. 

Table C-60:  Other Entries Participants Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Shift Shifts tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Apparatus Basic Info tab of the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Default Result 1 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 1 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Default Result 2 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 2 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Default Result 3 Other Entry Results 
tab of the Customize 
Other Entries dialog 
box

Default Result 3 For information, see 
“Customizing 
Default Results for 
Other Entries” on 
page 4-50.

Table C-60:  Other Entries Participants Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Other Entries Authorization
When you click the Other Entries Authorization tab on the desktop, you can view the fields in Table 
C-61 in which you can modify the codes. You can use the Other Entries Authorization tab to 
authorize an event. 

Table C-61:  Other Entries Authorization Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Position For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Daybook Form
The Daybook tab on your FireRMS desktop contains your activity information. This includes com-
pleted and incomplete Incidents, Training Events, Occupancy, and Vehicle and Equipment activity 
items.

When you click the Daybook tab on the desktop and click New, you can view the fields in Table 
C-62 on the FYI/Request tab in which you can modify the codes.

Table C-62:  Daybook Field 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

For Daybook Filter & 
____ Shifts

Shifts tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.
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Customizing Fields for Daily Roster, Personnel, 
Occupancies, Hydrants, 
and Vehicles and Equipment
This section describes how to customize fields in the screens you can display by clicking the 
following Desktop buttons on the FireRMS desktop; Daily Roster, Personnel, Occupancies, 
Hydrants, and Vehicles & Equipment.

Daily Roster
The Daily Roster is a 24-hour view of daily assignments based on your shift schedule and 
department structure. The Daily Roster organizes your department's structure into a tree view that 
shows detailed assignments for your agency.

When you click the Daily Roster button and then the Roster Entry tab, you can view the fields in 
Table C-63 in which you can modify the codes.
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Table C-63: Daily Roster Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Position Department Codes 
tab of the Customize 
Codes dialog box

Positions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Assigned To Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Apparatus Basic Info tab of the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Pay code Department Codes 
tab of the Customize 
Codes dialog box

Pay Codes For information, see 
“Entering 
Department Codes” 
on page 3-10.

Info1 Department Codes 
tab of the Customize 
Codes dialog box

Roster Info 1 For information, see 
“Entering 
Department Codes” 
on page 3-10.

Info 2 Department Codes 
tab of the Customize 
Codes dialog box

Roster Info 2 For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Personnel Info
The Personnel Info includes a list of the employees in your department, along with additional 
information. Using the tabs displayed, you can enter general info about the employees, indicate 
how to contact the person, add confidential employee info, attach files to an employee record such 
as a diglossia photo, and schedule exception days to an employee's normal shift pattern.

When you click the Personnel Info button and then the List tab, you can view the fields in Table 
C-64 in which you can modify the codes.

When you click the Personnel Info button and then the Basic Info tab, you can view the fields in 
Table C-65 in which you can modify the codes.

Table C-64: Personnel Info Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Show For Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Table C-65: Basic Info Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

State Department Code tab 
of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

NFIRS5 901 Codes tab of the 
Customize Codes 
dialog box

Usual Assignment For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Position Department Codes 
tab of the Customize 
Codes dialog box

Positions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Status 901 Codes tab of the 
Customize Codes 
dialog box

Career Status For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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When you click the Personnel Info button and then the Personal tab, you can view the fields in 
Table C-66 in which you can modify the codes.

Security Group Security Groups tab 
of the Administration 
dialog box

N/A For information, see 
“Creating Security 
Groups and Defining 
Access Rights” on 
page 3-31.

Schedule Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Assigned To Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Apparatus Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Shift Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Table C-65: Basic Info Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Personnel Info button and then the Scheduling tab, you can view the fields in 
Table C-67 in which you can modify the codes.

Table C-66: Personal Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Gender 901 Codes tab of the 
Customize Codes 
dialog box

Gender For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Ethnic 901 Codes tab of the 
Customize Codes 
dialog box

Ethnicity For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Race 901 Codes tab of the 
Customize Codes 
dialog box

Race For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Table C-67: Scheduling Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Schedule Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Assigned To Structure tab of the 
Customize 
Department dialog 
box

N/A For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Apparatus Basic Info tab of the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.
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Position Department Codes 
tab of the Customize 
Codes dialog box

Positions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Pay Code Department Codes 
tab of the Customize 
Codes dialog box

Pay Codes For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-67: Scheduling Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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When you click the Personnel Info button and then the Other Data tab, you can view the fields in 
Table C-68 in which you can modify the codes.

Table C-68: Other Data Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Employee Type Department Codes 
tab of the Customize 
Codes dialog box

Employee Type For information, see 
“Entering 
Department Codes” 
on page 3-10.

Employee Status Department Codes 
tab of the Customize 
Codes dialog box

Employee Status For information, see 
“Entering 
Department Codes” 
on page 3-10.

Residency Department Codes 
tab of the Customize 
Codes dialog box

Residency For information, see 
“Entering 
Department Codes” 
on page 3-10.

Retirement System Department Codes 
tab of the Customize 
Codes dialog box

Retirement System For information, see 
“Entering 
Department Codes” 
on page 3-10.
Customizing Fields for Incident, Training, Other Entries and Daybook Forms     C-111



Hydrants
The Hydrants module enables you to create records for all the hydrants in your service area. 

The Hydrant List provides a list of hydrants that have been entered in FireRMS. From the Hydrant 
List you can add hydrants, select existing hydrants, delete hydrants, and filter, sort and print the list. 
When you click the Hydrants button and then the List tab, you can view the fields in Table C-69 in 
which you can modify the codes.

Religious Preference Department Codes 
tab of the Customize 
Codes dialog box

Religious Preference For information, see 
“Entering 
Department Codes” 
on page 3-10.

Rank Department Codes 
tab of the Customize 
Codes dialog box

Rank For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-68: Other Data Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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The Hydrant Info contains identifying information for the hydrants. When you click the Hydrants 
button and then the Info tab, you can view the fields in Table C-70 in which you can modify the 
codes.

Table C-69: Hydrants Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Show for Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Table C-70: Info Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.
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The Hydrant Activities contains assign and track hydrant inspections and other hydrant-related 
actions. Activities are stored with hydrants so that you can review a hydrant's activity status and 
history. When you click the Hydrants button and then the Activities tab, you can view the fields in 
Table C-71 in which you can modify the codes.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-70: Info Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Using the Hydrants Schedule, you can schedule on-going activities like hydrant inspections that 
can be assigned, tracked, and marked as complete on the Activities tab. When you click the 
Hydrants button and then the Schedule tab, you can view the fields in Table C-72 in which you can 
modify the codes.

Table C-71: Activities Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize Hydrants 
dialog box

N/A For information, see 
“Creating Hydrant 
Actions” on page 4-2.
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Table C-72: Schedule Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize Hydrants 
dialog box.

N/A For information, see 
“Creating Hydrant 
Actions” on page 4-2.
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Occupancies
Occupancies contains a list the occupancies in your service area. From the Occupancy List you can 
add new occupancies, select existing occupancy records, delete occupancy records, and filter, sort 
and print the list.

The Occupancy List provides new occupancies, select existing occupancy records, delete 
occupancy records, and filter, sort and print the list. When you click the Occupancies button and 
then the List tab, you can view the fields in Table C-73 in which you can modify the codes.

Table C-73: Occupancy/List Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Show for Station Structure tab of the 
Customize 
Departments dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Using the Occupancies Basic Data, you can record basic data about an occupancy. When you click 
the Occupancies button and then the Basic Data tab, you can view the fields in Table C-74 in which 
you can modify the codes.

Show for Use Codes tab of the 
Customize 
Occupancies dialog 
box

Occupancy Use 
Codes

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.

Table C-73: Occupancy/List Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-74: Basic Data Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

Type Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Station Structure tab of the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.
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Using the Occupancies Contact, you can record contact person for an occupancy. When you click 
the Occupancies button and then the Contacts tab, you can view the fields in Table C-75 in which 
you can modify the codes.

Table C-75: Contact Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Other Department Codes 
tab of the Customize 
Codes dialog box

Incident Involvement 
Types

For information, see 
“Entering 
Department Codes” 
on page 3-10.

Prefix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Using the Occupancies Building, you can record building related details for an occupancy. When 
you click the Occupancies button and then the Building tab, you can view the fields in Table C-76 
in which you can modify the codes.

Type (Address) Department Codes 
tab of the Customize 
Codes dialog box

Street Types For information, see 
“Entering 
Department Codes” 
on page 3-10.

Suffix Department Codes 
tab of the Customize 
Codes dialog box

Street Directions For information, see 
“Entering 
Department Codes” 
on page 3-10.

State Department Codes 
tab of the Customize 
Codes dialog box

States & Provinces For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-75: Contact Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-76: Building Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Structure Type Codes tab of the 
Customize 
Occupancies dialog 
box

Structure Type For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Building Status 901 Codes tab of the 
Customize Codes 
dialog box

Building Status For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Construction (Main 
Floor)

Codes tab of the 
Customize 
Occupancies dialog 
box

Construction Codes > 
Floor

For information, see 
“Customizing 
Occupancies” on 
page 4-6.
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Interior Codes tab of the 
Customize 
Occupancies dialog 
box

Construction Codes > 
Interior

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Exterior Codes tab of the 
Customize 
Occupancies dialog 
box

Construction Codes > 
Exterior

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Construction Type 901 Codes tab of the 
Customize Codes 
dialog box

Construction Types For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Building Style 901 Codes tab of the 
Customize Codes 
dialog box

Building Style For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type Codes tab of the 
Customize 
Occupancies dialog 
box

Structure Type For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Material Codes tab of the 
Customize 
Occupancies dialog 
box

Roof Codes > Roof 
Materials

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Construction (Roof) Codes tab of the 
Customize 
Occupancies dialog 
box

Construction Codes > 
Roof

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Upper Floor 
Construction

Codes tab of the 
Customize 
Occupancies dialog 
box

Construction Codes > 
Floor

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Table C-76: Building Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Using the Occupancies More Building, you can record additional building information including 
use, prevention systems, and materials and products stored. When you click the Occupancies button 
and then the More Building tab, you can view the fields in Table C-77 in which you can modify the 
codes.

Table C-77: More Building Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Occupancy Use Codes tab of the 
Customize 
Occupancies dialog 
box

Occupancy Use 
Codes > Occupancy 
Use

For information, see 
“Customizing 
Occupancies” on 
page 4-6.

Property Uses 901 Codes tab of the 
Customize Codes 
dialog box

Property Use For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Using the Occupancies Prevention Info, and Systems tab, you can create a field of detector and 
extinguishment systems in place at an occupancy. When you click the Occupancies button and then 
Prevention Info and the Systems tab, you can view the fields in Table C-78 in which you can 
modify the codes

Mixed Use 901 Codes tab of the 
Customize Codes 
dialog box

Mixed Use Property For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Detector) 901 Codes tab of the 
Customize Codes 
dialog box

Detector Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Power Supply 901 Codes tab of the 
Customize Codes 
dialog box

Detector Power 
Supply

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Automatic 
Extinguishing 
System)

901 Codes tab of the 
Customize Codes 
dialog box

Type of Automatic 
Extinguishing 
System

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

On-Site Materials or 
Products

901 Codes tab of the 
Customize Codes 
dialog box

On-site Materials For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Table C-77: More Building Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Using the Occupancies Prevention Info, and Hazmat tab, you can identify any hazardous materials 
that are stored or processed at the occupancy. When you click the Occupancies button and then 
Prevention Info and the Hazmat tab, you can view the fields in Table C-79 in which you can modify 
the codes

Table C-78: Systems Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Type (AES) 901 Codes tab of the 
Customize Codes 
dialog box

Type of Automatic 
Extinguishing 
System

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Type (Detectors) 901 Codes tab of the 
Customize Codes 
dialog box

Detector Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Table C-79: Hazmat Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Units (Amount on 
Hand)

901 Codes tab of the 
Customize Codes 
dialog box

Units Capacity or 
Units Released

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Class 901 Codes tab of the 
Customize Codes 
dialog box

Container Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.

Units (Container) 901 Codes tab of the 
Customize Codes 
dialog box

Units Capacity or 
Units Released

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Using the Occupancies Prevention Info, and Permits tab, you can enter details about permits 
attached Systems, Hazmat and Other Info entries. When you click the Occupancies button and then 
Prevention Info and the Permits tab, you can view the fields in Table C-80 in which you can modify 
the codes

The Occupancies Activities to assign actions (like permit inspections) to an occupancy, track 
actions to completion and record the findings. This information is stored with the occupancy so that 
you can easily review and report on the history, status and results of each action. When you click 
the Occupancies button and then the Activities tab, you can view the fields in Table C-81 in which 
you can modify the codes.

Table C-80: Permits Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Permit Permits tab of the 
Customize 
Occupancies dialog 
box

System For information, see 
“Customizing 
Occupancies” on 
page 4-6.
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Using the Occupancies Letters, you can create letters for occupancies. When you click the 
Occupancies button and then the Letters tab, you can view the fields in Table C-82 in which you 
can modify the codes.

Table C-81: Activities Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize 
Occupancies dialog 
box

N/A For information, see 
“Customizing 
Occupancies” on 
page 4-6.
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Using the Occupancies Schedules, you can schedule on-going activities that can be assigned, 
tracked, recorded and marked as complete on the Activities tab. A primary use of this tab is to 
schedule ongoing permit inspections or other types of inspections that recur on a regular basis. 
When you click the Occupancies button and then the Schedules tab, you can view the fields in 
Table C-83 in which you can modify the codes.

Table C-82: Letters Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Template Letter Templates of 
the Customize 
Occupancies dialog 
box

N/A For information, see 
“Customizing 
Occupancies” on 
page 4-6.
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Table C-83: Schedules Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize 
Occupancies dialog 
box

N/A For information, see 
“Customizing 
Occupancies” on 
page 4-6.
C-132     Appendix C: Customizing Field Codes



FireRMS Administrator’s Guide
Vehicles & Equipment
Vehicles & Equipment allows you to create and maintain records of all vehicles and equipment 
used by your department as well as those that belong to outside agencies, but may appear in your 
incident report.

Using the Vehicles & Equipment > Vehicle Info and Basic, you can enter basic identifying 
information for a vehicle. When you click the Vehicles & Equipment button and then Vehicle Info 
and the Basic tab, you can view the fields in Table C-84 in which you can modify the codes.

Table C-84: Basic Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Category 901 Codes tab of the 
Customize Codes 
dialog box

Apparatus or 
Resource Type

For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Using the Vehicles & Equipment > Vehicle Info and Drive Chain, you can record information on a 
units drive train. When you click the Vehicles & Equipment button and then Vehicle Info and the 
Drive Train tab, you can view the fields in Table C-85 in which you can modify the codes.

Supplier Department Codes 
tab of the Department 
Codes dialog box

Supplier For information, see 
“Entering 
Department Codes” 
on page 3-10.

Manufacturer Department Codes 
tab of the Department 
Codes dialog box

Manufacturer For information, see 
“Entering 
Department Codes” 
on page 3-10.

Owner Department Codes 
tab of the Department 
Codes dialog box

Other Agencies For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-84: Basic Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Table C-85: Drive Train Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Displacement (units) Defaults tab of the 
Customize Vehicles 
&Equipment dialog 
box

ci, cc or liters For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Clutch Size (units) Defaults tab of the 
Customize Vehicles 
&Equipment dialog 
box

in or cm For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.
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Using the Vehicles & Equipment > Vehicle Info and Chassis, you can record information on a units 
chassis. When you click the Vehicles & Equipment button and then Vehicle Info and the Chassis 
tab, you can view the fields in Table C-86 in which you can modify the codes.

Pressure Plate (units) Defaults tab of the 
Customize Vehicles 
&Equipment dialog 
box

in or cm For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Capacity (units) Defaults tab of the 
Customize Vehicles 
&Equipment dialog 
box

gallons or liters For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Table C-85: Drive Train Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
C-136     Appendix C: Customizing Field Codes



FireRMS Administrator’s Guide
The Vehicles & Equipment > Vehicle Info and Pump to record information about a vehicle pump. 
When you click the Vehicles & Equipment button and then Vehicle Info and the Pump tab, you can 
view the fields in Table C-87 in which you can modify the codes.

Table C-86: Chassis Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Certified Gross 
Vehicular Weight 
(units)

Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

lb, tons, kg, or mt For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Total (units) Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

lb, tons, kg, or mt For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

V hi l & E i /V hi l I f /P
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Using Vehicles & Equipment > Equipment Info and Basic, you can enter general information about 
a piece of equipment. When you click the Vehicles & Equipment button and then Equipment Info 
and the Basic tab, you can view the fields in Table C-88 in which you can modify the codes.

Table C-87: Pump Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Lubricant Capacity 
(units)

Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

quarts, gallons, or 
liters

For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Water Tank Capacity 
(units)

Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

gallons or liters For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Foam Tank Capacity 
(units)

Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

gallons or liters For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Suction Size (units) Defaults tab of the 
Customize Vehicles 
& Equipment dialog 
box

in or cm For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.
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Table C-88: Basic Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Category Equipment 
Categories tab of the 
Customize Vehicles 
& Equipment dialog 
box

Group For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Supplier Department Codes 
tab of the Customize 
Codes dialog box

Suppliers For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Using the Vehicles & Equipment and Activities, you can assign actions (such as preventative 
maintenance and repairs) to vehicles and equipment. This information is stored with the vehicle or 
equipment record so that you can easily review and report on the history and status of all activities. 
When you click the Vehicles & Equipment button and the Activities tab, you can view the fields in 
Table C-89 in which you can modify the codes.

Sub Category Equipment 
Categories tab of the 
Customize Vehicles 
& Equipment dialog 
box

Description For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.

Manufacturer Department Codes 
tab of the Customize 
Codes dialog box

Manufacturers For information, see 
“Entering 
Department Codes” 
on page 3-10.

Table C-88: Basic Customizable Fields (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Using the Vehicles & Equipment and Schedule, you can schedule on-going activities that can be 
assigned, tracked, and marked as complete on the Activities tab. A primary use of this tab is to 
schedule ongoing maintenance or other types of actions that recur on a regular basis. When you 
click the Vehicles & Equipment button and the Schedule tab, you can view the fields in Table C-90 
in which you can modify the codes.

Table C-89: Activities Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize Vehicles 
& Equipment dialog 
box

N/A For information, see 
“Creating a List of 
Equipment Actions” 
on page 4-27.

Assignment Explorer Assignments tab on 
the Customize 
Vehicles & 
Equipment dialog 
box

N/A For information, see 
“Customizing 
Vehicles, Equipment, 
and Locations” on 
page 4-25.
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Table C-90: Schedule Customizable Fields 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Action Actions tab of the 
Customize Vehicles 
& Equipment dialog 
box

N/A For information, see 
“Creating a List of 
Equipment Actions” 
on page 4-27.

Assignment Explorer Assignments tab on 
the Customize 
Vehicles & 
Equipment dialog 
box

N/A For information, see 
“Creating Staff or 
Department 
Structures Available 
For Assignments” on 
page 4-29.
C-142     Appendix C: Customizing Field Codes



FireRMS Administrator’s Guide
Customizing Fields for Finders and Explorers
There are several FireRMS finders and explorers you can use to lookup information. This section 
lists the finder and explorer dialog boxes with fields you can customize.

Agency Finder
Using the Agency Finder, you can choose mutual aid agencies for Incident reports. You can view 
the fields in Table C-91 in which you can modify the codes.

Table C-91: Agency Finder

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Agency List Box Department Codes 
tab on the Customize 
Codes dialog box

Other Agencies For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Apparatus Finder
Using the Apparatus Finder, you can choose the apparatus that responded to an Incident. You can 
view the fields in Table C-92 in which you can modify the codes.

Table C-92: Apparatus Finder

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Apparatus List Box Basic Info tab on the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Note:   If an N/A appears in the Category You Can Customize column of a table, the 
codes are not contained in a category. You can change the available codes by adding to, or 
removing from, the list of codes displayed.
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Hydrants Assignment Explorer
Using the Hydrants Assignment Explorer, you can view the list of hydrants listed in FireRMS. You 
can view the fields in Table C-93 in which you can modify the codes.

Table C-93: Hydrants Assignment Explorer

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Assignments Assignments tab on 
the Customize 
Hydrants dialog box

N/A For information, see  
“Selecting Staff To 
Be Assigned Hydrant 
Activities.”
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Occupancies Assignments Explorer
Using the Occupancies Assignment Explorer, you can select from the list of Occupancies listed in 
FireRMS. You can view the fields in Table C-94 in which you can modify the codes.

Table C-94: Occupancies Assignment Explorer

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Assignments Assignments tab on 
the Customize 
Occupancies dialog 
box

N/A For information, see 
“Entering Staff 
Available for 
Occupancy 
Assignments” on 
page 4-9.
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Vehicles Assignment Explorer
Using the Vehicles Assignments Explorer you can choose a person or department structure for 
vehicles or equipment. You can then choose an activity to be performed on that vehicle or 
equipment from the Vehicles and Equipment Activities tab. You can view the fields in Table C-95 
in which you can modify the codes.

Table C-95: Vehicles Assignments Explorer

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Assignments Assignments tab on 
the Customize 
Vehicles & 
Equipment dialog 
box

N/A For information, see 
“Entering Staff 
Available for 
Occupancy 
Assignments” on 
page 4-9.
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City Finder
Using the City Finder, you can select a city, in addition to zip codes, districts, census tracts, and 
counties. You can view the fields in Table C-96 in which you can modify the codes.

Table C-96: City Finder 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Cities Cities tab on the 
Customize Cities 
dialog box

N/A For information, see 
“Entering Cities” on 
page 3-25.

Zip Codes Numbers tab on the 
Customize Cities 
dialog box

Zip Code For information, see 
“Entering Numbers 
for Cities” on page 
3-26.

Districts Numbers tab on the 
Customize Cities 
dialog box

Districts For information, see 
“Entering Numbers 
for Cities” on page 
3-26.
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Census Tracts Numbers tab on the 
Customize Cities 
dialog box

Census Tract For information, see 
“Entering Numbers 
for Cities” on page 
3-26.

Counties Numbers tab on the 
Customize Cities 
dialog box

Counties For information, see 
“Entering Numbers 
for Cities” on page 
3-26.

Agencies Numbers tab on the 
Customize Cities 
dialog box

Agency For information, see 
“Entering Numbers 
for Cities” on page 
3-26.

Other Numbers tab on the 
Customize Cities 
dialog box

Other For information, see 
“Entering Numbers 
for Cities” on page 
3-26.

Table C-96: City Finder (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Credentials Earned Explorer
Using the Credentials Earned Explorer, you can select from the possible list of credentials which 
measure a person’s progress towards a particular goal, such as certification. You can view the fields 
in Table C-97 in which you can modify the codes.

Table C-97: Credentials Earned Explorer

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Provider Department Codes 
tab on the Customize 
Codes dialog box

Training Providers For information, see 
“Entering 
Department Codes” 
on page 3-10.
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External Participants
Using the External Participants, you can add participants from outside your department to a training 
session or other scheduled activity. You can view the fields in Table C-98 in which you can modify 
the codes.

Table C-98: External Participants

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Agency Department Codes 
tab on the Customize 
Codes dialog box

Other Agencies For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Occupancy Finder Explorer
Using the Occupancy Finder Explorer, you can search for the list of occupancies for a location of 
the Incident report. You can view the fields in Table C-99 in which you can modify the codes.
 

Table C-99: Occupancy Finder Explorer

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Show for Station Findings tab on the 
Customize 
Occupancies dialog 
box

N/A For information, see 
“Creating a List of 
Occupancy Findings” 
on page 4-8.
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Incident Filter
Using the Incident Filter, you can specify the items by which to filter the Incidents. You can view 
the fields in Table C-100 in which you can modify the codes.

Table C-100: Incident Filter

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Incident Type 901 Codes tab on the 
Customize Codes 
dialog box

Incident Type For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Occupancy Finder
Using the Occupancy Finder, you can search for occupancies as the location of the Incident. You 
can view the fields in Table C-101 in which you can modify the codes.

Table C-101: Occupancy Finder

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Show for Station Structure tab on the 
Customize 
Department dialog 
box

Station For information, see 
“Setting Up The 
Department 
Structure” on page 
3-4.

Show for Use 901 Codes tab of the 
Customize Codes 
dialog box

Occupancy Use For information, see 
“Entering 901 
Sub-Codes” on page 
3-12.
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Storage Tanks
Using the Storage Tanks dialog, you can record information about a tank used to house hazardous 
materials at any occupancy site. You can view the fields in Table C-102 in which you can modify 
the codes.

Table C-102: Storage Tanks 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Manufacturer Codes tab on the 
Customize 
Occupancies dialog 
box

Storage Tank 
Codes>Manufacturer

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.

Tank Construction Codes tab on the 
Customize 
Occupancies dialog 
box

Storage Tank 
Codes>Tank 
Construction

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.
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Pipe Type Codes tab on the 
Customize 
Occupancies dialog 
box

Storage Tank 
Codes>Pipe Type

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.

Monitor Type Codes tab on the 
Customize 
Occupancies dialog 
box

Storage Tank 
Codes>Monitor Type

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.

Vapor Recovery 
System

Codes tab on the 
Customize 
Occupancies dialog 
box

Storage Tank 
Codes>Vapor 
Recovery System

For information, see 
“Creating Groups 
and Assigning 
Building Codes” on 
page 4-13.

Table C-102: Storage Tanks (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Street Finder
Using the Street Finder, you can select from the listing of streets when entering address 
information. You can view the fields in Table C-103 in which you can modify the codes.

Table C-103: Street Finder

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Streets Customize Streets N/A For information, see 
“Entering Streets” on 
page 3-28.
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Training Filter
Using the Training Filter, you can specify the items by which to filter the Training sessions. You 
can view the fields in Table C-104 in which you can modify the codes.

Table C-104: Training Filter 

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes

Method Department Codes 
tab on the Customize 
Codes dialog box

Training Methods For information, see 
“Entering 
Department Codes” 
on page 3-10.
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Apparatus Unit ID Basic Info tab on the 
Customize Apparatus 
dialog box

N/A For information, see 
“Adding Apparatus 
and Staffing 
Apparatus” on page 
3-18.

Other Locations Department Codes 
tab on the Customize 
Codes dialog box

Other Training 
Locations

For information, see 
“Entering 
Department Codes” 
on page 3-10.

Shift Shifts tab on the 
Customize 
Department dialog 
box

N/A For information, see 
“Entering 
Department Shift 
Patterns” on page 
3-6.

Table C-104: Training Filter (Continued)

Customizable 
Field

Tab/Dialog Box 
Used To Change 
The Codes

Category You Can 
Customize

Procedure To 
Modify The Codes
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Appendix A:Setting up the Master Name 
Index Feature

The Master Name Index (MNI) feature is available with FireRMS 4.5 SP1 and provides a quick and 
easy way to search, select or enter all information pertaining to people in a standardized format. 
The standardized format provides greater accuracy while significantly reducing redundancy. In 
addition, the indexing of the centralized data provides for quick and accurate retrieval of associated 
data such as aliases, address & contact history, identifying marks and involved incidents.

Setting Up the Master Name Index Feature

1.  Create the Master Name Index Database.

Launch and Logon to the SQL Utils program. 
Click on the Master Name Index checkbox and use the Create button to create a new 

Master Name Index Database. You may accept the default name provided on the create 
form or enter your own name for the MNI database.

2.  Connect MNI to FireRMS. 

After the Database has been created, clear the Master Name Index checkbox to display 
the list of your local FireRMS database(s). 

Select the MNI database from the dropdown list box titled Master Name Index.
A prompt displays to allow you to choose whether or not to import all current name records 

into the MNI database.   

Note: Activating the Master Name Index option does not change or update any of your 
existing information. Deactivating the Master Name Index option does not cause any loss 
of data in your new or existing FireRMS records.
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You may share the MNI database between multiple FireRMS databases when they are 
hosted on a single SQL Server, or you may create multiple MNI databases so each FireRMS 
database may use its own copy.

After you have setup the MNI database and associated it with a FireRMS database, the 
next time FireRMS is run, the following forms prompt the users to select from or enter 
information into the MNI system:

Persons Involved
EMS/NEMSIS Patient
Civilian Casualty
Occupancy Contact

Using the Master Name Index Feature
When adding a person to an Incident or Occupancy, the Master Name Index connection allows you 
to enter data more efficiently and easily. 

The following section describes the different forms that you can use for the Master Index feature. 

1.  On the Master Name Index Forms, click Add to add a new name to any form. 

2.  On the MNI Search Form, click on the button labeled Get All to return the complete list of 
all names, or search for a name by typing in at least two characters for either the first or last 
name. As the letters are added, the form automatically updates to show all records that 
match the search criteria:

Note: If you are using FireRMS Mobile, you have to drop the mobiles and remove the 
publication before connecting to a MNI database. This requirement ensures your mobile 
users will be able to use the new system.
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3.  The following screenshot shows the MNI Form with returned data. Select the correct name, 
the click the Save/Update button to fill the information into the FireRMS form..

 

4.   If you do not see any match for the current person, you may choose to make a new entry in 
the MNI database by clicking the Add New button. 
This activates the MNI Data Entry form.
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5.  On the Data Entry Form, Enter as much or as little information as needed to both properly 
fill out the FireRMS form and to also identify the person for future reference. 

The comments box allows you to communicate information to other FireRMS users who 
may encounter this person when filling out future reports. 

The Proper Case function allows you to enter the data in all lower or upper case and then 
transform it into proper case for better display.

If the person’s address is the same as the Incident Location, you can use the Incident 
Address box to pull that information into the MNI data entry form.

The Address History form allows you to update information when a person moves while 
still retaining the same name link and information in the MNI database.
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6.  The Address History form displays the address history of the person or organization 
associated with the record. 

Note the following additional information: 

Importing the existing data into the MNI database during the setup in SQL Utils may take several 
minutes. That time is extended for each additional FireRMS database you connect to a single MNI 
database when choosing to import the current data.

The first time you run FireRMS after importing the data there will also be a slight delay while the 
connection is completed. That delay will occur one time only.

Because fields on the forms listed above become read only fields when the MNI connection is in 
use, Local User Defined Mandatory fields should be removed from those forms before enabling the 
MNI connection. 

Fields required by NFIRS will continue to show as required when they are empty, but the user 
needs to enter the data on the MNI form in order to populate the data correctly into FireRMS. If you 
need to update fields after the MNI connection was initially established, use SQL Utils to remove 
the connection (clear the dropdown box). Make the desired changes to the forms and then reselect 
the MNI database in SQL Utils. You do not need to reimport your names when reconnecting to a 
previously established MNI database.

Height and Weight may be entered on the MNI person form for identification purposes, but that 
information is not be copied back into an EMS form when selecting a person from the MNI list. 
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This is because height and weight may change and should always be rechecked during an EMS 
assessment. Similarly, the field Age will not be auto populated unless a specific Date of Birth has 
been logged in the MNI person form.

During the initial import of data, records that include identical Name, DOB and address will be 
merged into a single record. 

A future update to the Master Name Index form will allow the Administrator to manually merge 
records as needed.
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Appendix A:Quick Reference

The “How do I...” questions listed in this appendix reference all major procedures described 
in this guide. These questions appear in alphabetical order. If navigating the PDF file, click 
the page number to jump to the referenced section.

How do I…

Activate Design Mode ........................................................................................................  page 5-8
Add Apparatus .................................................................................................................. page 3-18
Add Personnel.................................................................................................................... page 3-21
Add Sub-Categories .......................................................................................................... page 4-31
Allow User’s To Create New Records From a Mobile Device ...................................... page 6-13
Change a User’s Login Information................................................................................ page 6-13
Change Field Labels.......................................................................................................... page 4-61
Change Field Visibility ..................................................................................................... page 4-61
Change Object Properties ................................................................................................ page 4-58
Change Tab Caption ......................................................................................................... page 4-51
Change Tab Visibility ....................................................................................................... page 4-51
Change Tab Sort Order.................................................................................................... page 4-51
Change the Location of a Field ........................................................................................ page 4-59
Change the Desktop Font Size ........................................................................................... page 1-6
Choose a Reporting Method............................................................................................. page 5-11
Choose an Occupancy Numbering Scheme .................................................................... page 4-19
Create a List of Building Codes ....................................................................................... page 4-13
Create a List of Building Related Actions......................................................................... page 4-7
Create a List of Equipment Actions ................................................................................ page 4-27
Create a List of Objectives and Skills ............................................................................. page 4-33
Create a List of Occupancy Findings ................................................................................ page 4-8
Create a List of Occupancy Related Permits.................................................................. page 4-11
Create a List of Staff and Assignments ........................................................................... page 4-29
Create a List of Standards Linked to Occupancy Findings .......................................... page 4-12
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Create Classes .................................................................................................................... page 4-35
Create Credentials............................................................................................................. page 4-38
Create Custom Advanced EMS Protocols ...................................................................... page 4-45
Create Custom Tabs For Incident, Advanced EMS, or Occupancies .......................... page 4-52
Create Disclosures ............................................................................................................. page 4-47
Create Equipment Categories .......................................................................................... page 4-25
Create New Advanced EMS Tabs.................................................................................... page 4-52
Create New Incident Records From a Mobile Device.................................................... page 6-13
Create New Incident Tabs ................................................................................................ page 4-52
Create New Occupancy Records From a Mobile Device............................................... page 6-13
Create Security Groups .................................................................................................... page 3-31
Create Standards............................................................................................................... page 4-31
Create Hydrant Actions...................................................................................................... page 4-2
Create Templates for Occupancy-Related Letters......................................................... page 4-16
Customize Advanced EMS Disclosures........................................................................... page 4-47
Customize Advanced EMS Tabs...................................................................................... page 4-51
Customize Codes ............................................................................................................... page 3-10
Customize Data.................................................................................................................. page 1-13
Customize Default Results Fields..................................................................................... page 4-50
Customize Default Results for Other Entries ................................................................. page 4-50
Customize Field Codes....................................................................................................... page C-1
Customize Fields for Daily Roster, Personnel, Occupancies, Hydrants, 
      and Vehicles and Equipment................................................................................... page C-103
Customize Fields for Incident, Training, Other Entries, and Daybook Forms.......... page C-22
Customize Fields for Finders and Explorers ............................................................... page C-143
Customize Fields for the Tools/Customize Menu Commands ....................................... page C-2
Customize Hydrants............................................................................................................ page 4-2
Customize Incidents .......................................................................................................... page 4-20
Customize Incident Tabs .................................................................................................. page 4-51
Customize Module Selections............................................................................................. page 1-9
Customize Occupancies ...................................................................................................... page 4-6
Customize Other Entries .................................................................................................. page 4-50
Customize Tab Labels....................................................................................................... page 4-51
Customize Tab Sort Order ............................................................................................... page 4-51
Customize Tab Visibility .................................................................................................. page 4-51
Customize Training........................................................................................................... page 4-31
Customize Vehicles, Equipment & Locations................................................................. page 4-25
Customize Your Department’s EMS Codes .................................................................... page D-1
Decrypt Patient Data........................................................................................................... page 5-3
Define Access Rights ......................................................................................................... page 3-31
Determine the Information Personnel Can View ........................................................... page 1-10
Disable Automatic Incident Numbers ..............................................................................  page 5-3
Disable Dynamic Property Changes.................................................................................  page 5-8
Disable Mandatory Fields................................................................................................  page 5-14
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Disable Recommended Fields..........................................................................................  page 5-14
Display Mandatory Fields ...............................................................................................  page 5-14
Display Recommended Fields .........................................................................................  page 5-14
Display the Version 2 Advanced EMS Tabs ..................................................................  page 4-51
Enable Automatic Updates................................................................................................  page 6-1
Enable Dynamic Property Changes .................................................................................  page 5-8
Enable Mandatory Fields ................................................................................................  page 5-14
Enable Recommended Fields ..........................................................................................  page 5-14
Enable User Login............................................................................................................... page 5-2
Encrypt Patient Data .......................................................................................................... page 5-3
Enter 901 Sub-Codes......................................................................................................... page 3-12
Enter Basic Department Information ............................................................................... page 3-1
Enter Block Ranges for a Street ...................................................................................... page 3-30
Enter Cities ........................................................................................................................ page 3-25
Enter Department Codes.................................................................................................. page 3-10
Enter Department Information ......................................................................................... page 3-1
Enter Employee Contact Information............................................................................. page 3-23
Enter EMS Sub-Codes...................................................................................................... page 3-14
Enter Numbers for Cities ................................................................................................. page 3-26
Enter Staff Available for Occupancy Assignments.......................................................... page 4-9
Enter Streets ...................................................................................................................... page 3-28
Enter the Department Shift Patterns ................................................................................ page 3-6
Filter Data .......................................................................................................................... page 1-10
Install FireRMS Software................................................................................................... page 2-2
Install Software on a Mobile Device .................................................................................. page 2-5
Learn About Advanced Incident Reporting Features ..................................................... page 1-6
Learn About Desktop Buttons ........................................................................................... page 1-4
Learn About Desktop Tabs ................................................................................................ page 1-3
Learn About FireRMS Fill-in Fields ................................................................................. page 1-6
Limit Incident Records Created On a Mobile Device.................................................... page 6-13
Make a Field Invisible/Visible.......................................................................................... page 4-59
Make a Field Label Invisible/Visible ............................................................................... page 4-59
Manually Enter Incident Numbers.................................................................................... page 5-3
Map EMS Translation Codes........................................................................................... page 4-24
Modify a Previously Created Tab.................................................................................... page 4-56
Protect the Daily Roster and Personnel Module .............................................................. page 5-6
Protect the Daybook and Desktop ..................................................................................... page 5-2
Reconcile Mobile Incidents and Apparatus.....................................................................................    
Restrict Access To Data ...................................................................................................  page 1-13
Restrict Employee Contact Information......................................................................... page 3-23
Retire Occupancy Groups ................................................................................................ page 4-13
Retire Occupancy Codes................................................................................................... page 4-13
Retire Construction Group Codes................................................................................... page 4-13
Select a Color Indicator For Mandatory Fields ............................................................  page 5-14
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Select a Color Indicator For Recommended Fields ......................................................  page 5-14
Select a Hydrant Numbering Scheme................................................................................ page 4-5
Select Aid Given Codes Forms......................................................................................... page 4-22
Select an Alternate Spell Check Dictionary...................................................................... page 5-9
Select Centralized Reporting............................................................................................ page 5-11
Select Default Settings....................................................................................................... page 4-23
Select Local Reporting ...................................................................................................... page 5-11
Select Mandatory Fields ................................................................................................... page 4-59
Select Mobile Preferences ................................................................................................. page 6-13
Select Recommended Fields ............................................................................................. page 4-59
Select Staff To Be Assigned Hydrant Activities................................................................ page 4-3
Set Billing Rates for Incidents.......................................................................................... page 4-20
Set Default Measurement Units ....................................................................................... page 4-26
Set the Default Desktop Page ............................................................................................. page 5-1
Set Centralized Reporting ................................................................................................ page 5-11
Set Local Reporting........................................................................................................... page 5-11
Setup Additional FireRMS Modules ................................................................................. page 1-8
Setup a Mobile Device......................................................................................................... page 7-1
Setup Default Objects and Skills...................................................................................... page 4-43
Setup FireRMS .................................................................................................................... page 1-7
Setup FireRMS Mobile ....................................................................................................... page 7-1
Setup the Class Explorer Default Results ....................................................................... page 4-44
Setup the Department Structure........................................................................................ page 3-4
Setup the Objective Explorer Default Results ................................................................ page 4-45
Turn Off the Refresh Timer............................................................................................... page 5-4
Turn On/Off the Welcome Wizard.................................................................................... page 5-3
Understand Assigning Access Rights................................................................................ page A-1
Unretire Occupancy Codes............................................................................................... page 4-13
Use an Alternate Spell Check Dictionary.......................................................................... page 5-9
Use NT Logins...................................................................................................................... page 5-3
View Chemical Codes........................................................................................................ page 3-15
View Information About the FireRMS Client ................................................................ page 6-13
View Setup Procedures ....................................................................................................... page 1-7
View System Information ................................................................................................... page 6-1
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Appendix A:Getting Help

At ZOLL, we take as much pride in our technical support and custom solutions as we do in our soft-
ware. We know you will have questions so we have a full staff of well-trained, talented, and intelli-
gent people ready to help you.

Technical support 
We have a clearly defined commitment to help you use our software.

Technical support is available to help in these areas
• Software-related questions. Our support technicians can answer your questions about how our 

software works and provide advice about the best way to use it to perform specific tasks.
• Installation and maintenance procedures. Our support technicians can explain the correct instal-

lation and maintenance procedures for our software and related third-party software on which 
our products depend.

• Problem resolution. Our support technicians can assist you in times of system failure, accept 
problem and bug reports, and provide information and workaround, along with time frames for 
resolution.

Areas outside the scope of technical support
• Consulting and training. Our support technicians are not trainers who can teach you, for exam-

ple, how to bill; however, we can sometimes suggest a consultant.
• Hardware support. For hardware issues unrelated to our software, we recommend that you find 

a local hardware consultant who can assist you. If you are unsure whether your issue is hard-
ware or software related, please call us. Often, a short call can quickly help you get on the right 
path to finding a solution.

• Custom solutions. If you want assistance creating custom reports, forms, add-ons, and inter-
faces to third-party hardware and software, our Custom Solutions Group can work with you on 
a contract basis. Please see “Custom solutions” on page F-2..
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Your maintenance contract
Support is provided free of charge for 90 days from the time of purchase. To receive ongoing 
support after that, you must purchase a maintenance contract. For more information, please contact 
our Sales department.

Contact information

To help us address your problem in the quickest and most effective way possible, please provide as 
much specific information as possible, including when the problem began and whether it affects all 
RescueNet workstations.

Whether you email or call, your issue is routed to a technician specializing in your product who 
generates a ticket in our problem-resolution database and works with you to answer your question 
or resolve the issue.

Often the most effective way for our staff to assist you is to be able to re-create the issue at your site 
via a remote connection. To enable this, we recommend that you maintain a RescueNet workstation 
with Symantec pcAnywhere™ version 11.0 or higher, Microsoft RDP (Terminal Services), or VNC 
installed.

Support hours 8:00 A.M. - 8:00 P.M. Eastern Standard Time (EST)
Monday - Friday, except holidays

Email supportFD@zolldata.com

Telephone In the U.S. and Canada: +1 (800) 663-3911, ext 3, option 5
From other countries: +1 (303) 801-0000, ext 3, option 5

Fax +1 (303) 801-0001

Internet www.zolldata.com/Support

Mail ZOLL Technical Support Department
11802 Ridge Parkway, Suite 400
Broomfield, CO 80021 
USA

Custom solutions
If you want to maximize the capabilities of our software with custom reports, forms, add-ons, and 
interfaces to third-party hardware and software, our Custom Solutions Group can work with you to 
provide a solution. 
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To discuss custom solutions, please contact our Custom Solutions Group. They will discuss your 
requirements with you and prepare a contract. Upon your acceptance of the contract, work can 
begin on your solution.

Hours 10:00 A.M. - 7:00 P.M. Eastern Standard Time (EST)
Monday - Friday, except holidays

Email CustomSolutions@zolldata.com

Telephone In the U.S. and Canada: +1 (800) 663-3911, ext 6
From other countries:  +1 (303) 801-0000, ext 6

Mail ZOLL 
Custom Solutions Group
11802 Ridge Parkway, Suite 400
Broomfield, CO 80021 
USA
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